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Introduction 
This technical guide outlines policy and procedure for Content Analysis Processes. 

The guide is divided in two volumes, which roughly correspond to the duties of 
Content Analysis’ two primary content analysis functions: Data Entry, and Content 
Analysis. Volume I, Data Entry Processes, covers letter processing, log maintenance, 
mail identification, postal standards, comment entry, protocols, and validation. A 
significant part of this volume is dedicated to instruction in the Oracle v 1.0 database 
software. Volume II, Content Analysis Processes, comprises chapters on coding, 
identifying public concerns, writing narratives, editing, and creating appendices.  
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Section 1.1 ~ Processing Incoming Mail 
Before beginning the process of analyzing public comment, mail is collected and processed in a 
systematic manner. Following is the outline of responsibilities for the mail processor. 

• Pick up the regular mail at regularly scheduled time. Pick up FedEx, UPS and express mail 
per their pre-determined schedules. 

• Regularly check the e-mail project inbox and the fax machine for incoming mail. 

• Sort the mail by project and put additional mail in the appropriate mailboxes. 

• Remove the response from the envelope; make sure to keep the response and envelope 
together.  

• Split all clearinghouse letters into individual responses.  

• Date stamp all responses using a Date Received stamp. 

• Sort the mail by individual responses, form letters, postcards, e-mail, and responses with 
envelopes, responses without envelopes, hearings, and petitions. 

• Sort by single-page or multiple-page responses. Multiple-page responses can then be sorted 
for copying by: single-sided to double-sided, double-sided to double-sided, etc. 

• Number all of the original responses, post cards, etc., using letter number labels (See
Appendix K, Numbering Labels). Place or handwrite the number label in the upper right-hand 
corner, staying away from the edges. Handwrite the letter number on all subsequent pages of 
the response, including the cover sheet and any enclosures. 

• Once the mail is date stamped, sorted, and numbered it is ready for copying. 

1.1.1 ~ Helpful Hints 
• Watch for responses or forms that do not pertain to the project. These are called “out-of-

scope” responses. (See Out-of-Scope Responses)

• Watch for more than one response in an envelope. Individual responses need their own letter 
number.

• Watch for duplicate responses. The sooner multiple copies of the same letter are caught, the 
less chance there is of needlessly processing a duplicate response. 

• Watch for Resolutions. Resolutions should be attached and processed with the letter they 
arrived with.

Section 1.2 ~ Copying Letters/Postcards 
Make two copies of each response: a clean (reading file) copy and a working copy. Following 
is the process for making copies of the responses. 

• Keep the numbered responses and postcards together in their respective groups. Using the 
auto feeder, place the numbered responses face up in the tray. Be sure to copy them in 
ascending numeric order. 

• Clean copies are single-sided. To save paper, working copies are double-sided. Postcards are 
copied one per page. 
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• Make sure the letter number shows up clearly on all copies. 

• Postcards, responses on dark stationary, etc. need to be hand-fed using the flatbed glass. Be 
sure to keep these in ascending order. 

• After copies are made, staple the corresponding envelope to the back of the original response 
with the address facing out. File the originals and clean copies in numeric order in an 
accordion folder and place in the appropriate filing cabinet. Label each folder with the 
following information: “Originals, project name, and the letter number range (e.g., 475-
780).” Do the same for the clean.  

• Use the optional customized rubber stamps (see Letter Attribution section) and stamp the top 
of the first page of each working copy. Working copies go to the “MID folder” to be assigned 
a MID number. Working copies of form letters are organized by the assigned form number 
and put into the appropriate folder in the project bin. (See the alternative ways for dealing 
with forms in Chapter 1, Form section)

• The originals will be used by the log manager for entering into the Access correspondence 
log. For security reasons, the originals should be locked up in a filing cabinet when not being 
accessed.    

1.2.1 ~ Helpful Copying Hints 
• Align the postcard on the copier glass two inches from the top and left-hand side. The copy 

of the postcard will appear in the upper middle of the page. 

• Any responses or postcards that are written in pencil or very light writing need to be 
darkened. Take the copier off of the AUTO mode and adjust the exposure level accordingly. 

• Check the quality of the copies (e.g., exposure level, cut-offs, etc.) and correct when 
necessary. 

• It is necessary to copy the envelope whether or not the respondent provides a complete and 
legible address on their response. 

• Photocopy the envelope if the respondent does not provide an address or it is illegible on the 
response and it is legible on the envelope. 

• Check the legibility of names and addresses on the postcards while copying. Copy both sides 
of the postcard if necessary. 

1.2.2 ~ Letter Attribution Fields 
Rubber Stamp method: 

1234     I     1     2     1 (blank)

                                 MID OT      S       RT           DT   IA             and so on…. 

 Or dash method:     1234-I-1-2-1-X-X-X-5-X-X-X  

Customized Rubber stamps can be made to stamp the boxes used for labeling Letter Attribution 
codes. Each box can be labeled at the bottom with demographic/header codes (letter attribution 
fields) that identify a demographic type. An alternative method is to use dashes to separate 
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codes. If using the dash method, always use an X for a default code for those fields that are not 
being used in Oracle.  Information displayed in each box provides critical data used in reporting 
and in the demographic appendices (For description of header information see CH 6, Letter 
Information Block).

Section 1.3 ~ Additional Mail Processing 
Responsibilities
The mail processor has the following responsibilities in addition to receiving mail and copying 
responses.

• Coordinate with the project assistant, the log manager, and the person designated to make 
letter number corrections, or to correct numbering or copying discrepancies. 

• Identify forms, assign form numbers, determine form masters, and post additional copies for 
data entry and coding staff reference. (See Forms). 

• Identify letter generators and locates the letter generator from the website, prints the 
complete list of possible comments, and determines the letter generator masters. 

• Periodically check the “Possible forms” folder in the coders’ bin to determine if there are 
enough responses to constitute a form. 

• Keep the Project Team Leader and staff apprised of the volume of incoming responses. 

• Assist the Project Team Leader with Freedom of Information Act (FOIA) requests and 
prepare the copies necessary to fulfill each request. 

Section 1.4 ~ Forms or Organized Campaigns 
The term Form or Organized Campaign Letter refers to responses that are received from 
different individuals but are identical in content. In cases when response text paraphrases the 
content of a form letter with no change in the topic discussed, the response is treated as a form. 

Form Letter: Identical or very closely paraphrased text. 

The mail processor designates a response as a form if an identical response has been received 
from five or more different individuals. Identical responses are placed in a “Possible Form
Letter” folder. The possible form is considered a form when the total number of responses meets 
or exceeds five. Form letters are given to data entry and the form process begins. 

Form Letter with Additional Comments: Identical or very closely paraphrased, with one or 
more additional comments that may or may not be codable. If the additional comments are not 
codable, then treat it as a regular form. 

Form Master: A response chosen as the template for a particular form. 

A copy of the form is designated as the Form Master. Form masters are coded, entered and used 
as a template for the pool of forms they represent. Once the form master is entered the remaining 
corresponding forms are entered using the letter numbers, MIDs, and letter attribution 
information. This process saves a significant amount of time.  
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Staff designates a person, called the “forms coordinator,” to work with the mail processor in 
maintaining a main list of form numbers/names for each project. 

1.4.1 ~ Form Master Process  
• The mail processor identifies forms and determines which response is the form master.  

Forms with additional comments are not designated as the form master. 

• Unless you don’t have a choice, the forms coordinator for the coding staff codes the working 
copy of the form master, assigns comment numbers, and writes “Start additional comments at 
comment # __” The form master is given a unique number and a name descriptive of the 
response’s content. 

Example:
Form Letter #3 “We support Graylings.” 

• For reference, additional copies of the form master are posted for coder, mail processor, and 
data entry personnel reference. 

• The coded form master is given a MID, entered, and placed in the project bin Form Master 
entered folder. 

• Enter Form Number Master in Correspondence Log in Remarks field. 

1.4.2 ~ Form & Form Letter Process 
• Place identified forms in their corresponding Form Number folder in the project bin to 

receive a MID. 

• Query Project ID and the letter attribution in the Header Entry Form. 

• Enter only the header information, letter number, and MID. 

• Form Letter with Additional Comments Process  

• After the form letters are assigned a MID, they are put in the “1st Read” folder of the coders’ 
bin.

• Additional comments are coded before forms are returned to data entry. 

• Important: Do not begin additional comments at “one.” Refer to the corresponding form 
master or "Additional Comments" sheet to determine the starting number for additional 
comments. 

Section 1.5 ~ Out-of-Scope Responses 
Out-of-Scope Responses are responses sent with content that does not pertain to the project. A 
Team Leader should make this final determination.  

• Pull the original, clean, and working copies and staple them together. 

• Write “Out-of-Scope” on the top copy. 

• Record the information in the Out-of-Scope log in the project log Access database. 

• If the MID has no other responses attached, it is deleted. Record the pertinent information in 
the MID Delete folder in the project file. A computer specialist must delete MID records, 
unless the MID number is reused. 
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The log manager records “OOS” in the comments column of the project log. 
Out-of-Scope responses are returned. 

Section 1.6 ~ Filing 
File all response copies and originals to provide easy reference during the CA process and to 
protect the integrity of the original responses.  

Working Copies: 

Working copies of the response are filed in ascending MID order for easy reference during the 
validation process. The MID, written in the upper left-hand corner of the copy, is oriented so it is 
visible at the top of the file, i.e., file the left side up. 

After the working copy is entered into the Content Analysis application (see Chapter 6), it is 
placed in the appropriate MID folder in the “To Be Filed” project bin. 

Place the ordered copies into accordion files and label with the following information: Working, 
project name, MID number range. 

Place the accordion files, in numerical order, in a filing cabinet for easy access. 

Watch for duplicate letters and multiple MIDs while filing. Staple the duplicate letters 
(letters labeled “dup of ”) to the corresponding coded letters. File responses with multiple MIDs 
in a separate folder labeled “Multiple MIDs.” 

Clean Copies: 

Place the clean copies into accordion files in numeric order by letter number. Label the accordion 
files with the following information: Clean, project name, letter number range. Clean copies 
aren't written on, stapled or marked in any way, because they will be used to scan or laserfiche 
the project responses.  

After validation is completed, box and store the clean copies. 

Original Responses: 

After the clean, working, and any other client requested copies are made, the original responses 
are placed into accordion files in numeric order by letter number. Label the accordion files with 
the following information: Originals, project name, letter number range. The originals are then 
given to the log manager to be logged. The log manager places the folders in numeric order in a 
filing cabinet. The log manager is responsible for maintaining the locked cabinet of originals for 
the duration of the project. 

Section 1.7 ~ Project Bin Setup 
To organize each project, CAT uses a minimum of three large plastic bins with hanging folders: 
the coding bin, the data entry bin, and the filing bin. 

Coding Bin 

The coding team for a project uses the Coding bin to organize the different phases of the coding 
process. This bin is located in the coding room. 

Folders in this bin are labeled: 
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• 1st Read: Place responses that have received a MID and are ready to be coded in this folder. 

• 2nd Read: Place responses that have been coded and are ready to be reviewed and possibly 
revised in this folder.

• Data Entry: Place responses that have been coded and are ready to be entered into the 
database in this folder. 

• Possible Forms: Place responses that are received separately but contain identical text in this 
folder. When their number is five or more they are considered a form. 

• Out-of-Scope: Place letters that are not directed at the project being analyzed in this folder. 

• Problems: Place duplicate letter numbers, multiple Mail IDs, responses with missing pages, 
fax cover sheets with no additional pages, etc., in this folder. (See Section 6.2, Letter 
Information Block, page 6-3, Section 4.3, Protocol For Multiple MIDs, page 4-23, and 
Section 2.2.1, Protocol For Log in Problems, page 2-6.) 

• Flags: Place responses that meet the requirements for Immediate Attention, indicated by a red 
post-it attached to the left side, Comment Extension, indicated by a yellow post-it attached to 
the left side, or responses that contain an information request, indicated by a blue post-it 
attached to the left side, in this folder.  

Data Entry Bin 

Folders in this bin are labeled: 

• Dups: Place responses that are copies of the same letter sent by the respondent in this folder. 

• MID: Place the working copies of processed responses in this folder to receive a Mail ID.  

• Form Master MID: Place the Form Masters in this folder to receive Mail IDs. 

• Flags: Place responses that meet the requirements for Immediate Attention, indicated by a red 
post-it attached to the left side, Comment Extension, indicated by a yellow post-it attached to 
the left side, or responses that contain an information request, indicated by a blue post-it 
attached to the left side, in this folder. Red/Blue flagged responses are the priority for entry. 

• Problems: Responses with missing pages, fax cover sheets with no additional pages, etc., in 
this folder. (See CH 6, Letter Information Block, CH 4, Protocol for Multiple MIDs, and CH 
2, Protocol for Log in Problems.)

• Out-of-Scope: Place letters that are not directed at the project being analyzed in this folder. 

• Possible Form: Place responses that are received separately but contain identical text in this 
folder. When their number is five or more it is considered a form. 

• Project Info: This folder contains information on the project, including the coding structure, 
etc. 

• Replicate Responses: Place responses that need to have comments replicated (a time saving 
procedure) in this folder. 

• Enter: Place responses that have been coded in this file. 

• Form Master Enter: After a Form Master is coded; place it in this folder to be entered into the 
database.

When form letters are received, two additional folders are made for each form number and are 
labeled:
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• Form (#) MID 
• Form (#) Enter 

When letter generator responses are received, two additional folders are made for each letter 
generator number and are labeled: 

• Letter Gen (#) MID 
• Letter Gen (#) Enter 
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Create Logs from Templates 

Enter Information from Original 
responses

Update Daily 

Create and Maintain Linked Copies 

Daily Backup to CD  

Format Log for Administrative Project 
Record CD 

Chapter 2 ~ Log Procedures 



Technical Guide 

Chapter 2 ~ Log Procedures 2-2

For each project, a log of all responses received is produced and maintained in an Access 
database. The log tracks each letter number and provides a “real time” reference. The linked log 
is created and maintained in a database and is made up of the following information, at 
minimum:

Letter # (Letter Number) Received Date(s) 
SOP (Stage of Process) Remarks 
Organization Optional automated fields: 
Name (Last) Input By 
Name (First) Date Input 
Name (Middle Initial) Modified By 
E-Mail (Address) Date Modified 

Figure 2.1: Log Entry Form 

Section 2.1 ~ Log Entry Form Information 
L# 

The letter number (assigned by the mail processor) that is found in the upper right hand corner of 
the response is auto-filled into the database prior to beginning the logging process. 

SOP 

The Stage of Process is a one digit numeric code that indicates the current stage of process for 
the project. The Stage of Process code remains the same throughout that stage of the project, and 
like the letter number, is auto-filled into the database prior to beginning the logging process.  
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ORGANIZATION 

When the author is speaking on behalf of the organization/business enter the name of the 
organization/business in this field. This allows for the retrieval of specific information from the 
database, such as how many state employees have responded to a project, etc. (See Section 
Chapter 5, Organization/Business Addressing Standards).

NAME 

• Enter Last and First names, and Middle Initial in their respective fields. 

• If the name and/or address on the envelope are different from the name/address in the body 
of the response, use the name and address data in the body of the response. (See Chapter 4, 
Creating a New MID.)

• Be sure to check the envelope for additional information such as complete names, middle 
initials, or complete addresses. 

• Enter the author(s) of the response using the most complete name given.  

• Enter RESIDENT if the author’s name is missing, illegible or is only a first name, but the 
address is legible.  

• Enter ANON if the signature and address are illegible. Enter ANON if the response is noted 
anonymous by the author.  

• Enter UNUSED L# if a response number is skipped.  

• Enter nothing in the name fields if the respondent supplies an e-mail address only. 

• If there are several respondents and one provides a middle initial, enter the name that allows 
the use of the middle initial. Only enter the most complete name and indicate that it is 1 of 
however many signatures in the Remarks field. 

E-MAIL 

Enter a complete e-mail address only. Enter the address as it is written (e.g., LaLoBa@aol.com is 
not entered laloba@aol.com). If the domain is missing, leave the field blank. If there are two e-
mail addresses, enter both separated by a comma and no spaces between. 

RECEIVED DATE 

Enter the date the response was received (as reflected in the date stamp). Check all Original 
copies to verify that all Received dates have been stamped by mail processors. This is one of the 
most important pieces of information entered in the log.  

REMARKS 

This field is used to enter special aspects of the letter or respondent. The drop-down list attached 
to this field includes the following notations to choose from; however information in the 
comments field is not limited to the drop-down list.  

• OOS (Out of Scope) 

• DUP of L#_____ 

• Form Master1 (identifying the form master of form #1) 

• 1 of 2 Signatures (if two individuals with different names and/or addresses sign a response) 

• Pet - 122 names (petition with 122 names) 

• Illegible (for unreadable names) 
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• Pages 2 & 4 missing 

• After Comment Period (for responses logged after the Federal Register deadline) 

• Attachment (for a response with attachment) 

• Cmnty Mtg (community meeting) 

• /s/ (indicating someone other than the author signed the response) 

• 1 of 2 Orgs (2 organizations have signed the response) 

• YML Only (response has no codeable comments and has requested to be included on the 
mailing list) 

• NML (response includes instructions to be excluded from the mailing list) 

• Hnd Dlvrd (Indicates the response was hand delivered instead of being received by mail) 

• Unused Ltr # (Indicates this response number was skipped or not used) 

Input By 

This field is automatically filled in with the logging person's computer profile name. This 
happens as soon as the log person begins to tab through the fields. 

Date Input 

This field is automatically filled in with the date and time at the same time the Input By field is 
created. 

Next Record Button 

When all necessary fields have been filled the log person tabs to the next record button, presses 
enter and the next response record appears. 

Modified by 

This field is automatically filled in with the log person’s computer profile name when the record 
is modified in any way. 

Date Modified 

This field is automatically filled in with the date and time at the same time the Modified By field 
is created. 

Previous Record Button 

Pressing this button allows the log person to return to previously entered records 

Binocular Button 

Pressing this button brings up a “find box” allowing the logging person to enter the piece of data 
being looked for. Using CTRL F will also bring up the find function.  The database is indexed 
and if a match is found the record is retrieved. 

Verified Check Box 

This check box is used to indicate that a difficult to read name has been located and verified via 
the Internet, phone book, etc. When creating MIDs in Oracle for a respondent, use the log to 
verify hard to read information. The log person is creating the correspondence log by looking at 
original copies. They may have also looked up information on the internet to verify a name, etc.   
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Section 2.2 ~ Log Manager Responsibilities 
The following steps help to successfully create and maintain a project log: 

• Copy the Access log template found in the Templates folder into the specific project folder 
that was set up by the Computer Specialist on your C:\Drive or local network drive. At this 
point the linked back-end (be.) database is created. To do so, open the newly named log 
template, go to Tools> Database Utilities>Database Splitter. The Splitter Wizard form opens 
and you are prompted to create a backup database if data could be lost. If not, immediately 
choose "Split the database now." This process moves tables from the current database to a 
new back-end (.be) database. In multi-user environments, this reduced network traffic, and 
allows continuous front-end input without affecting data or interrupting users. It's the front-
end that's copied onto the Desktop of the project log manager, and anyone else who is using 
the log.  Be sure that it's a copy and not a shortcut. (Don't Click and Drag) The log manager 
now enters the project name on the files and on all of the logs within the files. 

• Protect the Back-End by writing it to a CD on a daily basis as a backup measure. 

• The Working Log is the individual team members’ working copy. This copy of the log is 
stored on the individual computer Desktop. Data is saved automatically and immediately to 
the be. log via the link between the Desktop copy and the backend db. on the network drive. 

• Enter information using the original copies. 

• After the responses are logged place them in the labeled folder until it is full then place the 
folder in the file cabinet area designated for this project. The log manager is responsible for 
maintaining the originals file cabinet, including locking it at night. 

• Refer to log procedures for guidelines on entering data. Always enter data consistently.  

• Check all Access tables within the same project database. (e.g., Dups, Out-of-Scope, etc.). 
Enter information from these logs into the main log on a regular basis, usually weekly.  

• Format and print the log as requested. 

• Data may be modified by anyone throughout the project.  

• After project completion the process of validation happens. The validation compares 
responses to the log, ensuring that respondents’ names are correct. 

• Provide a final log to the person scanning to be put on a CD. 

2.2.1 ~ Access Database Trouble-Shooting 
• When the computer has been on for more than 8 hours problems sometimes may occur, 

because the network will sometimes shut down a user if the connection has been up for a 
long period. Reboot to see if this corrects the problem. 

• Make sure the initial set up of log on network drive is correct by doing the following: 

• The front-end database (.mdb) contains the forms, which are linked to the tables in the 
back-end database (be.mdb) on the network drive. The back end database has a “be” on 
the end of the file name. 

• It is important to copy the front-end database, not the back-end. Do not create a shortcut. 
To ensure it was copied right, click on the front-end database icon on your desktop and 
select Properties. The value for Type should be Microsoft Access Application, not 
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Shortcut.  If it says Shortcut, delete it and copy the front-end database from the project 
log file on the network drive. 

• Make sure the path to the back-end database is available.  If not, logging is not possible and 
the following steps are necessary: 

• If the above steps have been completed and there are still error messages, re-link to the back-
end database by doing the following: 

• Open the log database. 

• Click on Tools>Database 
Utilities>Linked Table Manager  

• Click Select All and check the 
Always prompt for new location 
box. 

Figure 2.3: Linked Table Manager 

• When the Select New Location box appears, select the network drive, Projects folder, the 
appropriate project, and the be.mdb log, and click Open.  The path name can vary 
depending on folder structures.  The point is to find the log. be. 

• You should then get a message that says, “All of the selected tables were successfully 
refreshed”.  Click OK and close the linked table manager. 

• If “Admin” appears in the Input by and the Modified by fields instead of the user name do 
the following: 

• Check the pc mapping to the network drive.  If the mapping is missing, close the log and 
re-map the drives. Re-open the log and continue working. 

• If the network drive is down, the program automatically inserts Admin into those records. 
This is acceptable. The records are updated to the correct user name when the network 
drive is back up.  To successfully complete this update, it is important to keep track of 
letter number ranges and the time span for the ranges. This information is given to the log 
manager for update. 

Figure 2.2: Tools Drop Down Menu 
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• If the previously entered records in the log can be viewed, and there are no error messages, 
the work is saved and logging can continue. 

Section 2.3 ~ Logging FAQ’s 
The following is a partial list of Frequently Asked Questions about the Access log.  

Q: Why do the Modified By and Date Modified fields fill in when a record is created? 

A: These fields fill in when the record is entered because they are part of the underlying macro 
“Input By”. However, when the record is entered and edited at a later date these fields fill 
automatically with updated information. (See Chapter 2, Form Information, Modified By.)

Q: Why are original responses used to log (when possible)? 

A: Original responses are used to log because they usually provide a clearer example of the 
respondent’s name and other information than a copied response. 

Q: When do I check the “Verified” box? 

A: The “Verified” box is checked whenever a data tech searches for and finds a difficult to read 
name and or address. This may be the person logging, creating mail ids or someone else. (See 
Chapter 2, Form Information, Verified check box.)

Q: What goes in the “Remarks” field? 

A: This field is used to capture additional information about the respondent. This field has a List 
of Values (LOV) drop-down menu containing pertinent information. However, comments are not 
limited to this LOV. (See Chapter 2, Form Information, Remarks.)

Q: How do I go to the record I want to input? 

A: There are several ways to advance to a record:  

At the bottom of the form, highlight the record number and type the record number to be input. 
Press Enter and the desired record 
will appear.  

Press the Find button (the 
binoculars icon) to bring up a find 
box where the desired number is 
input. Press Find and the desired record will appear. (See Chapter 21, Form Information, Find 
Button.) 

Q: What are the arrows and binoculars buttons for? 

A: These are navigational buttons: The arrow buttons allow the user to go forward one record or 
back to the previous record. (See Chapter 2, Form Information, Next Record Button and 
Previous Record Button.) The binoculars button is described above.  

Figure 2.4: Record Number Field 
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Chapter 3 ~  The CAET Oracle 
Program

Mailing List Form 

Log On to CAET Program 

Start-up Computer 

Form Tally Form Content Analysis 
Form  

Query Project, 
Enter Header 

Information and 
Comments 

Header Entry Form

Mailing List Form 

Query, Create, and 
Modify MIDs 

Enter Form Number and 
Number of Signatures by 

State

Form Tally Form Content Analysis 
Form  

Query Project, 
Enter Header 
Information
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Section 3.1 ~ Computer Commands 
The Technical Guide uses words and symbols to describe a variety of actions. They are 
explained in more detail here to clarify the format of the Technical Guide. 

Figure 3.1: Computer Commands 

Section 3.2 ~ Computer Start-Up 
To start-up the computer, complete the following: 

• Turn on the computer. 

• Enter username. This needs to be setup by the Oracle Administrator. Press Enter or click 
OK.

• Enter user password. Press Enter or click OK.

Section 3.3 ~ Log On To CAET Program 
In order to enter data into the Oracle database you must first log on to the program. 

• Double-click on the program icon on the desktop. 

• Enter username. Press Tab.

• Enter password. Press Tab.

• Enter database alias. Press Enter.

Command Description 

Enter The word Enter is used when referring to pressing the Enter key on the 
keyboard. 

Execute The word Execute is used when referring to performing an action in the 
program.

Cancel The word Cancel is used when referring to the process of recanting any action 
performed in the program. 

[ ] Brackets are used when referring to a [function]. 
< > Angle brackets are used when referring to a <hot key>.

Bold Bold is used when referring to a button, an action or an important word 
(e.g., Enter, Cancel, Never, Always etc.). 

Click The word “click” is used when referring to selecting an icon or button, or 
clicking the mouse. 

Select The word “select” is used when referring to choosing menu items or using the 
mouse.

Press The word “press” is used when referring to actions performed on the keyboard. 
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Section 3.4 ~ CAET Program 
The CAET program is an executable program with two applications: the Mailing List
application and the Content Analysis application. Each application is used during different 
stages of the CA process. The Mailing List application is used to assign mail identification 
numbers (MIDs) and to update already existing MIDs. The Content Analysis application is 
used to enter header information and each respondent’s comments. To open an application, select 
the Menu item File or press <Alt+F> and choose one of the following: Mailing List to create or 
update MIDs or Content Analysis to enter responses. (See Chapters 4, Mail Identification & 6, 
Entering Comments in the Content Analysis Application.)

In each application there are different blocks that are tied to different tables in the Oracle 
database. In each of these blocks there is a series of fields in which to enter information. Each 
field is assigned a color that indicates a different mode or requirement. The following is a list of 
each mode and/or requirement: 

Field Colors:

• Yellow indicates that the application or form is in query mode. 

• Pink or blue indicates that the field information is required. 

• Gray indicates a calculated field and the information in the field are displayed automatically. 

• White indicates that the field is optional. 

Both applications open in query mode. It is necessary to exit query mode <Ctrl+Q> in any 
of the forms or applications before opening another form or application.

Important: Do not minimize the forms. Use the buttons found at the bottom of the form to 
navigate between forms (see Chapter, Additional Form).
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In each form in the CAET program there are buttons indicating a List of Values (LOV). This 
list displays all of the possible entries for a field. To display the LOV either click on the button to 
the immediate right of the field or press [F9] while the cursor is in the field. Select the 
desired value by clicking on it or use the up and down arrows and press Enter. 

Figure 3.2: Mail List Application 
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Content Analysis

Foreign Addresses

Mail ID/Proj

Close

Figure 3.4: Mail ID Application Buttons 

Figure 3.3: Content Analysis Application 

3.4.1.a ~ Additional Program Forms 
Each application contains buttons that open different forms. Each of these forms performs a 
different task. The following is a list of the names and functions of the forms accessible from the 
two main applications. 

3.4.2 ~ Mailing List Application 
Forms 
Click on the Content Analysis button (lower left) to 
toggle between the applications (Mail ID and 
Content Analysis). Click on the Close button to 
close the application. Click on the buttons at the 
bottom of the application to access these forms: 

The Foreign Addresses form is used to create 
MIDs that include foreign address data.  

The MID/Proj form is used in validation and 
verification of duplicate responses. 

(For more information on these forms See Chapter 
4 Accessing Forms In The Mail ID Application.) 

3.4.3 ~ Content Analysis Application Forms 
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Figure 3.5: Content Analysis Application Buttons 

Mailing List

Header Entry

Replicate

Query Comments 

Immediate Attention

Request For 
Information 

Close 

Click on the Mailing List button (lower left) to toggle between the applications (Content 
Analysis and Mail ID). Click on the Close button to close the application. Click on the buttons at 
the bottom of the application to open these 5 forms: 

The Header Entry form is used to enter header information and form letters without additional 
comments. 

The Replicate form is used to copy 
comments from one response and paste 
them into another response. 

The Query Comments form is used 
by the coding staff to find duplicate 
responses or responses that can be 
replicated. This form enables the user 
to query by a phrase or word, and 
thereby determine the letter number of 
a response with similar comments. 

The coding staff uses the Immediate 
Attention form to make notes 
regarding a response requiring 
immediate attention. 

The coding staff uses the Request for 
Information form to make notes regarding a response requesting information. 

(For more information on these forms See Chapter 6, Forms In The Content Analysis 
Application.)

Section 3.5 ~ Menu Bar Drop-down Lists 
The Menu Bar appears as a single line of menu titles and icons across the top of the primary 
window and contains choices for each of the drop-down menus and sub-menus in the CAET 
program.

A drop-down menu appears when you choose a menu title in the menu bar. Note: The
underlined letter indicates a keyboard shortcut. Press <Alt+the letter indicated> to produce 
the drop-down menu. Once the menu is displayed, simply press the letter indicated to perform 
the desired action. 

The following pages look at each menu and its properties. 

Menu Bar 

Figure 3.6: Menu Bar 
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FUNCTION KEYBOARD SHORTCUT 
Accept (Commit) F10 
Application Menu Ctrl + Corresponding Letter 
Block Menu F5 
Cancel ESC 
Clear Block* Shift + F5 
Clear Form* Shift + F7 
Clear Item* Ctrl + U 
Clear Record* Shift + F4 
Count Query Hits* Shift + F2 
Debug Mode* Ctrl + ? 
Delete Backward* Backspace 
Delete Record* Shift + F6 
Display Error* Shift + F1 
Display Windows Alt + W 
Down Ctrl + L, Down Arrow 
Duplicate Item F3 
Duplicate Record F4 
Edit* Ctrl + E 
Enter Query* F7 
Execute Query* F8 
Exit (Cancel Query)* Ctrl + Q 
Help* F1 
Insert Record F6 or Ctrl + L 
Left* Left Arrow 
List of Values* F9 
Main Menu* Ctrl 
Next Block Ctrl + Page Down 
Next Item* Ctrl + Tab 
Next Item* Tab 
Next Primary Key* Shift + F3 
Next Record Shift + Down 
Next Set of Records Ctrl + > 
Previous Block Ctrl + Page Up 
Previous Item* Shift + Tab 
Previous Item* Shift + Control + Tab 
Previous Menu* Ctrl + Enter 
Previous Record Shift + Up 
Print* Shift + F8 
Redefine Username/Password* Ctrl + N 
Return* Enter 
Right* Right Arrow 
Scroll Down* Page Down 
Scroll Up* Page Up 
Show Keys* Ctrl + F1 
Up* Ctrl + P, Up Arrow 

Figure 3.13: Function and Keyboard Shortcuts 

This list is found in the Help drop-down menu. Select Show Keys to display this list. 

* Indicates the function is also available in query mode. 
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Figure 3.14: Project Code Setup Form 

Section 3.7 ~ Project Specific Database 
Information
The Project database setup establishes the project coding structure and demographic codes that 
ensure that all entered data are consistent and accessible. This setup step is necessary before any 
response data can be entered.  The Project Team Leader determines the Project Setup data 
through the creation of the project coding structure at the beginning of each project. Data entry 
enters these data into the program. The Oracle Administrator can transfer Attribution codes from 
the Master Project codes. After this has been completed, modifying the project specific codes can 
be done. 

The following is a list of specific areas of the database that require setup at the beginning of a 
project.

Project Code 

The Project Code is an up to six-character alpha/numeric code used to identify a project. Use a 
project acronym (e.g., SNFP; Sierra Nevada Framework Project) or a shortened version of the 
project name (e.g., PLANR; 
Planning Regulations) for the 
project code.

• In the CAET program click 
on File>Project 
Setup>Project Code.

• A list of projects appears. 
Press [F6] or select 
Record>Insert to insert a 
new project code. 

• Enter the Project Code in 
the Code column and a 
description of the project 
code in the Description 
column.

• Commit.

 Phase 

The Phase code is a one-
character alpha/numeric code that indicates the stage of the project in relation to the NEPA and  
Rulemaking Processes (P: Prescoping (NOI), S: Scoping, D: Draft EIS, F: E, Supplemental EIS, 
Final EIS, I: Interim Rule, A Advanced Notice of Proposed Rule (ANPR), R Proposed Rule, and 
U: Unspecified.). 

• Click on File>Letter Setup>Phase.

• In this form, query the appropriate project. 

• Click on the arrows in any block and a drop-down list of all possible entries for that field 
appears. Choose the appropriate entry. 
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• Commit.

Stage of Process (SOP) 

The Stage of Process code is a one digit numeric code that indicates the current stage of process 
for the project.  

• Click on File>Letter Setup>Stage of Process.

• In this form, query the appropriate project. 

• Enter the code and a description of the code in the Stage of Process block.  

• Commit.

Response Type 

The Response Type identifies the specific format of correspondence. 

• Click on File>Letter Setup>Response Type.

• Query the project in the Response Type field. 

• Enter the response codes and descriptions. 

• Commit.

Delivery Type 

The Delivery Type is an up to two-character alpha/numeric code that identifies how the letter 
was received. 
This information is often consistent from project to project, but for accuracy and to account for 
possible differences, all of the codes and their respective descriptions are entered for each 
project. If they are the same, the computer assistant can copy them as mentioned above. 

• Click on File>Letter Setup>Delivery Type.

• Query the project in the Delivery Type field. 

• Enter the delivery codes and descriptions. 

• Commit.

Immediate Attention 
Immediate Attention codes are applied only to those responses requiring immediate response 
from the client. The Immediate Attention codes are listed in order by priority. If more than one 
code applies to a single response, the code with the highest priority is attached. There are six 
standard numeric immediate attention codes. A red “Post-It Flag” with the corresponding code 
on it is attached to the left side of the coded working copy to indicate it meets the requirements 
for one of the Immediate Attention categories. The Immediate Attention code is an up to two-
character alpha/numeric code. 

• Click on File>Letter Setup>Immediate Attention.

• Query the project in the Immediate Attention field. 

• Enter Immediate Attention codes and descriptions. 

• Commit.
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User Type 
The User Type code is an up to four-character alpha/numeric code that identifies the purpose for 
which a respondent uses public lands (e.g., Rock Climber, Hiker, Area Resident, etc.). This is an 
optional field provided at the clients’ request. 

• Click on File>Letter Setup>User Type.

• Query the project in the User Type field. 

• Enter User Type codes and descriptions. 

• Commit.

Letter Generator Number 

A letter generator is created when an organization uses an interactive website that contains a 
selection of comments from which a respondent composes a letter. Letter generators are given 
unique numeric codes and descriptive names, and are copied and posted for easy access. 

• Click on File>Comment Setup>Letter Generator.

• Query the project in the Letter Generator field. 

• Enter Letter Generator numbers and descriptions. 

• Commit.

Form Number 

A form is defined as five or more responses received separately but containing virtually identical 
text. Each new form is given a unique number (in ascending order) and descriptive name by the 
forms coordinator for tracking purposes. The form code is an up to five-character alpha/numeric 
code.

• Click on File>Letter Setup>Form Number.

• Query the project in the Form Number field. 

• Enter the Form Number and description. 

• Commit.

Common Interest Class 

The Common Interest Class is the up to five-character alpha/numeric code that categorizes 
respondents’ overall views on a particular project. This is an optional field provided at the 
client’s request. 

• Click on File>Letter Setup>Common Interest Class.

• Query the project in the Common Interest Class field. 

• Enter the Common Interest codes and descriptions. 
• Commit. 

Request for Information 

The Request for Information code is an up to five-character alpha/numeric code that identifies 
the type of request for information pertaining to the proposal (e.g., requests for a copy of the 
DEIS summary, full copy of the DEIS, a full copy of DEIS on CD, etc.). There are currently 
eleven designated Information Request codes. The code is written on a blue “Post-It Flag” and 
attached to the left side of the working copy. 
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• Click on File>Letter Setup>Request for Information.

• Query the project in the Request for Information field. 

• Enter the Request for Information codes and descriptions. 
• Commit. 

Comment Extension Period 

The Comment Extension Period code is used to identify requests to extend the comment period. 

• Click on File>Letter Setup>Comment Extension.

• Query the project in the Comment Extension field. 

• Enter the Comment Extension Period codes and descriptions. 
• Commit. 

Organization 

The Organization code is an up to two-character alpha/numeric code representing various Org 
types. Although these codes often remain the same from project to project, to be consistent the 
codes are entered for each project. To save time, if the codes are the same, the computer assistant 
can copy the codes from one project to the next. 

• Click on File>Letter Setup>Organization Type.

• Query the project in the Organization Type field. 

• Enter the organization data. 

• Commit.

Subject 

The Subject code is an up to five-character alpha/numeric code that represents broad themes 
associated with each project, such as natural resources, economics, wildlife, etc.  

• Click on File>Comment Setup>Subject.

• Query the project in the Subject field. 

• Enter the Subject codes and descriptions.  
• Commit. 

• After each subject is committed follow the steps to enter the subsequent category 
information.

Category 

The Category code is an up to five-digit alpha/numeric code that that defines a specific subtopic 
within each subject code, arranged from general to specific. 

• Click on File>Comment Setup>Category.

• Query the project in the Project/Phase block of the Category field. 

• Select a subject and enter each category and its description into the Category Codes. 

• Select the next subject and enter the corresponding category codes and descriptions.  

• Commit.

• Repeat this procedure for each subject. 
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Category 2 Code, Site Specific 1 and 2, Optional 1 and 2 

Alternative codes consist of the following fields: Category 2, Site Specific 1, Site Specific 2, 
Optional 1, and Optional 2. These are used on some projects to identify specific information not 
provided by Subject and Category codes. Alternative codes also provide an efficient way to 
access data for some reports. These codes are comment-specific and follow code entries in the 
left margin of the coded letter. Examples of possible Alternative type codes are national forest 
acronyms, regulation numbers, standard and guideline numbers, region numbers, theme codes, 
and Environmental Impact Statement (EIS) alternative numbers (See Example 4).

• Click on File>Comment Setup>Alternate, Site Specific, Optional 1, or Optional 2
(All of these forms are formatted identically). 

• Query the project in the selected field. 

• Enter the codes and their descriptions in the appropriate blocks. 

Important: Database setup must be completed before the Mail ID process and letter 
entry can begin. 

Remember: Close forms. Do not minimize them  
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Chapter 4 ~ Mail Identification 

The mailing list allows us to create, retrieve, and update individual records in the database. 
These records contain the mailing information of people who comment on particular projects. 
These people are known as respondents.

Section 4.1 ~ Mail ID Basics 
A MID or Mail Identification number is a sequence number, created and maintained by Oracle. 
Each respondent is given a MID number so his or her records can be easily accessed. The MID is 
a unique number defined by the mailing and demographic information (e.g. email address) 
provided by a respondent. This information is used to create mailing labels that allow the client 
to send information regarding the project to the respondents. Email addresses can also be 
grouped by project to send out project-related messages. Once a MID is created in the program, 
this unique number can be assigned or tied to many projects. These labels are printed in block 
format for easy referencing by the Postal Service. Use the most recent postal standards as a guide 
for creating MIDs. 

MIDs are created using the Mailing List application of the CAET program. The Mailing List 
application consists of three blocks: the Mail ID block/table, the Project ID block/table, and the 
Geographic Locations block/table. Use the Mail ID block to create, retrieve, and update 
mailing information. Use the Project ID block to attach the respondent’s record to the 
appropriate project. The Geographic Locations block gives the client the ability to assign 

Working Copies to data entry Mail ID 
Bin

Query response in Mailing List form 

Query successful: Record 
MID on working and enter 

letter # in Remarks 

Query unsuccessful: Create 
new MID, record MID on 
working and enter letter # 

in Remarks 

Response and forms with additional 
comments with Mail ID to Coders

Forms without 
additional

comments go 
directly to data 

entry to be entered
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To exit query mode press <Ctrl+Q> or use the Query drop-down menu and select Cancel. To 
re-enter query mode press [F7], go to the Query drop-down menu and select Enter, or click on 
the flashlight icon at the top of the form. 

MIDs to geographic areas other than a State, County, City or Zip, such as “Northeast,” “Bull 
River,” or “South.” 

4.1.1 ~ Getting Started in the Mailing List Application 
Select Mailing List > File drop-down menu in the Welcome form: The Mailing List application 
opens in query mode, indicated by the yellow fill in the fields. The application must be in query 
mode in order to perform a query. 

4.1.2 ~ Performing A Query 
Executing a query is asking the computer to search the database for specific information. 
When creating a new MID, perform a query to see if the respondent’s record already exists in the 
database. Queries take place in the Mail ID block. 

Performing queries thoroughly is essential in maintaining an accurate database.
Multiple MIDs means that a respondent receives multiple copies of the final document, which is 
not cost efficient. Once a MID is modified or created, the number is written clearly in erasable 
red ink in the MID box in the upper left-hand corner of the response. 

Queries are performed in any field or combination of fields. Including more information narrows 
the query and retrieves fewer records. For best results query less information to retrieve 
more results 

Most records are queried by the last name, physical or email address. However, sometimes 
records are entered incorrectly. Therefore, a respondent is queried in at least two ways. If the 
respondent’s last name is spelled incorrectly, querying by last name and city will not retrieve the 
correct record. Querying by the street name and zip code, however, displays the correct record.  

Click once on the flashlight button to enter 
query mode; click again to execute the query. 

Figure 4.1: Flashlight Button  
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Figure 4.2: Mailing List Block 

There are two fields available in which to enter address information. Most addresses are recorded 
in the Address 1 field. Occasionally, it is necessary to use both the Address 1 and Address 2 
fields. Therefore, when querying an address, especially those of businesses and organizations, 
query in both of the address fields. 

Every field in the Mailing List application is automatically entered in CAPITAL letters except 
for the Email Address field and the Remarks field. 

The Percentage Sign 
Use the percentage sign (%) when querying information. The % is a wildcard and allows for 
broader queries. Enter the information for the query then execute the query. To execute a query, 
press [F8], select the Query drop-down menu and click Execute, or click on the flashlight 
icon.

Example:

A query of %SMITH% retrieves GOLDSMITH, SMITH, and 
SMITHERS, because any record that includes but is not limited to 
SMITH is retrieved. A query of %SMITH retrieves GOLDSMITH and 
SMITH. A query of SMITH% retrieves SMITH, SMITHERS, SMITH 
JR & SMITH PH D. 

The % sign is useful if the name is illegible. 
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Example:

If a respondent’s last name is Johnson, but only “Johns” is legible, a 
query of JOHNS% could retrieve the appropriate MID. 

The % sign is useful when it is unclear how the name might have been input. 

Example:

Querying %Mally brings up O Mally (an incorrect use of a space) and 
O’Mally. 

Use the % sign to query an address. 

Example:

A query of %RIVER% retrieves a variety of addresses, from 1310 
RIVERSIDE DR to 2 RIVER LN. 

Use the box number to query a PO Box. 

Example:

Query %1214% for PO BOX 1214. (To query an address or PO Box, if 
possible include the city, state, or zip code to narrow the search.) 

Use the % sign to query a zip code. 

Example:

A query of 11703% retrieves records that include 5 and 9 digit zip codes. 

Use the % sign to query a fax number if only part of the fax number is legible. 

Use the % sign to query an email address. This field is not case-sensitive. 

Example:

A query of %MONROE@HOTMAIL.COM% retrieves the record 
monroe@hotmail.com. Notice a wildcard symbol is placed in front of 
and at the end of the email address. Many respondents will submit more 
than one email address. This query will find the address whether it is at 
the beginning or end of the multiple addresses. Enter all addresses that 
are known to be of the same respondent.   

Multiple MID Records 

When a query is executed and the records are retrieved there are often multiple records that 
match the query. 

Example:

If Tom Smith sends a response and signs it Tom Smith, he receives his 
own MID. If Tom Smith of the same address sends a response and it is 
signed Tom and Mary Smith, they receive a separate MID. If Tom Smith 
sends a response on behalf of an organization, like the Sierra Club, he is 
assigned another MID because those comments are considered not only 
his, but the organization’s as well. It is important to remember, the 
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respondent must be writing on behalf of the organization, not just as a 
member.  

Multiple matches are indicated at the bottom of the Mailing List application. The word “Count”  

appears followed by a number that indicates the record number currently viewed. If the number 
is followed by a “v” there are additional records that match the criteria of the search.  

Move between records by clicking the record up and record down buttons on the toolbar or 
the up/down arrows or Page Up/Page Down keys on the keyboard. 

If a query retrieves more than one record it is important to view each one. As mentioned earlier, 
a respondent may be assigned more than one MID number. Check all of the respondent’s 
records to assure accurate MID assignment. 

To obtain the number of records that match the criteria of a query use the Count Query Hits 
button. In query mode, enter the criteria of the search then press <Shift+F2> (Count Query 
Hits). The number of records that match those criteria is listed at the bottom of the application. 

If the respondent’s record exists in the database check the Remarks field to see if they have 
already responded to this particular project. If this is the case, check to see if the new response is 
a duplicate of a response already received. (See Section 4.4, Duplicate Responses)

If the respondent is queried and exists in the database, record the letter number of the response in 
the Remarks field of the MID block. (See Section 4.1.3 Remarks Field)

4.1.2.a ~ Creating A New Mail ID 
If no records are retrieved when the query is executed the application remains in query mode. 
Exit query mode in order to create a new MID. Press <Ctrl+Q> or select Cancel from the 
Query drop-down menu. When the query is canceled the field color changes from yellow to 
white (enter mode). 

If several records are retrieved but none of them match the respondent’s information, create a 
new MID. Press [F6] or select Insert from the Record drop-down menu. 

The cursor begins in the Last Name field. 

This indicates there is more than one record that matches the 
criteria of the query, and that the record currently viewed is 
the first in the list of retrieved records. 

Figure 4.3: Query Results  

Figure 4.4: Count Query Hits  
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When entering the respondents’ mailing information, adhere to the USPS postal standards. The 
more consistently these standards are followed, the fewer discrepancies there are in the database. 

When querying and creating foreign address MID cancel the query in the regular MID form, 
press the Foreign Addresses button at the bottom of the form. This will bring up the Foreign 
Addresses MID form in query mode.  

Abbreviate organization names, titles, and address information. The CAET program provides a 
list of abbreviations used in the MID process. Click on the Abbreviations button in the Mail 
ID block to open this LOV (List of Values). The abbreviations list is only displayed when the 
Mailing List application is not in query mode. To display the Abbreviations list without using 
the mouse, navigate to the Organization field and press [F9]. To exit the Abbreviations LOV 
click Cancel.

The Abbreviations Button provides a list of commonly used abbreviations. Use the % sign to 
narrow the search. In the example above “car%” brought up a list of words and their 
abbreviations beginning with c-a-r.  

If the abbreviations list provides a plural alternative, do not include the parentheses in the 
abbreviation (e.g., “(s)”). 

This list of values window does not allow you to fill in or enter data. The data entry person will 
have to manually enter the abbreviation.  

The Mail ID block consists of 23 fields. The following is a list of their names and functions. 

Figure 4.3: Abbreviations LOV 
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Mail ID Field 

The Mail ID field displays the MID number of the respondent’s record. When the respondent’s 
mailing information is entered and committed, this number is assigned automatically. 

PMB or MSC Field 

The attributes associated with the PMB or MSC (Private Mail Box or Mail Stop Code) field are 
discussed in Chapter 5, Post Office Addresses/Private Main Boxes.

Client Field 

When consultants, lawyers, or other legal representatives respond on behalf of an organization or 
an individual, use the Client field to indicate whom they represent. The MID is assigned to the 
lawyer or consultant. Client field information is not included on mailing labels. 

Example:

If a law firm represents several tribes, list the tribes in the Client field, 
the lawyer in the First and Last Name fields, and the law firm in the 
Organization field. 

Always use the ampersand (&) for the word “and” in any relevant field in the Mail ID block. 
These fields include Org, Client, Title, Attn, and First Name. Note: If there is a long list in the 
Client field, separate the names using forward slashes, and not spaces. 

Attention Field 

Use the Attn field to indicate the recipient of future project-related mailings if the recipient is not 
the author. Use this field only when specified by the author. (See last sentence of Last Name 
Field). 

Example:

Gov. Martz writes a letter but requests that Joe Smith (her aide) receive 
the response. The Attn field reads: JOE SMITH. 

Do not use this field for an individual who signs on behalf of another individual. 

Last Name Field 

Use the Last Name field for the last name of the respondent, and also for any titles such as MD, 
PH D (note the space in PH D), or generational designations such as JR or SR. Do not use both 
DR and PH D for one name; if the respondent's signature contains a title, use that one. If not, 
choose one. Always refer to the signature. The designation ESQ is never used. 

Enter names like O’NEAL and O’MALLY with an apostrophe but without spaces. 

Enter names like MCDONALD, MCLEOD or DELAHOYA without a space. (Remember these 
rules when performing queries.) 

When 2 or more respondents with different last names sign a response, enter one last name in the 
Last Name field, and all other names in the First Name field, also using the Middle Initial field if 
possible
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Example: 

Joe Meyers, Stacy M Powers and Marty J Mendel have signed the same 
response. There is only one address, therefore only one MID is created. The 
First Name field includes Joe Meyers, Stacy M Powers & Marty. The Middle 
Initial field has J, and the Last Name field contains Mendel. 

The secondary first name usually holds the title and should be entered as such. 

Example:

Marie and Jacob Evans PH D send a response. Following the above rule, 
the First Name field includes MARIE & JACOB and Last Name field 
EVANS PH D.  

When the written signature and typed signature at the close of a letter are different, 
include both names in the MID. 

Example:

Samuel S. Dodge signs a response, however the name and title directly 
below it indicate that Gerald Dean is the respondent. The First Name 
field includes Gerald Dean & Samuel, the Middle Initial Field includes 
S, and the Last Name field is Dodge. 

Enter double Native American last names only after an Internet search to make sure it’s actually 
two. For example, Thomas J Goes Running may actually be Thomas J GoesRunning. Query the 
program to bring up the name either way.  

When two or more respondents sign a letter and one includes a middle initial, always input the 
respondent with the middle initial last in the First Name field allowing for use of the Middle 
Initial field. Always use the Middle Initial field when possible. 

Example:

Michael T and Jennifer Atkinson sign a letter. The First Name field 
should read JENNIFER & MICHAEL and the Middle Initial field reads 
T.

Exception:  

Sam L and Mrs. Keith write in. Use of the Middle Initial field does not
take precedence over rule inputting Mrs as the second name. First Name 
field: SAM L & MRS, Last Name Field: Keith.  

Enter the word RESIDENT when the address is legible but the name is not. Before doing this, 
always query the physical address to avoid creating multiple MIDs. Enter ANON, not 
RESIDENT, when only a city and state are provided. 

Never enter just a first name. Enter RESIDENT in the Last Name field if an address is provided. 
Enter ANON in the Last Name field if an address is not provided. 

When assigning MID's to anonymous letters (no name or address) or letters where the 
respondent information is illegible, enter ANON in the Last Name field. Include any 
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demographic information available. Using the postmark is acceptable, but use the state only, not 
the city. 

There are pre-designated ANON MIDs in the database for anonymous responses containing only 
a state name. There is also a pre-designated “generic anon” in the database that is used when the 
response lacks any mailing or demographic information.  

Enter only the last name if the letter is signed Jones Family, Jones Residence, or if the letter is 
signed with a last name only. 

Never use RESIDENT or ANON in conjunction with an organization or business. 

If the respondent’s name is difficult to read, check the project log, ask a co-worker for their 
opinion, or use the Internet to search for the respondent.  

Enter the entire hyphenated last name in the Last Name field. If a respondent has two last names 
that are not hyphenated, enter the first last name in the First Name field, and the second last 
name in the Last Name field. 

Example:

Maria Gonzales-Gomez sends a response. The First Name field reads 
MARIA; the Last Name field reads GONZALES-GOMEZ. 

Example:

Sean Simpson O’Rourke sends a response. The First Name field reads 
SEAN SIMPSON. The Last Name field reads O’ROURKE. 

Example:

Roy Ford Jr and his wife, signing only as Mrs, send a response. The First 
Name Field reads ROY & MRS. Last Name field reads FORD JR. 

Example:

Barb Hayward-Johnson and Scott Johnson send a response. Because 
JOHNSON is the shared last name it’s entered into the Last Name field. 
The first Name field includes SCOTT & BARB HAYWARD. However, 
if Barb is the only one to send a response, HAYWARD-JOHNSON goes 
in the Last Name field.  

Example:

 Rachael and C W Quade send a response. RACHAEL and C are entered 
in the First Name field, W in the Middle Initial field.  

Note: If a person signs a letter on behalf of another person, assign the MID to the individual who 
makes the comments, not the person who signs the letter. 

First Name Field 

The First Name field is used for first names, but can also include additional signatures on a 
letter. Example:  
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If a letter is signed by John Jacobs, Millie Nelson, and Tyler Stewart, 
enter JOHN JACOBS & MILLIE NELSON & TYLER in the First Name 
field. Enter STEWART in the Last Name field. 

Include honorifics in the First Name field such as DR, REV, and also the ranks of current or 
retired military personnel. 

Example:

If Reverend Martin Luther King Jr. writes a letter, enter REV MARTIN 
LUTHER in the First Name field and KING JR in the Last Name field. 

Example:

Retired Lt. James T Simmons writes a letter. Enter LT JAMES in the 
first name field, T in the middle initial field, and SIMMONS in the Last 
Name field. 

Enter the most complete name given. For example, if the signature is Bill and the 
address label says William, use William 

Do not use periods. 

Do not use Miss, Ms, Mr, or Mrs. 

Exceptions:  

• If Mrs. William Wilson sends a response, enter MRS WILLIAM in the First Name field, and 
WILSON in the Last Name field. 

• If Mr. and Mrs. James P Jones send a response, enter JAMES P & MRS in the First Name 
field, and JONES in the Last Name field. 

• If Prof. and Mrs. John Sullivan send a response, enter PROF JOHN & MRS in the First 
Name field, and SULLIVAN in the Last Name field. 

• If two doctors with the same last name (Drs. Ken & Katherine Larson) send a response, enter 
DR KEN & DR KATHERINE in the First Name field, and LARSON in the Last Name field. 

Never enter just a first name. Enter RESIDENT in the Last Name field if an address is provided. 
The one exception is religious clergy: Sister Katherine or Father Thomas is entered in the first 
name field, and if a last name is provided it's entered in Last Name field. 

Enter ANON in the Last Name field if an address is not provided. 

Never abbreviate a first name, and always enter the most complete name. 

Example:

Wm. is entered as WILLIAM. 

Example:

If a respondent signs a letter Mike Jackson, but the return address reads 
Michael Jackson, use MICHAEL in the MID. 

Never use nicknames unless it’s the only name given. 
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Example:

A respondent signs a letter Henry “Skipper” Henderson. Do not include 
Skipper in the MID. However, if Skipper Henderson is the only name 
given, the nickname is used. 

If Mary and John Smith are included in the return address, but Mary Smith signs the letter, enter 
only MARY SMITH in the MID because the comments are hers. 

If the signature reads F W Jones, enter F in the First Name field, W in the Middle Initial field, 
and JONES in the Last Name field. 

If the signature reads J George Jones, enter J GEORGE in the First Name field, and JONES in 
the Last Name field. 

Never include a space in a first name. Le Roy is entered as LEROY, La Donna as LADONNA, 
and La Verne as LAVERNE.  

Middle Initial 

Only one character may be entered in the Middle Initial field. 

If respondents use their full middle names, enter this information in the First Name field. 

Example:

Anna Mae Aquash sends a response. Enter ANNA MAE in the First 
Name field and AQUASH in the Last Name field. 

If respondents use two initials in their names, enter the first initial in the First Name field, and 
the second initial in the Middle Initial field. 

Example:

Olive I.M. Boyle sends a response. Enter OLIVE I in the First Name 
field, M in the Middle Initial field, and BOYLE in the Last Name field. 

If a response contains two names, each with a middle initial, enter the names in such a way that 
one of the initials is entered in the Middle Initial field. 

Example:

Clara E. and Malcolm P. Walker write a letter. Enter CLARA E & 
MALCOLM in the First Name field, P in the Middle Initial field, and 
WALKER in the Last Name field.  

Organization Field 

Org stands for organization. Use the Org field if the respondent represents an organization. Data 
from this field is used to generate demographic reports; therefore it is important to fill in this 
field when applicable. 

Figure 4.5: Correct Entry of Two Middle Initials 
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Use the Org field if the response contains the comments of the organization or business. The text 
will usually include pronouns like “we” and “our.” However, if the respondent uses the 
letterhead of the organization or business, and the comments are from an individual, place the 
organization/business name in the Address 1 field, the mailing address in the Address 2 field, 
and do not use the Org field. Remember: for delivery purposes a physical address is less 
important than a PO Box.  

If an organization or business sends a letter and there is no signature it is acceptable to list the 
organization or business without an individual attached to the MID. 

If a response is faxed from a business, but the comments are from an individual and include an 
individual address, do not include the business name in either the Org field or Address 1 field. 

Do not use ANON or RESIDENT in conjunction with an organization or business. 

Do not abbreviate key words in an organization name. 

Example:

ABC Academy should be ABC ACADEMY  

Do not use any punctuation except slashes (/). Replace “and” with &. 

Do not use the word “The” at the beginning of an organization or business name. 

Do not use acronyms in this field unless this is the only information provided. If the respondent 
gives an acronym, search for its meaning on the web. The site www.acronymfinder.com is 
useful in this instance. Also query the address in Zip+4, which may give the business name. Be 
aware that some acronyms have multiple meanings. 

• Always abbreviate the organization type. 

Example:

Corporation should be CORP - do not use periods. 

• Always abbreviate state names. 

Example:

Montana should be MT - do not use periods. 

• Do not use apostrophes. 

Example:

Johnson’s Logging should be JOHNSONS LOGGING 

Title Field 

Use the Title field only if the respondent has a title and an organization affiliation (e.g., PRES, V 
PRES, or SECY). Use standard abbreviations for all titles. 

Example:

If a respondent signs her letter Josie Simmons, Vice President, but she 
does not specify what she is the Vice President of, then omit the title 
from the MID. 

Do not use PH D in this field; include this title in the Last Name field. 
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Use Slashes (/) to separate multiple titles. Do not use Dashes (-). 

Address 1 Field 

The Addr 1 field contains not only PO Boxes and street addresses, but also business name 
information.

Use Addr 1 to record a more specific department of a large business or university. 

Example:

If the Forest Products Laboratory at the University of California writes a 
letter, enter UNIV OF CA in the Org field and FRST PRODTS LAB in 
the Addr 1 field. 

Use appropriate abbreviations for suffixes, directionals, numeric street names, highways, rural 
routes, highway contract routes, and PO Boxes. Use the Abbreviations list or see Chapter 5 
Postal Standards. If there is any doubt about an address, check the Zip+4 website: 
www.usps.com/zip4/.

If an address contains two or more consecutive words that appear in the USPS standard 
abbreviation list, abbreviate the last of the words. The first word(s) is part of the primary name. 

Example:

Both 789 MAIN AVENUE DR and 2345 DEER MOUNTAIN RD are 
correct. 

If the respondent provides both a PO Box and a street address, enter the physical street address in 
Addr 1 and the PO Box in Addr 2. When entering the zip code, verify it is the zip code for the 
PO Box. 

Example:

If respondents list their address as 129 Kennedy Ct/PO Box 305, enter 
129 KENNEDY CT in the Addr 1 field and PO BOX 305 in the Addr 2 
field.

If there is not enough room for the unit designator and the secondary address identifier (e.g., STE 
1300, FL 3, RM 233), enter these alone in Addr 1, and enter the street address in Addr 2.  

Do not double space between words. 

Check all pound signs (#) at the Zip+4 website. Use proper unit designators.  

Figure 4.6 Unit Designator & Secondary Address Identifier 

Secondary Address Identifier
Unit Designator 



Technical Guide 

Chapter 4~Mail Identification  4-14

Do not add a space in a secondary address identifier unless it is verified at the Zip+4 Website. 

Example:

APT 6E – there is no space between 6 and E. 

Do not use dashes unless they are verified at the Zip+4 website.  

Check all addresses with punctuation at the Zip+4 website.  

Do not put a space in street names like MCDONALD. There may be exceptions, check the Zip+4 
website.

Check all highway addresses at the Zip+4 website. 

If an address is checked at the Zip+4 website and modifications are required, record all changes 
in erasable red ink next to the address on the working copy. 

When a clearinghouse is used to process an organization’s letters enter the clearinghouse’s 
address in the Addr 1 field. Enter whom the clearinghouse is representing in the Client field. 

Note: If an individual sends a response using the letterhead of an organization (this includes 
ranches and schools), but does not refer to the organization in its content by using pronouns like 
“we” and “our,” enter the organization name in the Addr 1 field. If the comments are those of the 
author and the organization’s, enter the organization name in the Org field.  

County Field 

The County field fills automatically when a zip code is entered. 

Address 2 Field 

The contents of the Addr 2 field depend on the contents of the Addr 1 field. 

If the Addr 1 field is used to specify a department at a university or business, enter the mailing 
address in the Addr 2 field. 

If there is a PO Box and a street address, enter the street in the Addr 1 field, and the PO Box in 
the Addr 2 field. 

Example:

If respondents list their address as 129 Kennedy Ct/PO Box 305, enter 
129 KENNEDY CT in the Addr 1 field and PO BOX 305 in the Addr 2 
field.

Figure 4.7: Department in Addr 1 
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Figure 4.8: Highlighted City Field  

Zip Code Field 

Enter either the five- or nine-digit zip code in the Zip Code field and press Enter. The city, 
state, and county fields fill in automatically. The city and state fields highlight to remind the user 
to verify that the information is correct. 

When an incorrect zip code is entered, simply move the cursor back one field by pressing 
<Shft+Tab>. Typing the correct zip code replaces the existing information. 

If the street address is not provided, but the city and state are available, always look up the zip 
code for that area at the Zip+4 Website: www.usps.com/zip4/. Select the first zip code from the 
list that is designated “ACCEPTABLE (DEFAULT).” Including the zip code is necessary for 
gathering demographic information. 

If the address is researched at the Zip+4 website, add the additional four digits of the zip code to 
the MID. Record these four digits next to the zip code on the working copy. 

If the four digits are added, include a dash between the original zip code and the additional four 
digits. 

City Field 

Enter the city name in the City field. When the zip code is entered, the city field is filled in 
automatically. 

State Field 

When the zip code is entered, the State field is entered automatically. The State field requires 
the two-character abbreviation. Access the drop-down list of abbreviations located to the 
immediate right of the State field if filling in the State only, and are unsure of the abbreviation.. 

When an address is not provided but the letter has a legible postmark, use the postmark for the 
purpose of gathering demographic information. Use the state only. Do not use the city name 
included in the postmark. 

Phone Field 

Phone field is optional. 

Fax Field 

Enter the fax number in the Fax field. The dashes are added automatically upon exiting the field. 

To access drop-down list of state abbreviations, click on the button, 
or press [F9] when the cursor is in the State field. 

Figure 4.9: Drop-Down Button  
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Email Address Field 

Use the Email Address field for email addresses only. Do not enter websites. An email address 
includes the “@” symbol. 

If a respondents send email and does not provide name and or address, input the email address 
only. Do not add ANON or RESIDENT in the Last Name field. 

Some email headings provide the email address and a name at the top of the page. Use the name 
at the top only if the email is not signed. Do not use a name in the Last Name or First Name 
fields that is part of the email address only.

Example:

Do not use the name Johnnie Jones if the only information on the 
response is johnniejones@juno.com. Include the Name in the MID if 
Johnnie Jones is provided along with the email address. 

It is acceptable to add multiple email addresses to a respondent’s MID. Use commas to separate 
the information, but do not include spaces. 

Example:

jim@juno.com,jimmy@hotmail.com,james@yahoo.com  

Do not add respondents to the mailing list if their MIDs consist of an email address only.(See 
Mailing List Status)

Remarks Field 

The Remarks field is a record of the responses affiliated with a respondent and particular 
project. Each time a respondent comments on a project, the remarks field of the respondent’s 
MID is updated.  

Each MID’s remark field has a specific string of codes. The purpose of this string of codes is to 
identify the project, the type of document (i.e., a form), and the letter number. It is ultimately 
used to identify duplicate responses and the phase of the project.

Note: The easiest way to add the string of codes when creating and updating MIDs is to copy 
and paste the information changing only the letter number each time.

The string of codes begins with a Project ID Abbreviation. Responses addressing the same 
project are added to the existing string. Responses addressing a different project initiate a new 
string of codes beginning with a new Project ID abbreviation. Use brackets to distinguish 
between projects, but do not include them around the first project listed in the string. Do not use 
spaces to separate the data. 

A String of Codes

Ml#6435/1706[Sl#p4478(NML)][V2h#20133,l#4727][BTl#361] 
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Example
Project  Code Document Phase Remark Code 
215 Appeals AP l u  APl#u 

The Document Code identifies the type of response. This Type of Document 
f Form (is followed by the form number) 
g Letter Generator
h Hearing (Transcript)
l Letter 
p Petition 
r Request (followed by a request type) 
w Workshop Notes  
x Resolution 

Phase Code Phase 

d Draft 
f Final 
p Pre-scooping 
s Scoping 
i Interim Directive 
a Advanced Notice of Proposed Rule Making 
E Draft Supplemental EIS 
R Proposed Rule 
u Unspecified 
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Note: If two forms with additional comments are sent by the same respondent, but the additional 
comments differ, indicate that additional comments differ (adtl cmts diff) in the remarks field.

   Example: 

    [P2fl#r1121,1303(adtl cmts diff)] 

Mailing List Status 

The two abbreviations in this section are only used in special cases. No Mailing List (NML) is 
used if the respondent requests removal from the mailing list of a project or if the respondent has 
a non-deliverable physical or email address (e.g., returned mailings). Enter (NML) at the end of 
the string of codes. Yes Mailing List (YML) is used if the respondent does not provide a mailing 
address, but resides in a town with only one zip code; therefore the mail is deliverable due to the 
size of the town. Verify this at the City/State Website. (YML) is also used if the respondent 
requests to be added to the mailing list for a project but makes no comments on the project itself, 
such as filling out a sign-in sheet used at a public hearing. Include (NML) or (YML) at the end of 
the string of codes for the pertinent project. 

Distinguishing Duplicate Letters 

The Remarks field is the best way of catching duplicate responses. (See Chapter 4, Protocol For
Duplicate Responses). If the letter is a duplicate of another response for the same project, this 
must be recorded in the Remarks field. Use a slash to indicate duplicate responses. The / literally 
means “is a duplicate of.” 

Example:

Rosa Parks responds to the Gray Wolf Project. She mails one response 
and emails a second response. The first response is numbered W3075. 
She is assigned a MID and the response is recorded in the Remarks field 
as Wl#3075. The second response arrives and is assigned the number 
W4583. Rosa Parks’ information is queried in the database. The 
Remarks field of her MID indicates she has already responded to the 
Gray Wolf Project. The clean copy of L#3075 is checked, and its content 
is identical to the content of response 4583. In the Remarks field 
(Wl#4583/3075) is recorded. This means Gray Wolf Project response 
4583 is a duplicate of L#3075. The first response to be given a MID 
(3075) is the response that is coded. 

Mailing List Status 
for the SNFP project 

Ml#6435/1706[Sl#p4478(NML)][V2h#20133,l#4727] 
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Examples of Strings of Codes 

The following are examples of strings of codes and their literal translations: 

Sf9#s2244[Rf16#6245,l#x6744/7123][Wl#s275(NML)] 

Sierra Nevada Framework Project form 9 #scoping 2244; Forest Transportation System 
Policy form 16 #6245, letter# late scoping 6744 is a duplicate of 7123 (7123 is the coded 
letter); Gray Wolf Project letter# scoping 275 No Mailing List for the Gray Wolf project 

Created By, Create Date, Modified By, Modified Date Fields 

The Created By field displays the profile of the user who created the record. The Create Date
displays the date and time the record is first committed. The Modified By field displays the 
profile of the user who last committed any changes to the record. The Modified Date displays 
the date and time the modifications are committed. These fields fill in automatically. It is 
possible to query by these fields. 

4.1.2.b ~ School Responses 
Schools often respond to projects. Classes sending batches of letters often include different 
information, which require different considerations when assigning a MID. Follow these 
examples: 

Example 1: 

A class sends a batch of responses. The teacher’s name is included in the 
mailing information, but the students sign only first names on their letter. 
Create a MID using the teacher’s name in the First and Last Name fields. 
Enter the name of the school and the class name (e.g., 4th Grade Class) in 
the Addr 1 field and the mailing address of the school in the Addr 2 field. 
List each response in the Remarks field of the teacher’s MID. The 
mailing list status for this MID is “Yes.” Do not list the students’ first 
names anywhere on the MID. 

Example 2: 

A class sends a batch of responses. The teacher’s name is not included in 
the mailing information. Create a MID using the mailing information and 
the name of the school. Enter nothing in the First and Last Name fields. 
Enter the name of the school and the class name in the Addr 1 field and 
the mailing address of the school in the Addr 2 field. List each response 
in the Remarks field of the MID. The mailing list status for this MID is 
“Yes.” Do not list the students’ first names anywhere on the MID. 

Example 3: 

A class sends a batch of responses. Some students list first and last 
names on their letter. In this case, each student that provides his or her 
first and last name is assigned his or her own MID. The students that do 
not provide their last names are combined in one MID. Use example 1 if 
the teacher’s name is included and example 2 if it is not included. 
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4.1.3 ~ Project IDs Block 
Navigate to the Project IDs block. The information entered in this block determines whether or 
not the respondent is included on the mailing list, and to which projects the respondent’s MID is 
attached.  

Assigning Group 

The Assigning Group field should be done by an Oracle programmer.  District and Forest level 
offices will want to assign their own group name. 

Example:

Enter TLRD Tally Lake Ranger District 

ID

Enter the Project ID in the ID field. Use this only once per project, even though a respondent 
may respond to more than one phase of the project. When the Project ID field is entered twice an 
error message indicates that the row already exists with the same MID code. 

Example:

Enter GWP for the Gray Wolf Project; enter SNFP once for any phase of 
the Sierra Nevada Framework Project, etc. 

Description 

The Description field fills automatically after entering the project in the ID field. 

Mailing List  

Enter “Y” for Yes or “N” for No. Yes indicates either the respondent provided a complete 
mailing address or lives in a small town with only one zip code. (Use the City/State Website to 
check.) In the latter case, be sure to enter “(YML)” in the Remarks field. This indicates the zip 
code was verified on the Internet and is the only zip code for the town in question. 

To remove an incorrect Y or N or the project code: In the ID or Mailing List field remove the 
record by pressing <Shift+F6> or selecting Remove or Clear Record from the Record drop-
down menu., or by backspacing out the unwanted character, entering the correct one and 
pressing commit. After removing the record press [F10] (commit). Finally, enter the correct code 
and commit again. 

Created and Modified Fields 

These fields display the date and time the Project ID is committed and modified, as well as the 
profile of the user who created and/or modified the record. 

Figure 4.11: Project IDs Block 
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4.1.4 ~ Editing MIDs 
To edit a record that already exists in the database, simply query by the MID. Once the record is 
retrieved you can edit, add, or remove information. Always remember to commit.

Find Form 

The Find form, accessed in the Mailing List application, enables the user to perform a query and 
view a list of the results highlight the desired row. Press Tab or click Accept to close the Find 
form and display the Mail ID form with the corresponding MID To display the Find form, the 
Mailing List application must be in query mode. The Find form is titled “Mail ID LOV.” LOV 
stands for “List of Values.” The fields in this form include: Last Name, First Name, 
Organization, City, and Mail ID. Query by any one or a combination of these fields. Use this 
form to display possible multiple MIDs. Use the up/down arrow keys to move around the 
form.. 

• If an individual writes on behalf of an organization or business and refers to “we” in the 
letter, the organization or business is assigned its own MID. If the respondent writes a 
letter and uses the organization’s letterhead and the pronoun “I,” then the respondent is 
assigned his or her own MID. Remember: in the former case the organization name is 
entered in the Org field and in the latter case the organization name is entered in the Addr 
1 field. 

• In some cases, when petitions or other letters with multiple signatures contain individual 
complete addresses for each respondent, the respondents receive their own MID. It is 
acceptable to combine two or three individuals in a MID if they list the same address. 
Assign government officials their own MID. If the petition contains only one address, 
choose one name (try to use an individual with a title) from the signatures and assign only 
one MID. 

• A letter written and signed by several individuals from various organizations but 
affiliated with one main organization (with or without a complete address) receives one 
MID. Remember: Enter the organization name in the Org field. 

• To fix the incorrect entry of a MID when in the Content Analysis form: delete the 
incorrect MID, enter the correct MID, press enter, and then commit. 

• When a congressperson or senator sends a response, check to make sure that it is more 
than a cover letter. Many times individuals write a letter to their congressman or senator 
and these offices forward the letters. Check for a letter attached from the respondent. 

• When a clearinghouse is used to process an organization’s letters enter the 
clearinghouses’ address in the Addr 1 field. Enter whom the clearinghouse is representing 
in the Client field. 

Entering the Address 
• If the respondent provides a PO Box only, enter it in the Addr 1 field. 
• If a respondent provides both a physical address and a PO Box, enter the physical 

address in the Addr 1 field and the PO Box in the Addr 2 field. 
• Use standard abbreviations unless the word is part of the street name. 

Example:
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129 STORM CR RD or 12 S ST should be 129 STORM CREEK RD or 
12 SOUTH ST. 

• Use the proper unit designator, not the pound sign (#) (See Section5.1.3, Directionals 
as Part of Street Name). Use the ZIP+4 Website to verify.

Example:

129 MAIN ST # 6 should be 129 MAIN ST APT 6. 
• Never use more than one space between words or numbers. 
• Enter Zip code., City, State and County will automatically fill. 

Section 4.2 ~ Protocol For Multiple MIDs 
A Multiple MID occurs when a respondent is inadvertently assigned more than one MID. A 
report is generated after each project to check for multiple MIDs. The following rules are used to 
decide when more than one MID for a respondent is correct. 

Correct uses of Multiple MIDs: 

• Tom Smith responds to a project on his own behalf and is assigned a MID. 

• A new MID is assigned when Tom Smith and Janet Inez write in together (there are two 
signatures, Tom Smith and Janet Inez, and one address).  

• A new MID is assigned when Tom Smith writes a letter on behalf of an organization with the 
organization’s address. 

• A new MID is assigned when Tom Smith writes in using email and only includes his email 
address. “N” is entered in the Mailing List field to indicate the lack of a physical address. 

Correcting Multiple MIDs: 

Tom Smith writes another letter using the same address information as his first response, but is 
accidentally assigned a new MID. To delete the duplicate MID: 

• Query the MIDs and decide which MID is easiest to remove from the database. The MID 
with the fewest number of responses entered in the Remarks field is the easiest to remove. 

• Record all of the entries in the Remarks field that will be added to the current MID and 
replace them with the word DELETE in the old MID. 

• Remove all Project Codes in the old MID by selecting Remove or Clear Record from the 
Record drop-down menu, or <Shft+F6> followed by [F10] (commit). 

• Record the MID to be deleted in the Delete MID folder in the appropriate Access project log 
file stored on the K:/drive. 

• To replace the duplicate MID with the correct one, query each attached letter number and 
project in the Content Analysis application. In the MID field, delete the old MID number, 
enter the correct one, and commit. This step is very important.

Section 4.3 ~ Protocol For Duplicate Responses 
A Duplicate Response occurs when the same respondent or respondents send more than one 
copy of the same letter or form. 
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Query the respondent in the Mailing List application to see if they have already been assigned a 
mail identification number (MID). If the respondent is already in the database, do not create a 
new MID. Check the Remarks and Project ID fields in the respondent’s MID to determine if they 
are attached to the project of inquiry. If it is not a duplicate, follow the procedures for updating 
MIDs. (See Chapter 4, Editing MIDs). If there is another letter for the project, it is necessary to 
compare the letter about to be MID'd with the letter already MID'd. 

• If it is a duplicate, record the MID number in the upper left-hand corner, record “Dup of 
L#7” (7 being the letter number of the previously processed response) under the duplicate’s 
letter number, then initial. 

• Enter the duplicate’s letter number in the Remarks field of the Mailing List application as: 
l#20/7, which reads, “Letter number 20 is a duplicate of letter number 7.” Letter number 7 is 
already accounted for in the system; therefore it is processed and coded first. 

• Staple the working copy of the duplicate response to the working copy of the coded response, 
found in the data entry project bin folder. If both copies are not available, put the duplicate 
response in the project bin folder labeled “Dups.” 

• Open the Dup log found in the Access database and record the pertinent information in each 
field of the log. 

The log manager transfers information from the project dup folder into the project log’s 
comments column on a weekly basis. 

When entering the comments of a response and a duplicate response is attached, check to see that 
the duplicate response is entered in the Dup log. 
Duplicate responses placed in the “Dup” folder in the data entry project bin are attached to the 
coded response after all of the working copies have been filed.

Section 4.4 ~ Accessing Forms In The Mail List 
Application
Within the Mail ID application there are the Foreign Mail IDs form and the Mail List/Proj
form. They are accessed by way of the buttons found at the bottom of the Mail ID application.

4.4.1 ~ Foreign Mail List Form 
The Foreign Mail ID form is identical to the Mail ID form except the fields Foreign 
State/County/Province, Postal Code, and Country replace the state and zip code fields. Follow 
the steps for creating and/or editing a MID. (See Chapter 4, Creating a New Mail ID). If the 
foreign address seems incomplete research the international standards on the Internet. Do not 
input overseas military addresses in this form. 

The Find feature in this form differs from the Find feature in the Mail ID block. The only fields 
in this Find form are Last Name, First Name, Country, and Mail ID. Perform a query in any of 
these fields. After retrieving the desired results use the down arrow to scroll through the 
records. Select a record and press Enter, Tab, or click Accept. This closes the Find form and 
displays the record in the Foreign MID form. Only foreign address MIDs are retrieved in the 
Find form of the Foreign MID form. 
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4.4.2 ~ Mail List/Proj Form 
Use the Mail List/Proj form in the validation process and to determine duplicate responses. This 
form combines the information in the MID application and the Content Analysis application. 

The form opens with the MID and Project Code fields in query mode. These fields can be 
queried together or independently. Use the Tab key to move the cursor between the two fields. If 
more than one MID or project is retrieved, use the down arrow key to display each record. 

Querying the MID retrieves the MID information and a list of projects attached to the MID. 
Querying the project retrieves a list of MIDs attached to the project. Query by both fields to 
narrow the search. 

The responses attached to the project displayed in the Project Code field are listed in the Letters 
block.

Example:

If 62593 is listed in the MID field and GWP is listed in the Project Code 
field, the responses in the Letters block are MID 62593’s responses for 
the Gray Wolf project. 

Use the down arrow to view each project and its corresponding responses. 

Figure 4.13: Mail ID/Project Form 
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The Letters block is linked to the Comments block. The comments and their codes listed in the 
Comments block are attached to the response highlighted in the Letters block. 

Use the small scroll bars to the right of each comment to view the whole comment. Use the 
large scroll bar to the far right for viewing the remaining comments of the highlighted 
response.

Section 4.5 ~ Searching The Internet 
A respondent does not always provide a complete mailing address or have legible handwriting. 
The Internet can provide a more complete listing of an individual’s full name and mailing 
information. Searching the Internet for addresses and complete names helps maintain the 
accuracy of the database. Linking phone and fax numbers to more detailed information is done to 
gather more detailed demographic information. 

4.5.1 ~ Types Of Searches 
The purpose determines the type of search. These searches include: reverse lookup, 
people/address search, map search, acronym search (mainly for businesses and organizations), 
phone search, international address search, and international people search. Before selecting a 
search site, identify the desired results. 

To expedite the search process, it is helpful to add search sites to the Favorites window. 

Reverse Lookup 

Use this search when the respondent’s name is illegible but the address is not. For example, if a 
respondent provides the address 123 A St Missoula, MT 59802, but the name is illegible, enter 
the address into any number of reverse search sites listed in Section 4.6.3 Helpful Websites,  to 
search for the complete name. 

The reverse lookup sites usually provide a field for email addresses that are useful if the 
respondent only provides their email address. Occasionally, the search will turn up an address or 
city and state. 

Reverse lookup searches can be broad or narrow depending on how much information is 
provided.

People Search 

This search requires a last name, a city and a state. Use this type of search to find the complete 
mailing address of a respondent. Even if the only information provided by the site is a city and 
state, that information should be added to the MID for demographic purposes. 

Map Search 

The map search is useful if the respondent misspells any address components and the Zip+4 
Website cannot verify the address. The map search can also be helpful if the respondent provides 
a corner address. 

Acronym Search 

Use this search if a respondent uses an acronym that is not listed in the Master Acronym List. 
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International Address Search 

If a response is from a foreign country, use this search to clarify the respondent’s address. 

International People Search 

If a response is from a foreign country, use this search to clarify the respondent’s name. 

4.5.2 ~ Saving Frequently Used Websites 
Click on Start> Programs> Internet Tools> Internet Explorer.

Open the web page to be saved by entering the web address in the address field, (e.g., www.m-
w.com (Merriam Webster On-line dictionary)). 

Open the Favorites window by clicking on the Favorites button at the top of the window. The 
Favorites window opens to the left of the window currently displayed. 

Click on the Add button in the Favorites window. The Website is now saved in the Favorites 
window.

4.5.3 ~ Helpful Websites 
The following Websites can be helpful in creating and editing MIDs. 

Lookups 

Area Codes and Phone Find: http://www.primeris.com/fonefind/ - Provides city and state 
possibilities when inputting area code and/or prefix. 

Advanced Name & Address Lookup: www.anywho.com/wp.html

Ultimate White & Yellow Pages: www.theultimates.com/white/ - Provides white and yellow 
pages searches, an email directory, map sites and reverse phone number searches. Each site 
provides about six different search engines for one search topic. 

US West White & Yellow Pages: www.qwestdex.com/ - Provides searches for businesses, 
residential listings, government listings, and toll free phone numbers. 

Google: www.google.com/ - Large search engine, providing searches for people, business 

Webcrawler People Search: www.webcrawler.com/ - Provides links to yellow pages, people 
searches, maps and directories.  

Yahoo People Search: www.people.yahoo.com

White Pages: www.smartpages.com

Advanced Business Search: www.anywho.com/bgq.html

Reference 

LookUp Directory: www.infospace.com - Provides links to map guides. 

Yahoo Reference: www.dir.yahoo.com/Reference/ - Provides links to acronym and 
abbreviation websites and dictionaries. 

Thesaurus & Dictionary: www.m-w.com/home.htm

Ask Jeeves: www.askjeeves.com
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Acronyms: www.acronymfinder.com

Postal Information 

Zip+4 Code/City/State Zip Code Associations Lookup: www.usps.com/zip4/

Yahoo Postal Info (countries): www.dir.yahoo.com/Reference/Postal_Information/ - Provides 
links to several sites providing postal code information to various countries and to USPS sites. 

Canadian Postal Codes: http: www.westminster.ca/

International Postal Standards: www.bitboost.com/ref/international-address-formats.html

International Directory: www.cern.web.cern.ch/CERN/Divisions/SPL/INFO-PAGE.html - 
Provides an international people search. 

Postal Information and Resources: www.postinfo.net

Australian Postal Information: www.auspost.com.au/international/

Government Information 

Executive Branch Agencies: www.whitehouse.gov/government - Provides links to the three 
branches of government and to federal and independent agencies like the FBI, IRS, and the 
USPS. 

Links to House/Senate members, addresses, etc.: www.thomas.loc.gov/ - Provides links to 
House and Senate members and their staff. 

US Fish & Wildlife Service: www.fws.gov

USGS Survey Results (Fact Sheets By State): www.water.usgs.gov/public/wid/index-
state.html

USDA FS directory: www.fs.fed.us/intro/directory

USDA FS/Region 1 directory: www.fs.fed.us/intro/directory/rg-1.htm

USDA telephone directory: www.usda.gov/phonebook - Provides links to agencies and staff 
offices in the USDA. 

BLM Directory: www.blm.gov/nhp/directory/index.htm

BIA: www.doi.gov/bureau-indian-affairs.html - The “links” page provides links to websites of 
tribes, intertribal organizations, environmental organizations and cultural organizations. The 
home page provides links to offices and divisions of the BIA. 

Agency Search: www.govspot.com - Provides links to local, state and world government sites. 
The three branches of government, justice and military links are also provided. 

Agency Search: www.firstgov.gov/ - Provides an excellent keyword search of government 
agencies. 

Search Site: www.ciir2.cs.umass.edu/Govbot/ - Provides a search of Government websites. 
This site has almost 1.6 million websites in its database.  
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Chapter 5 ~ USPS Postal Standards 
Use the most up-to-date postal standards to create the mail identification numbers (MIDs) used 
to print labels that are easily referenced by the Postal Service. (See Chapter 4 Mail 
Identification) The more consistently these standards are followed, the fewer discrepancies there 
are in the database. 

Jointly developed by the Postal Service and mailing industry, standardized address information 
enhances the processing and delivery of mail, reduces undeliverable-as-addressed mail, and 
provides mutual cost reduction opportunities through improved efficiency. 

A standardized address is one that is fully spelled out and abbreviated using the Postal Service 
standard abbreviations as shown in the Postal Service ZIP+4 Website
(http://www.usps.com/zip4/). 

Figure 5.1: Zip+4 Website 
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Section 5.1 ~ Delivery Address Components 

5.1.1 ~ Street Name 
The ZIP+4 Website indicate the preferred primary street name. 

Example:

MID-ISLAND PLAZA should be MID ISLAND PLZ 

5.1.2 ~ Directionals 
This is a term the Postal Service uses to refer to the part of the address that gives directional 
information for delivery (i.e., N, S, E, W, NE, NW, SE, and SW). Abbreviate directionals to the 
appropriate one- or two-character abbreviation. Refer to figure 5.2 for examples of pre- and post-
directionals.

5.1.3 ~ Directional As Part Of Street Name 
The directional is not abbreviated if it is part of the primary name and appears between the street 
name and the suffix. Verify this at the ZIP+4 Website.

Example:

BAY W DRIVE should be BAY WEST DR 

Pound Sign (#) 

Do not use the pound sign (#) as a secondary unit designator if the correct designation, such as 
APT or STE, is known or is shown in the ZIP+4 Website. If the pound sign (#) is used, there is 
a space between the pound sign and the secondary number 

101 W MAIN ST S APT 12

Pre-directional 

Primary 
Address 
Number

Street
Name

Suffix

Post-directional 

Secondary 
Address 
Range

Secondary 
Address 
Identifier

Figure 5.2: Delivery Address Components 
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Figure 5.3: Rural Route 

H E BROWN 
RR 3 BOX 9  
CANTON OH 44730-9521

Example: 

1500 E MAIN AVE # 201 should be 1500 E MAIN AVE STE 201 

425 FLOWER BLVD #72 should be 425 FLOWER BLVD # 72 

5.1.4 ~ Suffixes 
Abbreviations 

The suffix of the address should conform to the standard suffix abbreviations listed in the ZIP+4
Website.

Two Suffixes 

If an address has two consecutive words that appear on the suffix table, abbreviate the second of 
the two. The first of the two words is part of the primary name. 

For example: 

789 MAIN AVE DR should be 789 MAIN AVENUE DR 

4523 3RD ST CIRCLE W should be 4523 3RD STREET CIR 

Numeric Street Names 

When there are duplicate numeric street names within a postal delivery area one is spelled out 
and one is abbreviated. Enter numeric street names exactly as they appear in the ZIP+4 
Website.

Example:

7TH ST or SEVENTH ST   

Corner Addresses 

Corner addresses are replaced by physical street addresses. If a respondent gives a corner address 
with no primary address number, search for it on the Internet. (Chapter 4 Mail Identification 
Section 4.5) If the physical street address is not found, enter the corner address. 

Example:

5TH AND HIGH should be 514 HIGH ST 

5.1.5 ~ Rural Route Addresses 
Format  

Rural Routes are always abbreviated RR and include a 
Box number. 

Example:

RURAL ROUTE 2 BOX 152 should be RR 2 
BOX 152 
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Leading Zero 

Do not include a leading zero before the rural route number. 

Example:

RR03 BOX 98D should be RR 3 BOX 98D 

Hyphens 

Include hyphens as part of the box number only when indicated in the ZIP+4 Website.

Example:

RR 4 BOX 19-1A is acceptable. 

Designation RFD and RD 

Change the designations RFD and RD (Rural Free Delivery or Rural Delivery) to RR 

Example:

RFD ROUTE 4 #87A should be RR 4 BOX 87A 

Additional Designations 

There are no additional designations, such as town or street names, included with the rural route 
addresses.

Example:

RR 2 BOX 18 BRYAN DAIRY RD should be RR 2 BOX 18. 

Example:

RR 3 BOX 22 NORTH HAMPTON should be RR 3 BOX 22 

If secondary name information is used, as in the Bryan Dairy Road example, place it in the 
Addr 1 field, and the Rural Route in the Addr 2 field of the Mail ID block.

5.1.6 ~ Highway Contract Route Addresses 
Format 

Highway Contract Routes are always abbreviated HC and 
include a Box number.  Do not use the words HIGHWAY 
CONTRACT, ROUTE, NUMBER, NO., or the pound sign 
(#).

Example:

HIGHWAY CONTRACT ROUTE 68 BOX 23A 
should be HC 68 BOX 23A 

Leading Zero 

Do not add a leading zero before the highway contract route number. 

Example:

 HC068 BOX 98D should be HC68 BOX 98D 

B G LIGHT CO 
HC 72 BOX 293A 
DULUTH MN 55811-9702 

Figure 5.4: Highway Contract 
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Hyphens 

Include hyphens as part of the box number only when indicated by the ZIP+4 Website.

Example:

HC 68 BOX 19-2B 

Star Route Designations 

Change the designation STAR ROUTE, which usually refers to highway contract route, to HC 

Example:

 STAR ROUTE 68 BOX # 45 should be HC 68 BOX 45 

Additional Designations 

Do not add designations such as town or street names to the highway contract route addresses.  

Example:

 HC 72 BOX 18 BRYAN DAIRY RD should be HC 72 BOX 18 

If secondary name information is used, as in the above example, place it in the Addr 1 field, 
and the Highway Contract Route number in the Addr 2 field of the Mail ID block. 

Highway Standardization 

The following are examples of county, state, and local highway primary names and the 
standardized format.  

Example Standard 
COUNTY HIGHWAY 140 COUNTY HIGHWAY 140 

COUNTY HWY 60E COUNTY HIGHWAY 60E 

CNTY HWY 20 COUNTY HIGHWAY 20 

COUNTY RD 441 COUNTY ROAD 441 

COUNTY ROAD 110 COUNTY ROAD 110 

CR 1185 COUNTY ROAD 1185 

CNTY RD 33 COUNTY ROAD 33 

CA COUNTY RD 150 CA COUNTY ROAD 150 

*CALIFORNIA COUNTY RD 555  CA COUNTY RD 555 

EXPRESSWAY 55 EXPRESSWAY 55 

FARM TO MARKET 1200 FM 1200 

FM 187 FM 187 

HWY FM 1320 FM 1320 

HIGHWAY 101 HIGHWAY 101 

HIWAY 108A HIGHWAY 108A 

HWY 64 HIGHWAY 64 

HWY 11 BYPASS HIGHWAY 11 BYP 

HWY 66 FRONTAGE RD HIGHWAY 66 FRONTAGE RD 

HIGHWAY 3 BYP ROAD HIGHWAY 3 BYPASS RD 

KY ST HWY 1 KY STATE HIGHWAY 1 

KY STATE HIGHWAY 24 KY STATE HIGHWAY 24 
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Example Standard 
*KENTUCKY STATE HIGHWAY 625 KY STATE HIGHWAY 625 

KENTUCKY 440 KENTUCKY 440 

HIGHWAY 189 KY HIGHWAY 189 

KY 1207 KY HIGHWAY 1207 

KY HWY 75 KY HIGHWAY 75 

I10 INTERSTATE 10 

INTERSTATE 40 INTERSTATE 40 

IH280 INTERSTATE 280 

INTERSTATE HWY 680 INTERSTATE 680 

I 55 BYPASS INTERSTATE 55 BYP 

I 26 BYP ROAD INTERSTATE 26 BYPASS ROAD 

I44 FRONTAGE ROAD INTERSTATE 44 FRONTAGE RD 

ST HIGHWAY 303 STATE HIGHWAY 303 

STATE HIGHWAY 60 STATE HIGHWAY 60 

SR 220 STATE ROAD 220 

ST RD 86 STATE ROAD 86 

STATE ROAD 55 STATE ROAD 55  

SR MM STATE ROUTE MM 

ST RT 175 STATE ROUTE 175 

STATE RTE 260 STATE ROUTE 260 

TOWNSHIP RD 20 TOWNSHIP ROAD 20 

TSR 45 TOWNSHIP ROAD 45 

US 41 SW US HIGHWAY 41 SW 

US HWY 44 US HIGHWAY 44 

KENTUCKY 440 KY HIGHWAY 440 

*Excessive characters. Note: When the name of a state is used as a portion of the primary street 
name, the standard two-letter abbreviation is recommended. Spell out the state name completely 
when the state name is the complete primary street name, such as “OKLAHOMA AVENUE.”  

5.1.7 ~ General Delivery Addresses 
Format 

Use the words GENERAL DELIVERY, do not abbreviate. Add “ –9999” to the end of the zip 
code.

Example:

MR JOHN ADAMS 

GENERAL DELIVERY 

TAMPA FL 33602-9999 
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5.1.8 ~ Post Office Box Addresses/Private Mail Boxes 
Format 

PO Boxes are always abbreviated PO BOX. 

Example:

PO BOX 11890 

PO BOX G 

Remove leading zeros in PO Box numbers as shown in the ZIP+4 Website.

Example:

PO BOX 00145 should be PO BOX 145 

Designations 

PO Box addresses often appear with the words CALLER, FIRM CALLER, BIN, LOCKBOX, or 
DRAWER. Change these to PO BOX. 

Example:

DRAWER L should be PO BOX L 

Private Mailbox Address 

Private companies offer mailbox rental service to individuals or businesses. This service may 
require a “box” number for their final sort. Enter this number, with the appropriate designator 
(i.e., MSC (Mail Stop Code) or PMB (Private Mail Box)) in the MSC PMB field of the Mail ID 
block. The MSC or PMB number should never be placed in the Addr 1 or Addr 2 fields of the 
Mail ID block. 

Example:

ABC COMPANY        should be    MSC 1587

MSC 1587                                        ABC COMPANY 

12 E MAIN AVE STE 209              12 E MAIN AVE STE 209 

KRYTON TN 38188-3637              KRYTON TN 38188-3637

JANICE SMITH 
PO BOX 34 
DULUTH MN 55803-0034

Figure 5.5: Post Office Box 
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Section 5.2 ~ Organization/Business Addressing 
Standards 
Organizations and businesses often include nonessential information in their addresses for 
prestige purposes, and occasionally use multiple versions of their firm name. Organizations and 
businesses do not always apply abbreviation and compression tactics recognized by the Postal 
Service. This inconsistency can result in multiple MIDs and non-deliverable mail. 

The purpose of standard abbreviations and compression guidelines is to provide a uniform 
reference when there is a need to condense address data. The standards contain the following 
components: the preferred arrangement of address information, prioritization of optional line 
compression steps, and a table of standard abbreviations for the most commonly used business 
words. Adhere to these rules of standardization to create and maintain an accurate database. 

5.2.1 ~ Address Information Compression Guidelines 
The Postal Service equipment reads a maximum of 40 characters per line with a maximum of 8 
separate words per line. If either parameter is exceeded, the entire line is ignored. Apply the 
following steps, if it is necessary, to reduce the number of words or characters from an 
organization or business address. The organization/business name is printed on a single line for 
the purpose of creating a mailing label. 

Abbreviations 

Use the standard abbreviations for address information whenever necessary. These abbreviations 
are found in the Abbreviation list accessed in the Mail ID block.  

Right-to-Left Evaluation 

Evaluate each of the address data elements in each address line separately. Always work from 
the right to the left within each address line. 

Example:

Big Business Incorporated is entered BIG BUS INC 

Special Characters 

Remove special characters, multiple blanks, and punctuation as listed below in this order: 

• * Asterisks, except in the Optional Endorsement Line 

• , Commas 

• “ ” Quotations 

• : Colons 

• . Periods 

• ; Semi-colons 

• ( ) Parentheses 

• ‘ Apostrophes 

• @ At 

• - Hyphens, except in hyphenated last names, otherwise replace with a space 
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• / Back slash, remove spaces before and after the / 

• & Ampersand. 

•  Remove Certain Words 

Replace or remove certain words as listed below. However, the use of the standard
abbreviations is preferred over the removal of words. The following compression 
technique is applied only if there is not a standard abbreviation for the word, or to fit words into 
a Mail ID block: 

• Replace and with “&”. 

• Replace number words with numeric symbols: First with 1st. 

• Remove etc., i.e., in care of, and et al.

• Remove words like the, of, by, for, at, and also.

• Remove ATTENTION, ATTN: Attention is a Mail ID block field option. 

• Remove gender words like MS, MRS, MISS, MR, SIR, and ESQ.

Alternate Location 

When the mailing address information (e.g., APT or STE) is part of the address but does not fit 
in the Addr 1 field, all secondary components should be placed in the Addr 1 field and the rest 
in the Addr 2 field. 

Standard State Name Abbreviations 

An individual state name that appears anywhere in a business or organization address is 
abbreviated because of space restrictions. Use the Standard State Abbreviations found in 
the State field’s list of values in the Mail ID block. Whenever possible, begin an 
organization’s name with the state. 

Example:

The State Assembly of California is entered CA ASMBLY. 

Repetitive Word Removal 

Remove repetitive words; however, standard abbreviations are preferred over word removal. The 
compression technique in this step is applied only if standard abbreviations do not meet data 
entry needs. 

Example:

GOODMAN GOODMAN WILSON & HAROLDSON 

GOODMAN WILSON & HAROLDSON – Repetitive word 
removed.

Vowel Removal 

It is recommended that vowels not be removed if the desired address information can be 
compressed by first using the standard abbreviations. 

From the right side of the address lines, beginning with the rightmost word, remove vowels as 
necessary on a word-by-word basis to achieve desired compression. If the first character of a 
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word is a vowel, do not remove that character. It is also recommended that the vowels not be 
removed from the leftmost words. 

Section 5.3 ~ Military Addresses 

5.3.1 ~ Overseas Locations 
Enter overseas military addresses in the MID form, not in 
the Foreign MID form. Overseas military addresses 
contain the APO or FPO designation along with a two-
character “state” abbreviation of AE, AP, or AA and the 
ZIP Code or ZIP+4 codes. 

Example:

APO AE 09001-5275 

FPO AP 96606-2783 

   APO AA 34035-4198 

APO stands for Army and Air Force Post Office. 

FPO stands for Fleet Post Office. 

AE is used for armed forces in Europe, the Middle East, Africa, and Canada. 

AP is used for armed forces in the Pacific. 

AA is used for armed forces in the Americas excluding Canada. 

5.3.1.a ~  APO/FPO Military Addresses Standardization 
Enter APO or FPO in the City field, AE, AP, AA in the State field and the Zip code in the 
Postal Code field. Standardize the APO/FPO military addresses as follows:  

SGT ROBERT SMITH 

PSC 802 BOX 74 

APO AE 09499-0074 

SGT KEVIN TAYLOR 

UNIT 2050 BOX 4190 

APO AP 96278-2050 

SEAMAN JOSEPH DOE 

USCGC HAMILTON 

FPO AP 96667-3931 

SSGT KEVIN BEASLEY 
UNIT 2050 BOX 4190
APO AP 96522-1215 

Figure 5.6: Military Address 
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5.3.2 ~ Domestic Locations 
Use only the approved city name as listed in the City State File at the ZIP+4 Website, along 
with the two-character abbreviation and the ZIP Code or Zip+4 code. 

Example:

MINOT AFB ND 58705-1253 
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Figure 6.1: Project/Phase/Stage of Process  

Chapter 6 ~  Entering Comments in 
the Content Analysis Application 

Content Analysis
Content Analysis 

Project/Phase/Stage of Process , Letters Respondents
Comments Ctrl Page Down
Next Block

Section 6.1 ~ Project/Phase/Stage Of Process 
Block
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Project  

Note:

Example:

Phase and Stage of Process 

Note:

Example of Phase: 

Section 6.2 ~  Letter Information Block 

Letter Attribution Block

Letter No (Number) Field (required)
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•
•

•

•

•

•

•

•

•

Response Type Field (required)

Delivery Type Field (required) 

Immed Attn (Immediate Attention) Field 

User Type Field 

Letter Generator Field 

Form No (Number) Field  

CIC (Common Interest Class) Field  
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Request for Info (Request for Information) Field 

Cmt Ext (Comment Period Extension) Field  

1st/2nd Read Initials and Dates Field  

Total Sigs (Signatures) Field  

Entered By, Entered Date, and Entered Time Fields 

Modified By and Date Fields 

Section 6.3 ~ Respondents Block 

6.3.1.a ~ Mail ID Field (required)

Enter F10

Find

Figure 6.3: Respondents Block 
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OK Enter

Org Type (Organization Type) Field (required)

Sigs (Signatures) Field (required)

Section 6.4 ~ Comments Block 

F9

Ctrl L F6

Comment Amended Check Box 
Figure 6.5:Comments Block 
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Comment No (Number) Field 

Subject Field  

Example:

Category Field 

Example:

Category 2 Field 

Site Specific 1 and Site Specific 2 Fields 

Optional 1 and Optional 2 Fields 

6.4.1 ~ Entering Text 

Tools
Spelling and Grammar. 

<Ctrl+x> <Ctrl+v>

•
•
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•
•

•

Example:

•

•
•
•

Example:

•

Example:

•

Example:

•
•

Example

•
•

first
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•

Example:

•
F10

F6 Ctrl L Next Record

•

Modifying Protected Fields 

•

•

Example:

•
•

For example: 

Section 6.5 ~ Converting Electronic Text 
Using Electronic Data 
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• .TIF file

                                                                Figure 6.6: Locating .TIF File 

• OK.

• Save As Desktop
Save

                           Figure 6.8: Saving .TIF File 

• Download Complete
Desktop

•
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Figure 6.9: .TIF File  

• File Send 
Text to Word... Send Text to 
Word 

                                                
                                          Figure 6.10: Send Text to Word Button     

• Microsoft Office Document Imaging must recognize the 
text in this document (OCR) before you can perform this operation. This may take 
a while OK

Figure 6.11: OCR Error Message 

Figure 6.12: OCR Text Recognition 

• Send Text to Word
All Pages > OK

Figure 6.13: Text to Word Box 
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• Word 

• (See Section 6.4.1, Entering 
Text)

6.5.1 ~ .PDF Files 
• .PDF filePDF filePDF filePDF file

.TIF file (See Chapter 6)

•

Figure 6.14: Adobe Acrobat Reader 

• Text Select Box

                                                                                                    Figure 6.15: Text Select Box    
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• Right Click Select All

Figure 6.16: Select All 

• Right Click Copy

                                                      Figure 6.17: Copying Text 

• Word

• (See Section 6.4.1, 
Entering Text)

6.5.2 ~ Helpful Hints 
• Show/Hide
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Header Entry Replicate Query Comments 
Immediate Attention Request for Information 

Content Analysis

6.5.3 ~ Header Entry Form 
Header Entry

(For a description of form letters see
Chapter 1).

Example:

Header Entry
Header Entry

Header Entry  Project/Phase/Stage of Process 
Header Information Letter Numbers/Respondents
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Project/Phase/Stage of Process 

(See Ch. 6, Project/Phase/Stage of Process Block) 

Header Information/Letter Attribution 

Header entries are covered in 

Letter Number/Respondent Information 

Execute
Commit button

Execute 

Figure 6.19: Project/Phase/Stage of Process Block 

Figure 6.20: Header Information Block 
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6.5.4 ~ Replicating Form 
Replicate

Replicate
Replicate

Project/Phase/Stage of Process Letter
to Be Replicated View Comments

Project/Phase/Stage of Process  

Project/Phase/Stage of Process

Figure 6.21: Header Entry Form 
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Letter to be Replicated 

Letter to be Replicated

View Comment 

View Comment

Example:

Last Original Comment
New Letter Number New First Comment Number

Figure 6.22: Project/Phase/Stage of Process Block 

Figure 6.23: Letter to be Replicated Block 

Figure 6.24: View Comments Block 
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•

Example:

•

•

Example:

Execute

6.5.5 ~ Query Comments Form 
Query Comments

Query Comments 

Figure 6.25: Replicating Form 

T
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Project/Phase/Stage of Process
Comments

Project /Phase/Stage of Process  

Project/Phase/Stage of Process

Comments

Ctrl Page Down Comments
(See Section 4.1.2, Performing a Query).

Figure 6.26: Project/Phase/Stage of Process Block 

Figure 6.27: Comments Block 
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6.5.6 ~ Immediate Attention Form 

Query

See the Database Report 
Appendix

6.5.7 ~ Request for Information Form 
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Chapter 7 ~ Validation Process 

Validation is the process by which a project database is checked for accuracy and completeness. 
Validation involves checking the information on a response against the information in the 
database. In this chapter, some phases of validation refer to using “original/clean” responses. 
This is a matter of preference. If possible, use the original response, as it contains more 
information. However, sometimes the original responses are sent to the client and are not 
available for use in the validation process. In this case, use the clean copies. 

Validation consists of three phases. Phase I is a validation of the letter number, accounting for 
every response and ensuring that the letter number is in the remarks field of the Mailing List 
form (See Chapter 4, Creating a New Mail ID, Remarks). Phase II is a verification of the name 
by corroborating the information on the letter number report, original or clean copies, and the 
project log. Phase III is a validation of the mailing information, which involves checking the 
MID Report against the working copies. Phase IV is a validation of the header information (See 
Chapter 6, Letter Information Block) and the comments entered in the database (Chapter 6, 
Comments Block), which involves checking the header information and number of comments on 

File Working Copies 

Letter Attribution ValidationLetter Number Validation Mail ID 
Validation

Log  
Validation

Investigate 
Missing Letter 

Numbers

Verify correct 
letter number 

in the Remarks 
field of the 

Mailing List 
form  

Ensure found 
letters are coded 

and entered

Verify correct 
letter #, name, 

org, e-mail 
using project 

log 

Verify correct 
information in 
remarks field, 
org, mailing 
info, mailing 
status, using 

workings 

Verify correct header 
information, # of 

comments coded equals 
# of comments entered 

using workings and 
MID report 

Correct errors in 
the Content 

Analysis form 

Correct errors in 
the Mailing List 

form

Correct errors in 
the log or the 
Mailing List 

form. 
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the MID Report against the working copy of the response. Note: Phase IV is required if a letter 
browser is being created for the project, otherwise it is optional. 

Section 7.1 ~ Pre-Validation Setup  
Do the following in preparation for the Validation process: 

• File all responses in ascending MID order. 

• Staple all duplicate responses to their corresponding responses and file them. 

• Print a copy of the Dup log with the letter numbers in ascending order. 

• Print a copy of the Out-of-Scope log with the letter numbers in ascending order. 

• Ask the log manager to print a copy of the “UNUSED” letter number portion of the project 
log to assist in finding missing letter numbers. 

• Ask the Computer Assistant to print a copy of the last page of the letter number report before 
the full report is run. This page will indicate whether any mistakes were made during 
response entry. 

Example:

If the last letter number in the project is 12,051 then any number greater 
than 12,051 is incorrect. 

Section 7.2 ~ Phase I: Letter Number Validation 
Phase I accounts for all letter numbers and verifies the letter number in the Remarks field of the 
Mailing List form. 

Step One 

Identify inconsistencies in the numeric order of the validation report. 

• The project lead produces the letter number validation report with the letter numbers in 
ascending order. 

• Ask the Oracle Administrator to run a missing letter numbers report with the letter numbers 
in ascending order. Note: This report is not part of the canned Oracle validation reports.  

• Transfer the information derived from the missing letter numbers report to the letter number 
validation report. 

Example:

If there is a gap between letter number 1201 and 1203, write the number 
1202 between the two. This indicates a missing letter number(s) that 
must be accounted for later in the process. 

Step Two 

Account for duplicate responses, out-of-scope responses, and unused letter numbers. 

• Check the Dup log, the Out-of-Scope log, and the Unused Letter Number list for letter 
numbers not found on the validation report. These are the only legitimate reasons for a 
missing letter number. 
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When the missing letter number is accounted for, record the number 
where it would appear on the report and the reason for the inconsistency. 

Step Three 

• Circle all duplicate letter numbers within the same column. 

Letter #  MID  Respondent 

4 65509 SABRINA BROCK 
SPOKANE, WA  99203 
Wl#4 

5 65509 SABRINA BROCK 
SPOKANE, WA  99203 
Wl#5 

6 65606 SHANNON MARTIN 
BALTIMORE, MD  21224-6321 
Wl#6 

7 62219 HAROLD CHRISTIANSON 
NEW YORK, NY  10026 
Wl#7 

7 62222 STEVEN WRIGHT 
FARGO, ND  58102 
Wl#7 

8 62228 CHERYL A MACCARONI 
TITUSVILLE, NJ  08560-1619 
Wl#8,f10#2251[Sl#d7560] 

8 62110 ANGELA HUGHS 
MISSOULA, MT 59801 
Wl#80 

Possible reasons for repeat letter numbers include responses with more than one Mail ID 
attached to it or more than one MID attached inadvertently. 

• Check the remarks on the validation report to verify whether the MID should be attached to 
that response. 

• After each letter number on that page has been verified, make a check mark in the upper right 
corner to indicate the entire page has been reviewed.  

Step Four 

Investigate the missing letter numbers not found in Step 3.  

• Query the missing letter number in the Remarks field of the Mailing List form and compare 
the results with the letter number report. 

Example:

To query Gray Wolf L#1234 enter %W%1234%. 

Figure 7.1: Duplicate Letter Numbers 
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If the query is successful, the response was assigned a MID, but the MID was not attached to the 
response:

• Write the MID next to the missing letter number on the validation report.  

• Check the Remarks field for information to determine why the letter number is missing on 
the validation report. This field also shows if a response is a duplicate, a multiple-signature 
document, etc. 

• Correct all errors. 

If the query is unsuccessful, either the response did not receive a MID or the letter number was 
incorrectly entered in the Remarks field: 

• Check the originals and cleans to determine if a copy of the letter exists. 

• If it does, use the information to find it in the Mailing List form and the Content Analysis 
form. 

• Check the working copy of the response to determine if it has been coded. If the response has 
not been coded, give it to a member of the appropriate coding team to code. Once it’s coded, 
enter the response and file it. If the working copy of the response is coded, query the letter 
number in the Content Analysis form to verify that the response is entered. If the query is 
unsuccessful, enter the response and file it. On the validation report record “entered,” your 
initials, and the date next to the letter number.  

• If the working copy of the response cannot be found, check the Comments column in the 
project log to determine if the response is a duplicate, a petition, or an unused number. A 
letter number is most commonly unused because a letter number is skipped, the response is 
out-of-scope, or the letter number was never reused. 

• If the working copy of the response still cannot be found, the Oracle Administrator will 
search for it in the database using SQL. If this is unsuccessful, make a photocopy of the 
response using the clean copy and stamp “COPY” on the first page. Have the “COPY” coded 
and entered. (If the working copy is eventually found it will replace the “COPY”). 

Always query in the Content Analysis application. Often the letter number is entered 
incorrectly and/or attached to the incorrect MID.  

Step Five 

Verify that the letter number in the Remarks field is accurate. 

Fix any errors in the Mailing List form, and record all changes on the validation report. 

Section 7.3 ~ Phase II: Log Validation  
Phase II ensures that the letter number, name, organization, and e-mail address in the Project log 
match the letter number report and original/clean copy. 

First, compare the original/clean to the letter number validation report, and then compare the in 
the original/clean to the city, state, and zip in the code project log. Next, assure that the letter 
number, name, organization, e-mail address, and comments information on the original/clean 
match the information in the project log.  
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Remember: The log person does not spend as much time searching for a respondent on the 
Internet as a data tech. Although the information entered into the log is usually accurate, defer to 
the validation report. 

Section 7.4 ~ Phase III: MID Validation 
Phase III verifies that the mailing information with the assigned MIDs.  

Compare the information on the original/clean with the “Mail ID for a Project” validation report 
to ensure that the correct MID is attached to the corresponding response. 

• Compare the letter number on the working with the letter number on the validation report to 
ensure accuracy. 

• Compare the Org on the working copy with the Org on the validation report to ensure data 
entry standards are used.  

• Compare the full name on the response with that in the database to ensure that the spelling is 
correct. 

• Compare any other mailing list information, i.e., PMB, Attn, Client, Title, FAX. 

• Compare the address on the working copy with the address on the validation report to ensure 
that the two coincide. MIDs must follow the Postal standards.  

• Compare the e-mail information on both the working copy and the validation report. 

• Compare the mailing list status on the validation report and the mailing information on the 
working copy to verify that the appropriate mailing status is assigned. Check in the 
comments for a request to be removed from the mailing list. 

• Verify that the correct form number is entered. 

• Verify that the remarks have the correct project code, document code, letter number, and/or 
form number. 

Place a check mark next to each of the aforementioned components of the MID to indicate the 
information on the validation report has been reviewed.  

Make all corrections in the Mailing List form, and record the corrections on the validation report. 
When changing a letter number or MID, record the changes on the validation report and 
communicate this information if it affects another person’s validation report. 

Most duplicate responses are discovered in Phase I; however, some are missed. 

Example:

A duplicate response is entered in the Mailing List form but not in the 
dup log, or a duplicate response has been entered incorrectly in the 
Remarks field.

If a duplicate response is discovered, follow the protocols for resolving duplicate responses. (See
Chapter 4, Protocol for Duplicate Response)



Technical Guide 

Chapter 7 ~ Validation Process 7-6

Section 7.5 ~ Phase IV: Letter Attribution 
Validation  
Phase IV ensures that the header or letter attribution information and the comments entered in 
the database match the working copies. A random ten percent of the working copies are checked. 
Verify that the header information on the response matches the information on the validation 
report for the following: Org Type, No of Sigs, Response Type, Immediate Attention, User Type, 
Letter Generator No, Form No, Common Interest Class, Req for Info, and Cmt Ext. Correct any 
mistakes in the Content Analysis application. 

Verify that the number of comments coded on the working copy corresponds with the number of 
comments entered in the Content Analysis application. If the two values are inconsistent, query 
the response in the Content Analysis application to determine the error and correct it. 

If a Coder/Analyst has changed any comment codes after the comment has already been entered 
into the database, there will be a check in the Amended Codes Box. It will not be necessary to 
change codes to match the working copy. 

Figure 7.2 

Remember: Always communicate clearly with the Oracle Administrator, make correction 
requests specific, and always confirm that the problem has been fixed.  
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Chapter 8 ~ Form Tally 
For large projects, the team may receive hundreds of thousands of form letters. The Form Tally
allows us to track how many forms have been received, how many signatures are linked to each 
form, and basic demographic information from each form letter within the project. 

Select Form Tally > File drop-down menu in the Welcome form. 

Section 8.1  ~ Project/Phase/Stage of Process 
Block

Figure 8.1: Project/Phase/Stage of Process Block 

This block contains the codes to distinguish between various projects. Identifying a project is the 
first step in enabling the team to track the form information. (See CH 6, Project/Phase/Stage of 
Process Block, for a detailed description of each field)

Section 8.2  ~ Entering Form Information  
Sequence Number, Form Number, Number of Signatures, and State Abbreviations will be used 
to capture the form information. 

Figure 8.2: Form Information  

Enter Project Code from 
the drop-down menu 

Phase and Stage of 
Process fill automatically 

Sequence Number 
fills automatically Enter the Form Number 

Enter number of Respondents 
that have signed the Form 

Enter the Abbreviated State of Respondent(s)



Technical Guide 

Chapter 8 ~ Form Tally 8-2

Sequence Number 

This is the number of Forms that you have tallied for this group. This field fills automatically and 
will keep progressing after every form you enter.  Whenever possible, tally forms in groups of 
100 or 200 in case an error/problem occurs. (See Form Tally Helpful Hints.)

Form Number 

Forms are sorted during mail processing and will have a corresponding form number (See CH 1 
Forms). Enter this number once, and the same number will automatically appear for every form 
entered within this group.  

Figure 8.3: Entering Form Information 

Number of Signatures 

Enter the number of respondents that have signed the form. This field will automatically fill with 
a (1) every time you hit <Enter> unless you click in the field and manually change it. 
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State Abbreviation 

Enter the Abbreviated State of the respondent(s). Use the drop-down menu if you need help and 
ANON if there is no state provided.  

Figure 8.4: State Abbreviations drop-down menu 

**When there is a ONE form with multiple signatures from multiple states, count the number 
of signatures belonging to each state. Enter the TOTAL number of signatures belonging to each 
state in the Form Tally.  

Section 8.3 ~ Saving Tally Information 
When finished tallying a group of forms, click on the Commit Button.  

• If all information has been entered correctly, all fields will return blank and a message will 
appear at the bottom of the screen indicating how many records have been saved 

• Secure the group of tallied forms together with a rubber band or paper clip 

• In the top right-hand corner of the first form in the group; indicate the amount of forms 
tallied, the date, the form number, the State (or Misc. if there are several states tallied at 
once), and your initials in red ink 

• Place the tallied group of forms in the "Forms Tallied" bin located near the project filing bins 
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Section 8.4 ~ Helpful Hints 
Data entry personnel have found the following tips helpful in completing Form Tallies. 

• If a group of forms will not save, make sure that you did NOT hit the <Enter> key after your 
last entry 

           Figure 8.5: Form Tally that cannot be committed  

• To remove a record, make sure appropriate record has gray fill, click on <Record, <Remove

Figure 8.6: Removing a Record 

• To track your daily records, you may perform a query. To perform a query, click on the 
Queries button and a Query Screen will appear.  

• If you have made a mistake, the Oracle Administrator may alter, add, or delete your records. 

The last field must contain 
an entry before it commits 
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Section 8.5 ~ Email & Fax Form Tally 
When Emails and Faxes remain in electronic file format in Lotus Notes or through a Fax Server, 
Form Tally (Chapter 9: Form Tally) can be done without the use of any paper.  

8.5.1 ~ Lotus Notes Email 
In order to tally emails without printing them, you must toggle between the Content Analysis 
Form Tally application in Oracle and the Lotus Notes project database.  

• Open the Form Tally screen and the Form Folder in Lotus Notes that you wish to tally  
• Set up the Form Tally application to the desired project and the appropriate form 

number, etc. 
By pressing Alt+Tab, you may toggle between the Form Tally active screen and the Lotus Notes 
active screen. 

1. Press Alt+Tab to move back to the Lotus Notes screen 
2. Open the first form that you wish to tally 
3. View the # of Signatures and the State of the respondent 
4. Press Alt+Tab to move back to the Form Tally screen 
5. Enter the Signature and State Information of the form in the Form Tally application and 

then <Enter
6. Press Alt+Tab to move back to the Lotus Notes screen 
7. Open the next form to be tallied by pressing <Enter or using the mouse 

Repeat steps 3-7 until you have tallied 200 records or the entire folder, whichever is less.  

8. In the Form Tally application, Commit the records you have entered 

9. Move the most recently tallied emails into the form's corresponding Tallied Sub-Folder. 
Make sure to move all of the forms you have tallied into the correct folder. You may drag 
multiple emails to the same folder by selecting all emails you wish to add to the folder 
with a checkmark to the left of the email. 

Figure 8.7: Moving Multiple Emails to Tallied Sub-Folder 

• Start the entire process over again until the entire folder for the form is tallied.  
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8.5.1.a ~ Helpful Hints 
• Check that the correct Project IDs and Form Information are entered each time you begin 

to tally a new batch of forms. 
• Remember: Alt+Tab> State >Enter > Alt+Tab> Enter> Alt+Tab> State > Enter >Alt+Tab as

the pattern to tally with.

8.5.2 ~ Faxes  
In order to tally fax .tif files without printing them, you must toggle between the Content 
Analysis Form Tally application in Oracle and the Folder on the C:Drive containing the fax files.  

• Open the Form Tally screen and the Form Folder that you wish to tally  
• Set up the Form Tally application to the desired project and the appropriate form 

number, etc. 

By pressing Alt+Tab, you may toggle between the Form Tally active screen and the Folder screen 
containing the .tif files. 

1. Press Alt+Tab to move back to the Form Folder screen 
2. Open the first form .tif file that you wish to tally 
3. View the # of Signatures and the State of the respondent 
4. Close the form .tif file by clicking the X in the upper right hand corner of 

the screen with the mouse 
5. Press Alt+Tab to move back to the Form Tally screen 
6. Enter the Signature and State Information of the form in the Tally and then <Enter
7. Press Alt+Tab to move back to the Form Folder screen 
8. Open the next form to be tallied by double clicking the .tif file with the mouse 

Figure 8.8: Opening Fax .tif Files 

Repeat steps 3-7 until you have tallied 200 records or the entire folder, whichever is less.  
9. In the Form Tally application, Commit the records you have entered 



Technical Guide 

Chapter 8 ~ Form Tally 8-7

10. Move the most recently tallied emails into the form's corresponding Tallied .zip File. 
• Select all files to be added to the .zip file by holding down the shift key and 

highlighting selected files with the mouse 
• With files still highlighted, Right-click. Select Winzip>Add Files to Winzip 

Figure 8.9: Adding .tif files to Zip File 
• Click Add

Note: Make sure to move all of the forms you have tallied into the correct folder.  

• Start the entire process over again until the entire folder for the form is tallied.  

8.5.2.a ~ Helpful Hints 

• Check that the correct Project IDs and Form Information are entered each time you begin 
to tally a new batch of forms 

• Remember: Alt+Tab> State >Enter > Alt+Tab> Select File> Open File > Close File> 
Alt+Tab> State > Enter >Alt+Tab as the pattern to tally with
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Chapter 9 ~ The Coding Process 
Coding is the foundation of the content analysis process. It provides a starting point for 
identifying public concerns from letters, faxes, emails, and public hearing transcripts (all 
generically referred to as “letters” in this chapter). Specific codes are applied to each 
respondent’s comments, which are entered into a database. Database reports are then generated 
and analyzed to develop public concern lists, appendices, and summaries. 

Section 9.1  ~ The Fine Art of Coding 
Public comment letters display a range of depth and emotion, and vary from bold, simple 
statements to highly detailed analyses of a proposal. Coders are charged with the task of 
dissecting pieces of correspondence and determining which statements are relevant to the 
proposal, which are outside the scope of the proposal, and which restate comments coded earlier 
in the same letter. This section explains what a comment is and what the coding process entails. 

9.1.1  ~ What's a Comment? 
Although many federal agencies use the word “comment” to describe any piece of 
correspondence submitted on a planning project, the Content Analysis Program uses the word 
much more specifically. The word “comment” can be defined as a coherent segment of text that 
will stand-alone as a suggestion, idea, request, or critique. Each comment is assigned a specific 
Management Action and Affected Resource code listed in the coding structure .It is important to 
note that although the team considers every word a person writes, a letter may contain zero 
coded comments or dozens of coded comments.  

Public comments can range from general statements or questions (“I like this . . . I don’t like that 
. . . You should do this . . . Why are you . . .”?) to specific discussion of details (“Your analysis 
of the grazing impacts to allotment 5 does not adequately assess the contribution of . . . .”). It is 
important that coding captures both the content and emotion of a letter. 

Keep in mind that the goal of public comment analysis is to facilitate an accurate and 
comprehensive response to that comment. According to 40 CFR 1503.4 (a), “An agency 
preparing a final environmental impact statement shall assess and consider comments both 
individually and collectively, and shall respond by one or more of the means listed below, stating 
its response in the final statement. Possible responses are to: 

• Modify alternatives including the proposed action. 

• Develop and evaluate alternatives not previously given serious consideration by the agency. 

• Supplement, improve, or modify its analyses. 

• Make factual corrections. 

In addition to the reasons identified by regulation, the process of coding searches public 
comments for people’s explanations of why something should or should not be done. Identifying 
these reasons is important to developing an adequate response to public comment. 

It is also important to capture the general feeling of the public. However, sometimes a public 
comment does not appear directed at the specifics of the project. These comments are considered 
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“out of scope”—outside the scope of the project. There are two different kinds of out of scope 
responses, each of which we deal with in a different way. The first kind is a response regarding 
one project that somehow gets mixed in with the response of another. Usually the mail sorters 
notice and identify this kind of out of scope response and redirect to the correct project or 
agency. If you should come upon one of these letters while coding, please bring it to the attention 
of the Team Leader. The other kind of response is where the sender actually is directed toward 
the particular project, but is not really relevant. While not necessarily related to evaluation of 
alternatives or modification of analyses, comments outside the scope of the project can provide 
important insight into the concerns of people and how they perceive the project. Entire letters 
considered “out of scope” are generally logged and returned to the client for further evaluation. 

Some comments are within the scope of the project but not codeable. Examples of this type of 
comment would include attachments such as newspaper articles, independent studies, etc. (see 
Coding Attachments) or anecdotal comments (“My family has been spending our summers in 
Housekeeping Camp for the past 20 years . . .”). 

9.1.2  ~ Coding Structure Development 
The coding process begins with the development of a coding structure, which is a topical outline 
with alpha and numeric codes attached (see Appendix for a Standard Coding Structure 
Template).The coding structure is used as a tool to identify public comments and sort them into 
recognizable topic categories. Once comments are assigned codes, they are then entered into a 
database from which they can be reported and sorted in any combination needed for analysis. 

The coding structure is logically organized to capture potential public comment on a proposal. It 
includes main topic areas addressed in the proposal as well as those not addressed but still likely 
to receive comment. Letters arriving early in the project may help identify these additional areas 
of concern. The coding structure should be both flexible enough to account for this wide range of 
information and specific enough to avoid ambiguity in coding. 

Coding structures are organized into Management Action and Affected Resource codes. The 
Management Action code represents a specific action that is requested by the individual 
submitting the comment. A Management Action code is made up of a subject code and a 
category code. Subject codes are five-character alpha codes that represent broad themes 
associated with a project, such as natural resources, economics, wildlife, etc. Coders should be 
able to easily recognize sections by subject code names. For example, the environment subject 
code might be assigned the letters ENVIR. Category codes are five-digit numeric codes that 
define specific subtopics within each subject code, and they are generally arranged from the 
general to specific with subcategories nested within categories. For example, the LEGAL subject 
code has a general category code of 30000 and includes a category entitled Federal Laws, Acts, 
and Policies – 30300, under which several subcategories are nested including NEPA (National 
Environmental Policy Act) 30301; APA (Administrative Policy Act) 30302; CAA (Clean Air 
Act) 30303; CWA (Clean Water Act) 30304. (See Example 1)  
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Example 1 ~ Management Action Codes (With Subject and Category Codes) 

LEGAL 30000 Relationship to Applicable Laws, Regulations, and 
Policies 

30100 Adequacy of analysis 
30200 Constitution 
30300 Federal Laws, Acts, and Policies 

30301 NEPA (National Environmental Policy Act) 
30302 APA (Administrative Procedures Act) 
30303 CAA (Clean Air Act) 
30304 CWA (Clean Water Act) 
30305 ESA (Endangered Species Act) 
30306 Fish and Wildlife Conservation Act 
30307 Migratory Bird Treaty Act 
30308 50CFR 21.43 (Depredation Order) 
30309 FIFRA (Federal Insecticide, Fungicide, and Rodenticide Act) 
30400 Relationship to state and local policies and laws 
30401 North Dakota Century Code 
30402 North Dakota Pesticide Act of 1975 
30403 South Dakota Statutory Titles Chapter 11 Section 41-11-10 
30404 South Dakota Codified Laws, Title 38 Sections 20, 20A, 21 
30405 Administrative Rules of South Dakota (Water Quality) 

CATEGORY 2 FIELD 
Affected Resource Code (the whys – the effect) 
The third code assigned to a comment is the Affected Resource code. This code represents either 
the reason why the specific management action is requested or the resource that is affected by the 
action. Affected Resource codes are three digit numbers that generally correspond to the 
numerical scheme of the Management Action codes. In the following example, the affected 
resource code for Legal is 300 while the Management Action codes for Legal are found under 
LEGAL 30000. (see Appendix for standard Affected Resource codes)

100 – Planning decisions/decision authority 
101 – Other USDA/APHIS rules/policies 
102 – Administrative effectiveness/efficiency  
103 – Trust and integrity - general 
104 – T&I USDA/APHIS 
105 – Influence of interest groups 
106 – Influence of industry groups 
107 – Influence of environmental groups 
108 – Public relations/public involvement/public opinion 
109 – Adequacy/availability of information 
110 – Outreach/agency communication efforts 
111 – Public education/understanding 
112 – Relations with other agencies/orgs 
113 – Agency funding/staffing/structure 

Subject code 

Category code 
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Fig. 9.1 Example 2 ~ Project Code Setup Form 

200 – Alternatives 

300 – Laws, policies, and legal issues 

9.1.2.a  ~ Project Specific Database Setup 
The Project database setup establishes the project coding structure and demographic codes that 
ensure that all entered data are consistent and accessible. This setup step is necessary before any 
response data can be entered.  The Project Team Leader determines the Project Setup data 
through the creation of the project coding structure at the beginning of each project. Data entry 
enters this data into the program. If there is a change in the coding structure, make sure it gets 
added or deleted in the setup.  

The following is a list of specific areas of the database that require setup at the beginning of a 
project.

Project Code 

The Project Code is an up to six-character alpha/numeric code used to identify a project (e.g., 
SNFP; Sierra Nevada Framework Project, or PLANR; Planning Regulations) for the project 
code. This project ID will 
remain the same throughout all 
of the different phases of the 
project.

• In the CAT program click 
on File>Project 
Setup>Project Code.

• A list of all CAT projects 
appears. Press [F6] or select 
Record>Insert to insert a 
new project code. 

• Enter the Project Code in 
the Code column and a 
description of the project 
code in the Description 
column.

• Commit.

 Phase 

The Phase code is a one-character alpha/numeric code that indicates the stage of the project in 
relation to the NEPA or Rule-making process (P: Pre-scoping, S: Scoping, D: Draft EIS, E: Draft 
Supplemental EIS, F: Final EIS, I: Interim Directive, A: Advanced Notice of Proposed Rule, R: 
Proposed Rule, and U: Unspecified.). 

• Click on File>Letter Setup>Phase.

• In this form, query the appropriate project. 
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• Click on the arrows in any block and a drop-down list of all possible entries for that field 
appears. Choose the appropriate entry. 

• Commit.

Stage of Process (SOP) 

The Stage of Process code is a one digit numeric code that indicates the current stage of process 
for the project. In the SOP description, enter the comment period dates. If the comment period 
gets extended, use a new SOP period. This allows you to run separate database reports for each 
comment period.

• Click on File>Letter Setup>Stage of Process.

• In this form, query the appropriate project. 

• Enter the code and a description of the code in the Stage of Process block.  

• Commit.
The letter attribution codes can be transferred from the Master Project set up in the Oracle 
Program. The Project ID in Oracle is called: MTRPRJ 
An Oracle Administrator can transfer these codes. 

Response Type 

The Response Type identifies the specific format of correspondence. The code is an up to two 
numeric codes.

• Click on File>Letter Setup>Response Type. 

• Query the project in the Response Type field. 

• Enter the response codes and descriptions. 

• Commit.

Delivery Type 

The Delivery Type is an up to two-character alpha/numeric code that identifies how the letter 
was received.  

• Click on File>Letter Setup>Delivery Type.

• Query the project in the Delivery Type field. 

• Enter the delivery codes and descriptions. 

• Commit.

Immediate Attention 
Immediate Attention codes are applied only to those responses requiring immediate response 
from the client. The Immediate Attention codes are listed in order by priority. If more than one 
code applies to a single response, the code with the highest priority is attached. There are six 
standard numeric immediate attention codes. A red “Post-It Flag” with the corresponding code 
on it is attached to the left side of the coded working copy to indicate it meets the requirements 
for one of the Immediate Attention categories. The Immediate Attention code is an up to two-
character alpha/numeric code.  

• Click on File>Letter Setup>Immediate Attention.

• Query the project in the Immediate Attention field. 
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• Enter Immediate Attention codes and descriptions. 

• Commit.

User Type 
The User Type code is an up to four-character alpha/numeric code that identifies the purpose for 
which a respondent uses public lands (e.g., Rock Climber, Hiker, Biker, Area Resident, etc.). 
This is an optional field provided at the clients’ request. 

• Click on File>Letter Setup>User Type.

• Query the project in the User Type field. 

• Enter User Type codes and descriptions. 

• Commit.

Letter Generator Number 

A letter generator is created when an organization uses an interactive website that contains a 
selection of comments from which a respondent composes a letter. Letter generators are given 
unique numeric codes and descriptive names, and are copied and posted for easy access. 

• Click on File>Comment Setup>Letter Generator.

• Query the project in the Letter Generator field. 

• Enter Letter Generator numbers and descriptions. 

• Commit.

Form Number 

A form is defined as five or more responses received separately but containing virtually identical 
text. Each new form is given a unique number (in ascending order) and descriptive name by the 
forms coordinator for tracking purposes. The form code is an up to five-character alpha/numeric 
code.

• Click on File>Letter Setup>Form Number.

• Query the project in the Form Number field. 

• Enter the Form Number and description. 

• Commit.

Common Interest Class 

The Common Interest Class is the up to five-character alpha/numeric code that categorizes 
respondents’ overall views on a particular project. This is an optional field. 

• Click on File>Letter Setup>Common Interest Class.

• Query the project in the Common Interest Class field. 

• Enter the Common Interest codes and descriptions. 

• Commit.

Request for Information 

The Request for Information code is an up to five-character alpha/numeric code that identifies 
the type of request for information pertaining to the proposal (e.g., requests for a copy of the 
DEIS summary, full copy of the DEIS, a full copy of DEIS on CD, etc.). There are currently 
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eleven designated Information Request codes. The code is written on a blue “Post-It Flag” and 
attached to the left side of the working copy.  

• Click on File>Letter Setup>Request for Information.

• Query the project in the Request for Information field. 

• Enter the Request for Information codes and descriptions. 

• Commit.

Comment Extension Period 

The Comment Extension Period code is used to identify requests to extend the comment period. 
Standard list: 

• Click on File>Letter Setup>Comment Extension.

• Query the project in the Comment Extension field. 

• Enter the Comment Extension Period codes and descriptions. 

• Commit.

Organization 

The Organization code is an up to two-character alpha/numeric code representing various Org 
types. Although these codes often remain the same from project to project, to be consistent the 
codes are entered for each project.  

• Click on File>Letter Setup>Organization Type.

• Query the project in the Organization Type field. 

• Enter the organization data. 

• Commit.

Subject 

The Subject code is an up to five-character alpha/numeric code that represents broad themes 
associated with each project, such as natural resources, economics, wildlife, etc.  

• Click on File>Comment Setup>Subject.

• Query the project in the Subject field. 

• Enter the Subject codes and descriptions.  

• Commit.
After each subject is committed follow the steps to enter the subsequent category information. 

Category 

The Category code is an up to five-digit alpha/numeric code that that defines a specific subtopic 
within each subject code, arranged from general to specific. 

• Click on File>Comment Setup>Category.

• Query the project in the Project/Phase block of the Category field. 

• Select a subject and enter each category and its description into the Category Codes. 

• Select the next subject and enter the corresponding category codes and descriptions.  
• Commit. 
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Repeat this procedure for each subject. 

Category 2 Code, Site Specific 1 and 2, Optional 1 and 2 

Alternative codes consist of the following fields: Category 2, Site Specific 1, Site Specific 2, 
Optional 1, and Optional 2. These are used on some projects to identify specific information not 
provided by Subject and Category codes. Alternative codes also provide an efficient way to 
access data for some reports. These codes are comment-specific and follow code entries in the 
left margin of the coded letter. Examples of possible Alternative type codes are national forest 
acronyms, regulation numbers, standard and guideline numbers, region numbers, theme codes, 
and Environmental Impact Statement (EIS) alternative numbers (See Example 4).

• Click on File>Comment Setup>Alternate, Site Specific, Optional 1, or Optional 2
(All of these forms are formatted identically). 

• Query the project in the selected field. 

• Enter the codes and their descriptions in the appropriate blocks. 

Important: Database setup must be completed before the Mail ID process and letter 
entry can begin. 

Remember: Close forms. Do not minimize them. 

9.1.3  ~ Coding Process 
The job of the coder is to determine which Management Action and Affected Resource codes 
apply to a variety of responses. Sorting through this information can be a daunting task. 
Therefore, Content Analysis Team developed some basic rules for coding public comments to 
allow more consistency and less redundancy: 

• Be concise and avoid coding lengthy sections. However, in order to accurately reflect a 
person’s sentiments, it may be appropriate to code a large portion of a response document as 
one comment. Code what is necessary to capture why someone feels a certain way. 

• Be as specific as possible without losing the substance of the comment. In other words, do 
not split paragraphs so that the full meaning or emphasis of the comment is lost. When in 
doubt, lump rather than split. If the coded comment cannot stand alone, then go back and 
reread the entire section and include any additional information necessary to form an 
understandable comment. 

• Try to avoid redundancy. If you’ve already captured the facts or sentiments of a statement in 
an earlier comment in the same letter, then skip it. You don’t need to code every line, 
especially when it’s been expressed somewhere else in the document. You may want to write 
“already coded” in the left margin as a hint to your second reader. 

9.1.3.a  ~ Management Action Coding 
Identifying Comments and Their Subjects 

Read each comment and identify: 

WHO is the comment directed to? 

WHAT is the respondent asking for? 
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WHERE is the location that the comment is directed to? 

WHEN should this activity/action take place? 

WHY is the respondent asking for a certain activity/action? 

HOW can the Forest Service (or other agency) accomplish what the respondent is asking for? 

The following is a set of basic rules and processes to ensure more accurate and efficient subject 
and category coding: 

• Be consistent when selecting a subject and category code for certain types of comment. For 
example, all comments about snowmobile access on public lands get coded to RECRE 42300. 
Consistency helps ensure that information is located within relatively discrete sections of the 
database, which increases the efficiency and accuracy of the public concern identification 
process. When overlap or ambiguity occurs, team members decide as a group where the 
specific comment type should be coded. These items should then be documented in a “coding 
bin” (list of group coding updates), which should be posted in the coding room or made 
available in hard copy form. 

• Pick the Management Action code that best captures the action requested by the individual 
writing the comment.  

• Always code in pencil to allow for corrections. 

• Mark coded comments by placing brackets before and after the selected text. 

• Enter the Management Action and Affected Resource codes in the left margin of the coded 
comment. This allows data entry personnel to easily read and track comments. If there is no 
room in the left margin, use your best judgment in writing the code where data entry can 
easily read it. When a comment continues onto the next page in a letter, write “cont” after the 
category code so that data entry personnel can easily track the comment. 

Figure 9.2 Example 3 ~ Coded Letter 
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• When splitting out bulleted statements or separate sentences from within a paragraph to place 
into different code categories, consider whether you have coded a complete thought or 
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concern. In order to ensure the integrity of the comment, sometimes you should include the 
lead-in statement with each comment. See Example 3 for an example of repeating a statement 
for bulleted comments. 

• Without the lead-in statement, the bulleted comments lose the intent of the writer. Code the 
lead-in statement by writing “REPEAT” in the left margin along with the total number of 
comments included with the statement. In this example you would write “REPEAT 3 times” 
in the left margin by the lead-in statement and color the lead statement as you would for other 
coded comment. 

• Do not include transitional phrases such as “because,” “however,” “in addition,” or an 
ellipsis at the beginning of a coded comment. Begin your first bracket after the transitional 
phrase, and make sure the rest of the sentence can stand alone to represent the respondent’s 
comment accurately. 

9.1.3.b  ~ Alternative Codes 
Alternative codes consist of the following fields: Category 2, Site Specific 1, Site Specific 2, 
Optional 1, and Optional 2. These are used on some projects to identify specific information not 
provided by Subject and Category codes. Alternative codes also provide an efficient way to 
access data for some reports. These codes are comment-specific and follow the Management 
Action and Affected Resource code entries in the left margin of the coded letter. Examples of 
possible Alternative type codes are national forest acronyms, regulation numbers, standard and 
guideline numbers, region numbers, theme codes, and Environmental Impact Statement (EIS) 
alternative numbers (See Example 4).

Figure 9.3 Example 4 ~ Alternative Codes Letter with alternative codes

SITE SPECIFIC 1 FIELSITE SPECIFIC 1 FIELSITE SPECIFIC 1 FIELSITE SPECIFIC 1 FIELDDDD

PNF - Plumas NF 
ENF - Eldorado National Forest 
LNF - Lassen National Forest 
MDF - Modoc National Forest 
TNF - Tahoe National Forest 
LMU - Lake Tahoe Basin Management Unit 
STF - Stanislaus National Forest 
SQF - Sequoia National Forest 
SNF - Sierra National Forest 
INF - Inyo National Forest 
PSW - Pacific Southwest Research Station 
RO5 - Regional Office, Region 5 
SAC - Sacramento/Sierra Nevada Framework Project 
TOF – Humboldt/Toiyabe NF, Region 4 
XXX – No originating forest 

 100000 
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USDA Forest Service 
Sierra Nevada Framework 
PO Box 7669 
Missoula, MT 59807 

Comments on Sierra Nevada Forest Plan 
Amendment Draft Environmental Impact 

Statement 

ECONO [I am sitting here, in the middle of our grazing 
81200  allotment on the Modoc National Forest, writing to 
100      you about a most important proposal. If either of the  
MDF    preferred alternatives are implemented our livelihood will       

be negatively effected.] 

PLANN[I’m having a hard time becoming motivated to write  
15100  these comments. We have been bombarded with such an 
100  array of proposals that we can’t keep them straight. We  
XXX don’t understand what the overall, combined effect of the 

roadless, roaded, business plan, water plan, framework, 
etc. will be. No analysis has been offered to the public. I’ve 
heard the same from USFS personnel, we don’t have the 
time to do our work plus the reading, research, and critical 
thinking and writing needed for all of these proposals.] 
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9.1.3.c  ~ Coding Long, Dense Letters 
Concise letters that are well-organized and well-written often contain many codeable comments. 
These letters can be challenging and may be a bit confusing. You will need to be more attentive 
when coding these lengthy letters. Some will receive a red flag and an Early Attention code (see 
Early Attention) that shows they require detailed review by the agency. In most cases, you will 
also code them, but the amount you code will be determined by the type of letter and the client’s 
needs and wishes. You may want to consult with your team leader when you begin to receive big 
letters on a project. Below are a few types of lengthy letters and some advice on handling them: 

• Letters that analyze the proposal in detail. These letters may be 10 to 20 pages long or even 
longer. As long as the comments can be separated and sorted without losing valuable context, 
code as you would normally. Because authors of these letters often repeat themes in 
introductions and summaries, as well as in the body of the letter, watch out for duplication. If 
you have already coded a particular sentiment on page 3, don’t code it again on page 13. If the 
comment on page 13 is more clearly worded or includes more useful detail, code the comment 
on page 13 and erase the codes for the same type of comment on page 3. As a hint to your 
second reader, you may want to write “already coded” in the left margin near the comment 
not selected. 

• Legal letters that analyze the proposal in detail and supply numerous pages of legal 
arguments and citations. Again, as long the comments can be separated and sorted without 
losing valuable context, code them. However, you will want to cut out not only duplication, 
but also much of the legal minutiae not central to the authors’ main points. These letters 
generally are well-organized around topic headings that identify respondents’ primary 
concerns. Make sure to code any informative topic headings and adequate supporting 
information. Some of the legal arguments will be relevant and should be coded, but pages of 
case histories often add little value to the database. Check with your team leader or ask an 
experienced second reader to check your coding. The second reader is responsible for 
ensuring that the first reader attaches red flags to these letters (see CH 10 First and Second 
Readings). A red flag indicates to client that the particular letter is worthy of special attention 
and consideration. 

• Letters with voluminous attachments, including newspaper articles, research studies, 
statistics, etc. Sometimes letters with attachments can pass the 1,000-page mark, and while 
some of these attachments must be coded, some can be left alone. Consult with your team 
leader regarding how much to code (see Coding Attachments).

• Letters with fully developed, detailed alternatives. Often the text of a fully developed 
alternative loses value out of context. Usually you will code some of the summary 
information but not the entire text. You will want to check with your team leader regarding 
the client’s wishes for how to analyze a comprehensive alternative. 

9.1.3.d  ~ Coding Attachments 
Some individuals responding to a call for public comment will include attachments in the form 
of newspaper articles or editorials, journal articles, doctoral dissertations or other written 
material. All attachments shall be coded to the standard attachment code ATTMT 99999, and 
code the subject of the attachment to the affected resource.  Code only the title of the attachment 
and the citation (author and publication). Do not code the attachment itself unless the author of 
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the attachment is the same as the person submitting it. In that case, you will code the attachment 
as you would any other response. 

If, for example, an individual attaches a journal article written by a colleague on the impact of 
roadless areas on water quality, the attachment will be assigned a management code of ATTMT 
99999 and an affected resource code that captures the water quality aspect of the article.  
Another type of attachment that occasionally appears is when an individual submits an email 
with the comment on a project attached as a word document. In this situation, first ensure that the 
document has indeed been attached to the email and was downloaded by the data technicians. 
Next, the attached comments should be coded as usual (assuming the attached document was 
written by the sender of the email). 

9.1.3.e  ~ First and Second Readings 
Letters are read two times to ensure accuracy and consistency. The following defines the roles 
and responsibilities of first and second readers in the coding process. 

First Reader’s Responsibilities: 

The first reader reviews letters and codes comments according to the coding structure and 
“coding bin” items. The specific tasks of the first reader include the following: 
1) Ensuring that a letter is in scope. If not, the letter is filed in the “Out of Scope” folder. 
2) Ensuring that a letter is not a form (see Chapter 10 for instructions on how to identify and 

process forms).
3) Assigning header codes (see Demographic and Header Information).
4) Placing brackets before and after the comment. 
5) Assigning Management Action and Affected Resource codes to each comment in the 

clearest location on the page—in the left margin when possible. 
6) Assigning alternative codes if applicable. 
7) Applying red or blue flags, if applicable, to the left edge of the page. 
8) Initialing and dating the lower right corner of the first page. 

Second Reader’s Responsibilities: 

The second reader reviews the coded letters and either concurs with the first reader or revises the 
coded comment(s). Before making changes, the second reader needs to consult with the first 
reader. If the second reader finds regular occurrences of what the reader perceives to be a 
specific coding error, the second reader should discuss the perceived inaccuracy with the first 
reader and determine the best code for that specific type of comment. The specific tasks of the 
second reader include the following: 
1) Checking header information for accuracy. 
2) Checking that correct alternative codes have been assigned, if applicable. 
3) Checking Management Action and Affected Resource codes for accuracy. 
4) Coloring comments. 
5) Numbering comments—only if the letter is a form master or a form with additional     

comments (see Chapter 10, Forms).
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6) Initialing and dating the lower right corner of the first page below the initials of the first 
reader. 

Coloring the comments 

The second reader also has the task of coloring the coded comments. After reviewing the coded 
letter, the second reader colors each comment with highlighter pens. Coloring helps to reduce 
error and eye strain when comments are entered into the database. The basic rules of coloring are 
these: 

• Use only transparent colored highlighter pens. 

• Color the comment along with its corresponding codes. 

• Color only around the perimeter of the comment and codes. Do not highlight all text or every 
other line in the comment. 

• Alternate colors to help data entry personnel keep track of their place while entering 
comments. 

• Avoid dark colored highlighter pens that make it difficult for data entry people to read the 
text (purple, etc.). 

Alternate Second Read Option

On a project specific basis, there is another type of second read that may be employed. This type 
of read is generally known as the “group read” and involves the printing out and group review of 
a database to help ensure consistent and correct coding. This process, which may be modified for 
different projects, can be summarized as followed: 
1)   First reads are done as usual. 
2)  One person is in charge of second reads. The headers are checked for accuracy and the 

comments are colored. 
3)  The comments are entered into the database. 
4)  A database is printed and reviewed for accuracy by the coding team. Each Management 

Action and Affected Resource is checked for consistency. 
5)   Any changes are entered into the Oracle database. 
6)   The original coded letters are pulled and changed as needed. 
Depending on the size and complexity of the project, a database may be reviewed only once or 
may be reviewed several times at various stages of the project. In some cases, only certain 
sections of the database may have to be reviewed by the coding team. The Team Leader will 
make the determination as to the frequency and detail of database review sessions.  

Section 9.2  ~ Letter Attribution Information 
Demographics give clients the opportunity to identify information including geographic area, 
organization affiliation, response type, and number of respondents. The demographic data is 
supplied by information entered into the Mail Identification (Mail ID) tables in the database by 
the Data Technicians. The Data Technicians will assign each letter a Mail ID number while 
Coders fill in the additional header or letter attribution information. These fields are named 
accordingly in Oracle:  Org Type (OT), No of Sigs (S), Response Type (RT), Delivery Type 
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(DT), Immed Attn (IA), User Type (UT), Letter Generator (LG), Form No (F), CIC (CIC), Req 
for Info (RI), and Comment Ext (CE). 

9.2.1  ~ Letter Attribution Fields 

      

                        x    x     x       1        x         x           
Each box is labeled at the bottom with header codes that identify a demographic type. The goal is 
to organize header information from each response, which allows for more efficient processing 
of header information into the database. Information displayed in each box provides critical data 
used in reporting and in the appendices (For description of letter attribution information see CH 
6, Letter Information Block).

9.2.1.a  ~ Letter Attribution Descriptions 
The following are descriptions of the header codes displayed at the top of each response and the 
information captured within each code. Header code information is subject to change depending 
on the specific project. These are standard and optional codes to choose from.   

MID (Mail Id) Field (required)

The Mail ID is a unique number that is associated with respondent’s name and address 
information. The Mail ID number is assigned by the database. 

Org Type Field (OT) (required)

The Organization Type code identifies a specific type of organization, association, agency, 
government agency, elected official, or individual. The following are standard organization 
types: 

Government Agency/Elected Officials 

Code Description 

F Federal Agency/Elected Official 
N International Government/Association  
S State Government Agency/Elected Official/Association 
C County Government Agency/Elected Official/Association 
T Town/City Government Agency/Elected Official/Association 
Q Tribal Government/Elected Official/Tribal Member/Assn 

Interest Group (includes legal representatives of interest groups) 

A Agriculture Industry or Associations (Farm Bureau) 
B Business (my/our (someone speaking for or as a business owner), 

chamber of commerce) 
D Place Based Group (homeowner’s associations, planning 

cooperatives, i.e. Quincy Library Group) 
E Government Employee/Union 
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G Domestic Livestock Industry (incl. permittees) 
H Consultants/legal representatives 
I Individual (unaffiliated, unknown or unidentifiable) 
J Civic Group (Kiwanis, Elks, Community Councils) 
K Special Use Permittee (Rec. homes, Backcountry huts, 

Outfitter/Guides) 
L Timber or Wood Products Industry or Associations 
M Mining Industry/Association (locatable) 
O Oil, Natural Gas, Coal, or Pipeline Industry (leasable) 
P Preservation/Conservation 
R Recreational (motorized/non-motorized, conservation, non-specific 

(-use this general code when client does not require the specific 
recreational organizations- see below) 

U Utility Group (water, electrical, gas) 
X Conservation District 
Y Other or unidentified Organization 
Z Multiple Use or Land Rights Organization 

Optional Organization Codes (Project Specific) 

AD Academic (professor, research scientist, university department) 
AR Animal Rights (humane treatment org) 
BL BLM employee 
BI BIA employee 
CF Commercial Fishing 
CH Church/Religious Group 
EO Extension Office (University) 
FS Forest Service Employee (analyzed separately) 
HT Hunting/trapping industry or Organization 
KS Special Use; Ski Industry (operators, management, interest group 
LO Private Land Owner 
MN Miners (unspecified) 
NP National Park Employee 
PA Professional Association/Society 
QQ Tribal Non-Governmental Organization/Member 
RB Mechanized Recreation (bicycling) 
RC Recreation/Conservation Organization (Trout Unlimited, Elk 

Foundation) 
RM Motorized Recreation (4X4, OHV, snowmobiling) 
RN Non-Motorized/Non-Mechanized Recreation (hiking, x-c ski, 

horse/stock animals) 
SF Small farms/farmers 
XX Regional/other governmental agency (multi-jurisdictional) 

*There may be additional Organizational Types added on a project specific basis. 
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*Notes on Organization Type Identification:* 
Letters from businesses are categorized as “B” only if you believe or they assert they are 
impacted by the decision, otherwise they are considered to be individual responses. A letter from 
a member of an organization is considered to be an individual response unless the author is 
writing on behalf of the organization. 

Letters from government employees submitted as personal are categorized as “I” rather than as 
codes F, N, S, C, T, Q, which are reserved for official comments from an elected official or 
government agency or department. Letters from government employees submitted on 
government letterhead or via government email are considered to be internal comment, and are 
separated from public comment and analyzed separately. 

Sigs Field (S) (required)

The number of signatures is the total count of names associated with a particular Mail ID 
number. The procedure for determining the number of signatures per Mail ID number is 
consistent across all response types. In other words, letters, emails, and other response types will 
be treated the same for determining the number of signatures. 

• Each individual name associated with one Mail ID is counted as one signature. 

• When a Mail ID has no complete name associated with it, such as an anonymous letter 
or an email address, it is counted as one signature. 

• Mr. and Mrs. are counted as two signatures. 

Response Type Field (RT) (required)

The Response Type identifies the specific format of correspondence. The following is a standard 
list of Response Type codes and definitions: 

Code     Description 
1 Letter (postal service, FedEx, UPS, etc.) 
2 Form/Letter Generator 
3 Resolution (generally from local Government such as a County 

Commission) 
4 Action Alert (NGO constituent comment guide) 
5 Transcript (dictated Audio, Video, Telephone response) 
Optional Project Specific Codes: 
6 Public Meeting Comment Form 
7 Public Meeting Transcript (hearing/oral testimony) 
8 Public Meeting Group Notes 
9 Workshop Notes 
10 Web-based Comments 
11 Petition (use when project petitions are of interest) 

Delivery Type Field (DT) (required)

The Delivery Type is the mode of delivery of the original correspondence. 

        Code         Description
E       Email 
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 F              Fax 
 H              Hand delivered/oral testimony (personally delivered) 

M             Mail or Commercial Carrier (FedEx, UPS, includes video, audio, letter       
format) 

 T              Telephone 
 U              Unknown 

Immed Attn Field (IA) 

Immediate Attention codes are applied only to those documents requiring an immediate or early 
response by the project team. The Immediate Attention codes are listed in order by priority. If 
more than one code applies to a single document, the code with the highest priority is attached. 
For example, if a State Congressman threatens bodily harm to a Forest Service representative, 
the letter would receive a “1” instead of a “6.” A red flag is attached to the left side of the page 
with the Immediate Attention code written on it. There are six standard immediate attention 
codes:

   Code         Description
1 Threat of harm – Any response that threatens physical harm to the 

administration or to project or agency personnel. 
2 Notice of appeal or litigation – Any response that describes intent to 

appeal an action or brings legal suit on the agency. 
3 Freedom of Information Act (FOIA) – Any response that officially 

requests information and documentation under the FOIA. 
4 Proposals for new alternatives (in NEPA documents) – Any response 

that discusses a proposal for a new alternative. 
5 Requires detailed review – Any response that requires a detailed review. 

These responses may include map enclosures, detailed scientific analysis, 
or extensive technical edits. 

5a) Provides extensive technical edits - deletions/replacements 
(optional)

 5m) Map(s) attached (optional, project specific)
6 Government entities – Any response from an elected official, writing in 

his/her official capacity, from federal, tribal, state, county, and municipal 
governments; or any official correspondence from a government agency.

6a) Requests for cooperating agency status from a government entity 
7  Requests Public Hearing (optional, project specific) 

User Type Field (UT) 

User Type is an optional code supplied by CAT at the client’s request. A user code defines the 
purpose for which an individual, organization, or agency uses public lands. User types vary 
depending on the project or client needs. Here are some examples of User Types: 

Code    Description
A Area residents 
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B Businesses and services 
K Bikers 
C Campers 
F Anglers 
H Hikers 
P Photographers 
W Non-motorized watercraft users 
R Rock climbers 
S Stock users 
X No identifiable type 

Letter Generator Field (LG) 

A letter generator is a document that enables respondents to extract specific text from a selection 
of prewritten comments. These responses are usually created through an interactive website that 
offers a selection of comments and allows a person to choose which ones to include in their 
personal letter. Many projects will not have any letter generators. It is often large, national 
projects that have portions of letter generators submitted as comment. Example 5 shows a letter 
generator from the Sierra Nevada Framework Project, a project that attracted the attention of 
many national environmental groups.  

To process this type of response, a team member locates the letter generator, often from the 
source website, and prints the complete text. From there, the complete text is coded, given a 
unique numeric code, labeled as the "letter generator master", copied, and posted for reference. 
Coders need to be familiar with letter generators during the coding process to be able to identify 
and process them correctly. 

Responses that include portions or all of the coded comments from the "letter generator master" 
with no additional comments are not coded. These responses are linked to the master in the 
database with a designated "letter generator number." Coders simply write the corresponding 
"letter generator number" in the LG box of the purple worm. We treat all letter generator 
responses as if they contain all the comments in the master. If a response includes additional, 
unique comments, code these and treat the response like a form with additional comments (see 
Forms (F)). Enter the "letter generator number" in the header with a plus (+) sign and code the 
additional comments(s). 
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Figure 9.4 Example 5 ~ Letter Generator (LG) 



Technical Guide 

Chapter 9 -  ~ The Coding Process 9-21

Form No. Field (F) 

The method of processing “forms” began as a device to alleviate the inefficiency of entering 
multiple copies of the same letter into the database. A “form” is defined as five or more 
responses received separately but containing text that is so close that there is no significant 
difference and the difference does not alter the context of the response. 

A “master form” is coded and entered into the database with all of the content information. All 
responses with matching text are then linked to this master form within the database with a 
designated “form number”(see example 7). If a response includes all of the core text from the 
“master form” plus additional text, it is entered as a “form with additional comments.” Such 
letters are identified as forms with additional comments by entering their form number in the 
header with a plus (+) sign (see example 8). All additional comments are coded, numbered using 
the next sequential number after the last comment number on the “master form,” and entered into 
the database. If a respondent omits significant portions of the text presented in a given form, or if 
a respondent makes any substantive changes that clearly alter the context of the form, the 
response is entered as an individual letter. Duplicate responses from four or fewer respondents 
are also entered as individual letters. 

Each new form is given a unique number and descriptive name. One coder is designated as the 
“forms/letter generator coordinator” for a project and is responsible for numbering and tracking 
new forms and letter generators. In addition, the “forms/letter generator coordinator” is 
responsible for the following tasks. 

• Coding all new forms and letter generators and numbering each comment. 

• Writing “MASTER FORM” or "LETTER GENERATOR MASTER" along with a 
descriptive name and a form or letter generator number on the form – preferably at the 
top of the response when possible. 

• Making 3 copies of the “form master” or "letter generator master." 
1) One copy plus the master goes to data entry. 
2) One copy is filed in a separate folder for the “forms/letter generator 

coordinator.”
3) One copy is posted in a convenient location for easy access by coders (coding 

room wall or forms/letter generator book). 

All coders are responsible for checking any suspected forms or letter generators against copies of 
the masters and for giving new forms and letter generators to the “forms/letter generator 
coordinator” to process. Forms and letter generators with additional comments are generally 
numbered by data entry using the original “form number” or "letter generator number" followed 
by a plus (+) sign. These forms or letter generators are returned to the coders who code only the 
additional comments and apply the next consecutive comment number from the master to the 
additional comments (see example 8).
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Figure 9.5 Example 6 ~ Form Master 
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Figure 9.6 Example 7 ~ Form with additional comments 
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CIC Field (CIC) 

The Common Interest Classification codes are an optional. The code represents an effort to 
capture each respondent’s overall view on a proposal. The range of views on a project assumes 
an almost infinite number of values, as each respondent contributes something personal and 
subjective to the analysis. 

CIC codes are not used as a voting procedure. However, CIC categories provide managers with 
an estimate of the respondent’s range of interests, including a range of management actions that 
respondents deem appropriate. CIC codes vary depending on the customer needs. 

Some examples of Common Interest Classifications are: 

Code        Description

O No preference stated. Category O responses are requests for information 
or are requests to extend the comment period and contain no indication of 
position or preference. 

I Respondent favors a more restrictive combination of alternatives/policy 
options. This category includes all responses that claim the chosen 
alternatives do not offer strong enough protection to roadless areas.  
These responses may include suggestions for policies not discussed. 

II Respondent favors a less restrictive combination of alternatives/policy 
options. 
This category includes most responses that convey a degree of support 
for the direction of the policy, but with specific exceptions. 

III Respondent favors no action, a combination of alternatives, or general 
opposition to the plan. 

IV Respondent favors the preferred combination of alternatives or expresses 
general support for the plan. 

Request for Info Field (RI) 

Request for Information codes are applied only to those documents with specific requests for 
information pertaining to the proposal. The client determines the level of specificity for 
identifying information requests. A blue flag is attached to the left side of the page with the 
information request code written on it. There are currently eleven designated Information 
Request codes: 

         Code         Description

A Mailing List only/nothing to code (do not attach a flag)
B Request to be removed from mailing list/Do not include on mailing list (do

not attach a flag)
C Request copy of the Federal Register Notice/IDs 
D Other requests for specific information 
E Request for confirmation of receipt 

Optional Project Specific Codes: 
F Request for hard copy of summary of the DEIS 
G Request for full hard copy of DEIS 
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H Request for CD version of DEIS 
I Request for hard copy of summary of the FEIS 
J Request for full hard copy of FEIS 
K Request for CD version of FEIS 
L Request for draft copy of proposed rule/policy 
M Request for final copy of rule/policy 
Ch Hard copy of Fed Register Notice of the Proposed Rule 
Cd CD of Fed Register Notice of Proposed Rule 
Ce Electronic copy of Fed Register Notice of Proposed Rule 

Comment Extension Field (CE) 

The Comment Period Extension code is entered when there is a specific request for an extension 
of the comment period included in a letter. A yellow flag is attached to the left side of the page 
with the comment extension code written on it. The following is a list of codes for specific 
requests for comment period extension: 

   Code         Description
0      General request for extension of comment period 

15 Request for a 15 day extension of comment period 
30 Request for a 30 day extension of comment period 

 45 Request for a 45 day extension of comment period 
60 Request for a 60 day extension of comment period 
90 Request for a 90 day extension of comment period 

120 Request for a 120 day extension of comment period

Total Signatures (TS) 

This field will tally automatically in Oracle Content Analysis Application form.  
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The Analysis Team produces a public concern list in its analysis of public comment as one tool 
to assist clients in meeting regulatory requirements. A public concern list identifies distinct 
concepts respondents want the client agency to address and organizes these topics into a 
condensed format to facilitate the client agency’s issue identification and response to comment. 
To develop a public concern list, the team evaluates public comments, selects quotations that are 
representative of key ideas, and distills these key ideas into statements that summarize 
respondents’ sentiments regarding a project. 

Section 10.1 ~ Database Analysis 
After a letter has been coded, all reference information and comments are entered into a 
computer program called the comment database. The database allows the team to store and 
organize every segment of information through electronic associations. The team can use these 
associations to recall pertinent information according to multiple variables. During the analysis 
phase of a project, team leaders will periodically distribute a printout of the comment database to 
team members. As standard procedure, all comments coded to specific management action codes 
are grouped together for the database reports; however, the needs of a particular project may 
require a different configuration. For further detail on the structure of database printouts, please 
refer to the sample printout that accompanies this chapter. 

Analysts are responsible for the last four steps in the process illustrated in the flow chart at the 
beginning of this chapter. Step 2, analysis of the database report, involves reading through 
assigned sections to identify relevant and coherent quotes that express distinct concepts the client 
agency can or should address. The team refers to a relevant and coherent quote from a 
respondent as a sample statement. Not all comments in the database are sample statements. The 
standards for identifying sample statements (SS) are further defined below. In Step 3 analysts 
must recognize related statements and select the SSs that best represent distinct concepts the 
agency can or should address. Working from these distinct concepts, the analyst drafts a sentence 
that accurately captures the idea as an action or decision to be made by the client agency, or a 
topic to be addressed in subsequent publications of the agency’s proposal. A sentence capturing 
the action, decision, or topic for agency review is known as a public concern. Public concerns 
(PC) are further defined following a discussion of SSs. 

Sample statements are quotes from the comment database (or directly from letters under rare 
circumstances) that satisfy three requisite standards. Comment segments that are relevant,
coherent, and express a distinct concept the client agency can or should address are identified as 
sample statements. Conceptually, SSs presents the subject of a respondent’s concern and why the 
individual or group believes it is of importance. Sample statements may also impart the author’s 
suggestion(s) on how, when, or where the concern should be addressed. Sometimes a full 
comment from the database may serve as a SS but often sample statements are only a segment of 
the database entry. 

The standard for relevancy dictates that a quote must meet at least one of the following criteria: 

• Addresses the details or themes of the agency’s proposal. 

• Refers to actions, complications (indirect effects), statutory requirements, or questions 
connected to the agency’s proposal. 

• Requests that no actions be taken or no changes made to existing policies. 
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An agency may identify specific topics it considers irrelevant to the proposal but the team retains 
the authority to include these comments or topics in the analysis if the project team believes it is 
a concern the agency legitimately should address. 

The standard for coherency dictates that a quote must meet all of the following criteria: 

• Presents an identifiable question, suggestion, interest, or request. 

• Possesses adequate grammatical accuracy to express a clear concept. 

• Communicates sufficient information to form a complete thought the agency can address. 

The standard for a distinct concept the client agency can or should address dictates that a quote 
must meet at least one of the following criteria: 

• Informs the agency of the respondent’s preferred action or decision regarding the proposal 
(may or may not be one of the agency’s preferred alternatives or the proposed action). 

• Identifies a topic to be addressed in subsequent publications of the agency’s proposal. 

• Questions the accuracy of information as presented in the published document. 

• Questions the adequacy of environmental and/or other analyses as presented in the proposal. 

• Questions the appropriate use and/or span of the responsible agency’s authority (this includes 
appropriate scale of planning, public involvement, and legal authorities). 

• Identifies a suggestion consisting of statements of value or preference with a rationale. 

• Requests revisions that may— 

• Help to clarify, improve, or evaluate the adequacy of the public involvement, planning or 
NEPA process. 

• Result or call for a modification of the proposal. 

• Result in additional analysis. 

The process for applying SS standards is summarized by the following flowchart: 

Database 
Commen
t

→
Is It 
Relevant
?

→ No. →
Comment 
is not a 
SS.

        

↓             

→ → Yes
. →

Is It 
Coherent
?

→ No. →
Commen
t is not a 
SS.

    

      ↓         

      → → Yes
. →

Is It A 
Distinct 
Concept? 

→ No. →
Commen
t is not a 
SS.

          ↓     

          → → Yes
. → Commen

t is a SS. 

Public Concerns are statements drafted by the analyst to summarize the content and context of 
SSs to facilitate the agency’s response to topics within public comment. A public concern 
identifies who should respond (which may actually be a subsequent document); and what is the 
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question, problem, suggestion, or interest expressed by respondents. Whenever clearly stated by 
respondents, public concerns also identify the environment or resource affected by an action, the 
hierarchical or geographical location for decisionmaking, and the stage of planning or 
implementation at which the question, problem, suggestion, or interest should be addressed. 
Some public concerns are specific to sections of the proposed action and others address broad 
themes that may underlie or inform the agency’s proposed action. 

For more information on the structure of PCs and SSs for public concern reports, please see 
sections [2.2] and [2.5], respectively. 

10.1.1 ~ Techniques for Database Analysis 
The goal of database analysis is to select the sample statements that best express a public concern 
and encompass the full range of rationales presented by respondents. Analysis Team members 
may use a variety of techniques to accomplish the task of database analysis but all acceptable 
techniques must conform to the following standards: 

• Accuracy – the analyst must endeavor to capture public concerns within the context of the 
actual statements. What a respondent may have “really meant” or “should have said” is 
beyond the realm of analysis. There are some limited exceptions to this standard with regard 
to capturing comments within the required structure of a PC. (See the General Guidelines in 
section 2.3). 

• Consistency – the analyst must attempt to review each assigned segment of the database 
following the same criteria (within each report and for successive reports). 

• Brevity – the analyst must strive to focus the consideration of public comment upon coherent 
subjects and abridge the extent of considerations by excluding duplicative, incoherent, or 
irrelevant comments/comment segments. 

• Thoroughness – all sections of the database must be reviewed for each report. Additionally, 
the analyst must recognize that a database comment may contain more than one relevant SS 
and, thus, may present more than one PC. 

• Timeliness – the analyst must be able to complete this process with enough time to write and 
edit a full PC list before the deadline set by the team leader or project editor. 

As well as these standards, there are some general guidelines to consider when analyzing a 
database report: 

• Establish reasonable time limits to analysis. If an existing PC cannot be identified or a new 
one drafted relatively quickly, reevaluate the comment for compliance with SS criteria. If the 
comment is confirmed to meet SS criteria, the analyst should seek advice from the project 
editor or team leader. 

• Scan each section prior to beginning detailed analysis. Mark obviously duplicative 
comments, such as minor alterations of form letter submissions. 

• Write “hold” (or some other marker) near SSs that present a definite PC but are not 
articulately stated. “Hold” SSs may be reviewed in conjunction with subsequent database 
reports to help identify new SSs that may articulate the concern more clearly. If a more 
eloquent SS cannot be identified, then a PC can be drafted for the “hold” SS to make sure the 
topic receives agency review. 
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Though each analyst will develop a personalized technique that may be adjusted from one 
project to another, there are at least two effective base techniques for database analysis. 

Option 1 

Read each comment within a database section (either a full Management Action Code or limited 
to an Affected Resource Code within the Management Action Code) and follow these steps: 

• Mark relevant, coherent comment segments that meet the SS criteria. 
1) Note comments that explicitly state or clearly imply what the agency should do. 

“Please consider the impacts on small communities before you move forward with this plan. A 
reduction in recreation opportunities will destroy our economy.” 

This comment explicitly states a request and provides a meaningful context 
underlying the request. 

“The Forest Service gives too much power to bureaucrats in Washington. Local people know what’s 
best for the land and those who make their living from it.” 

Though not as explicit, the respondent clearly implies a suggestion that local citizens 
should be given more say in decision-making. 

2) Avoid comments that present only statements of fact or emotion. 
“Wolves were once plentiful across this beautiful land but now they can only be found in a few 
isolated places.” 

This statement of fact provides no meaningful concern to which the agency can 
respond. Does the person support wolf recovery, want further research, or simply 
prefer to announce the obvious? 

“What gives you the right to do this to us? Have you no decency?!?” 

Though the respondent clearly does not like the proposal, without more specific 
identification of an aspect to which the writer objects, the agency cannot provide a 
meaningful response. 

3) Be spare with comments that are too clever or simplistic to elicit a meaningful response 
from the agency. 
“I like wolves, especially bar-b-qued.” 

The agency could not possibly respond to this statement in a meaningful way. 
“This forest plan is just another example of how the Forest Service caters to extraction industries.” 

Though the author’s perspective is clear and a workable PC could be written—‘The 
FS should not cater to extraction industries’—without an indication of how the plan 
caters to extraction industries, the agency doesn’t have much upon which to base a 
response.

4) Be careful with comments that are so complex that a legitimate PC statement would have 
to restate a significant portion of the comment – review these comments according to the 
guidelines for Technical and Editorial statements established in section 2.6. 

• Write notes in the margin/open spaces to capture the key concept(s). 

• Disregard comments that do not meet SS criteria or are redundant. 

Review written notes and follow these additional steps: 

• Identify comments that express a similar concept or suggest a similar action for the agency to 
consider but provide different rationales to support their positions. 
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1) When logical and possible, draft a PC broad enough to capture each SS. 
“The Forest Service needs to adopt the SEPRT Alternative because it is the only one that guarantees 
protection of all forest resources.” 

“Please adopt the SEPRT Alternative. Economic considerations must come second to protecting the 
environment.” 

“The SEPRT Alternative is your only real choice. The jerks who created this problem are going to file 
suit if you choose anything other than Alternative 3 (No Action) so you might as well go for broke.” 

These three respondents support the same Alternative but for divergent reasons. Each 
is directly urging selection of a specific alternative and provides a straightforward 
rationale for that position. Therefore, the SSs would best be captured under one PC 
with a subconcern (section 2.4) to capture the rationale presented in each SS. 

2) When the rationales are too disparate or constitute fundamentally different manifestations 
of the requested action, the accuracy standard may dictate that the SSs be captured under 
different PCs. 
“I support the proposal to reclassify wolves from endangered to threatened. Reclassification will help 
promote recovery by reasonably addressing the concerns of those who see wolves as a threat to their 
livelihood without relaxing regulations to such a point that wolves are likely to face extinction.” 

“Gray Wolf recovery is a success. The proposal to reclassify should be implemented as soon as 
possible.” 

“Wolves should have been reclassified years ago. There are so many in this area now that I fear for the 
safety of my children when they play outside. Environmentalists keep saying that wolves don’t attack 
people but what happens when one finally does? I’m in favor of any proposal that will allow people 
more freedom to protect themselves.” 

The first and third SSs support the same proposal but from nearly opposite 
perspectives. Though the agency may chose to provide the same response to these 
divergent motivations, the team’s responsibility is to reflect, as accurately as possible, 
the spirit of public comment as well as the overlaying theme. Therefore the fist and 
third SSs should be captured under different PCs. The second SS is opaque and may 
be closely aligned with either perspective and should be dropped unless the database 
report gives more context to help determine the intent of the author. 

• Identify existing PCs that may accurately capture each new SS. 
1) Evaluate whether the new SS provides substantive context to the PC beyond that 

established within existing SSs. 
2) Mark the PC # for these additional SSs. 
3) Disregard SSs that do not provide additional substantive context. 

• Note modifications for existing PCs that can be reasonably broadened or narrowed to capture 
new SSs. 

• Identify SSs that constitute new concerns and draft a PC for each. Mark other new SSs that 
may be incorporated within the new PC. 

Option 1 Advantages and Disadvantages 

Advantages 

• Written notes reflect a relatively complete analysis enabling a fellow team member to enter 
the material if needed. 
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• This method allows the analyst to consider all relevant material within a section before 
making PC/SS decisions (reduces potential for duplicative or hairsplitting entries). 

• The first pass through a database printout emphasizes the identification of key concepts 
within possible SSs, reducing the potential for an analyst to become bogged down with how 
to write a PC for a particular SS when there may be other, possibly better, SSs deeper into the 
section.

Disadvantages 

• Two passes through the database and detailed notes may be difficult to accomplish during 
project crunch times. 

• May lend itself to over-analysis of questionable SSs. 

Option 2 

Read each comment within a database section and follow these steps: 

• Mark relevant, coherent comment segments that meet the SS criteria (please refer to 
examples from Option 1). 

• Immediately identify an appropriate existing PC or draft a new public concern for each SS. 

• Disregard comments that do not meet SS criteria or are redundant. 

Enter new material into the Access Database. 

Some analysts employ a variation on this approach by entering new material as it is identified 
rather than after completing analysis of the full section. However, we try to discourage this 
variation because it increases the potential for entering PCs that will be significantly modified or 
even wholly replaced by subsequent SSs in the database report. 

Option 2 Advantages and Disadvantages 

Advantages 

• Though some analysts may not be comfortable enough to make decisions on the first run 
through the database, this option is quicker than Option 1 and should reduce the potential for 
over-analysis. 

Disadvantages 

• Single review of comments may lead the analyst to make too quick a decision on 
complicated expressions of opinion or fact. 

• Without a second review of comments, the analyst may tend to select inadequate SSs. 

• Immediate decisionmaking may increase the potential for duplicative or hairsplitting entries. 
The analyst’s PC report may become overloaded with highly particular PCs and bury the 
themes that underlie the respondent concerns. 

10.1.2 ~ Redirecting Miscoded or Potentially Overlapping 
Material
The multifaceted process of coding comments often results in similar concepts appearing in 
different sections of the database reports. Sometimes comments may be miscoded, despite the 
precautions of the coding process. Whatever the reason, it is important that team members 
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communicate with each other to address these matters without stalling progress towards 
completion of the analysis. In the end, a project may necessitate some degree of thematic overlap 
as a result of the client’s requests or complex interrelationships between different segments of 
the proposal. To accomplish this facet of database analysis, the following guidelines have been 
established:

• Evaluate the comment for relevancy to the client’s proposal and coherency of expression. 

• Assess the comment for compliance with the SS criteria detailed in Section 2.1. 

• Draft a PC for SSs that meet the criteria and deliver to the team member analyzing the 
section where it may be more appropriately placed. 

• Allow the team member time to review the possible PC and, if appropriate, discuss options 
for addressing the material. 

Section 10.2 ~ Structure of Public Concerns 
PCs are always directly followed by SS(s) that support the concern statement. Generally it is 
good to have three to five SSs in support of each public concern but each PC must have at least 
one supporting sample statement. 

Public concerns are not “issues.” The National Environmental Policy Act establishes a legal 
definition for the term “issue” within an agency’s decision-making process [reference CEQ 
regs?]. The agency has the authority and responsibility to determine if a PC (or multiple concerns 
if combined) constitutes an issue, therefore, these documents do not refer to any topic as an 
issue.

Public concern statements follow a standard format consisting of the actor, “should,” verb,
action or effect, affected environment or resource, and location, level, or time (when 
possible).

The actor is the organization (usually a government agency) responsible for making decisions 
based on public comment and formulating responses to explain those decisions.  

The “should” is a mechanism within each PC statement to positively and assertively focus 
analysis upon actions the responsible agency can accomplish or effects the document can 
address. In limited cases, the “should” can be replaced by “must” or “should not.” 

The verb clarifies a method of approach for the responsible agency (either in terms of active 
management or amending the published document). The actor-verb agreement material below 
provides a short sampling of appropriate verbs relating to the agency as actor and a document as 
actor. Section 3.4.2 details a more extensive list of verbs appropriate for use in narratives. 

The action or effect is the key concept (the question, problem, suggestion, or interest) expressed 
in respondent comments. 

The affected environment or resource is the direct object of the action or effect. The affected 
environment or resource often accentuates the rationale underlying a respondent’s assertions or 
clarifies the larger context that informs a highly specific suggestion. Not all respondents clearly 
identify an affected environment or resource; therefore not all PCs contain this element. 

The location or level is the geographic location of a concern and/or the hierarchical level at 
which the concern should be addressed. The time is the stage of planning or implementation at 
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which a suggestion should be incorporated. Not all respondents clearly identify a location, level, 
or a time; therefore not all PCs contain these elements. 

Examples: 

Public Concern: The Bitterroot National Forest [actor] should conduct [should 
and verb] salvage logging [action] to reduce fuels [affected resource]. 

Public Concern: The Forest Service [actor]  in the Final EIS should address 
[should and verb] the cumulative increase in water yield [affected 
environment] as a result of fire and intermediate harvesting [effect]. 

Public Concern: The Ciudad National Forest [actor] should prohibit [should and 
verb] roadbuilding [action] in the Lohantan Basin [location]. 

Public Concern: The Forest Service [actor] should protect [should and verb] 
local economies [affected environment] by granting final decision authority 
[action] to the forests and districts [level]. 

Section 10.3 ~ How to Word a Public Concern 
Extracting a PC from one or more SSs can be challenging for several reasons. Respondents do 
not always express their ideas eloquently, succinctly, or within the clear parameters of the 
agency’s proposal. However, these problems do not diminish the validity of an individual’s 
concerns. This section presents general guidelines for PC development as well as some 
procedures for handling common problem areas. 

General Guidelines 

Be as Literal as Possible when Interpreting Sample Statements – One of the biggest 
challenges to drafting a PC is to identify the central concept and accurately capture it within the 
standard PC format. Analysts can reduce the risk of introducing personal bias into a PC by 
seeking to interpret public comments as literally as possible. One method to accomplish the 
literal interpretation goal involves using the respondent’s own language in the PC. The critical 
step in using this technique is to identify a short segment that captures the respondent’s central 
concept without simply restating the full comment as a PC. 

Public Concern: The Forest Service should in the Final EIS display forest 
growth baseline numbers as an indicator of wildfire potential.
“It appears the forest growth baseline numbers have conveniently been left out of the DEIS. Our forest 
grows 2.2 billion board feet of timber each and every year. Restricted logging and thinning over the last 6 
years account for less than 30% of growth, adding to wild fire acres burned. The most liberal alt. in DEIS 
allows less than 30% to be thinned (690 MBF). This increases wild fire potential.”

Make Sure the SSs and PC Are in Agreement –A concern statement must be supported by its 
associated SSs. It should not state more than the SSs support. Additionally, each SS must support 
the PC statement. While it is good to include multiple SSs, each providing distinct context to the 
PC, every SS must have a direct relationship to the PC rather than serving to clarify another SS. 
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State in the Positive When Possible – Though “should not” statements are acceptable for 
limited cases, statements made in a negative form are much more likely to become convoluted 
than those stated in a positive form. 

(Marginally Acceptable) Public Concern: The Forest Service should not 
promote transportation management decisions that cause habitat 
fragmentation and erosion. 
“We need to protect these important habitats from being fragmented. Building logging roads cuts through 
sensitive habitat and wildlife corridors as well as causes erosion in steep areas.” 

(Much Better) Public Concern: The Forest Service should emphasize habitat 
connectivity and soil retention within transportation management decisions. 
“We need to protect these important habitats from being fragmented. Building logging roads cuts through 
sensitive habitat and wildlife corridors as well as causes erosion in steep areas.” 

Keep It Simple and Concise – If a PC statement is longer than three lines the key concept is 
likely to be buried. Instead, evaluate the material following the Technical and Editorial (T&E) 
criteria (section 2.2.3) or seek advice from the project editor. 

Use Consistent Terminology – Variety is good in narrative analysis, but PCs are the framework 
for the agency’s response to public comment and should be as consistent as possible. Do not vary 
key references between PC statements. A “final rule” is always a “final rule” and should not be 
alternately referred to as a “proposal,” a “plan,” or a “final document.” The “U.S. Fish and 
Wildlife Service” should not be called the “Service” or the “Agency.” 

Be Specific – When appropriate reference specific regulations, acts, or laws (e.g., use 
“American’s With Disabilities Act” if respondents refer to “the disability law”). 

Use Key Process Words and Phrases – Sometimes analysts can concisely and accurately 
capture a respondent’s intent by using common process words such as “objectives,” and 
“standards,” 

Public Concern: The Boiselle National Forest should establish in the 
Management Plan clear standards for streamside vegetation stabilization. 
“You haven’t even addressed how this plan will affect streamside vegetation stability. Field personnel need 
guidance before they try to implement this proposal. Nothing should be finalized unless the plan contains 
clear directions for these people.” 

Or phrases such as “address the cumulative impacts of …,” and “establish evaluation criteria 
for… .” 

Public Concern: The Boiselle National Forest should address in the Final 
Management Plan the cumulative impacts of vehicle-induced pollution on 
aquatic and avian species. 
“Increasing human population within Sinkhole National Park means increased non-point source pollution 
from parking lots, residential and working facilities, and vehicle deposits on road beds. This may adversely 
affect populations of aquatic insects, especially those that are sensitive to pollution, which may adversely 
affect bat, bird and fish populations.” 

Often laundry lists of actions or resources can be concisely and accurately captured by using 
standard terminology such as “ecosystem health” “
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Avoid Comparative Structures – Comparative structures (such as “more” or “rather than;”) are 
a common gateway to tortured and ineffective PC statements. Statements such as, “The Forest 
Service should provide more funding for …” appear very inviting but the ID team will be 
saddled with pondering, “more than what?” before they can even respond to the concern. “Rather 
than” structures are also problematic because they tend to de-emphasize or obfuscate the 
preferred management action and/or affected resource by inserting a wildcard comparative 
element. 

Public Concern: The Park Service should emphasize adequate staff and 
funding for facility maintenance. 
“The Park Service wastes our taxes on these endless planning efforts. Instead of blowing money on glossy 
documents that are obsolete before they even reach our doorsteps, you should be using your time and 
money to fix the campground toilets and other NECESSARY facilities.” 

Even though the respondent spends a fair amount of space criticizing the agency’s planning 
efforts, this individual’s main point is that more attention needs to be directed at the facilities 
visitors use on a regular basis. Although it may seem reasonable to craft a PC statement that 
proposes ‘the Park Service should do X rather than Y,’ the ID team needs to focus on the 
management action they should consider and the potential for beneficial impact on the 
affected resource. In the above example, the concern the ID team needs to address is 
adequate staff and funding for facility maintenance. The diversion of limited funds to 
produce materials for public consumption is a relevant, yet tangential, perspective. 

Avoid Use of Acronyms – Most acronyms should be spelled out. Often our PC lists are not 
accompanied by an acronym decoder list so we should try to keep them free of these opaque 
references as much as possible. 

When the Proper Actor Is Not Clear: 
“Congress should fully fund all Park Service efforts to repair recreational facilities.” 

The actor in each PC statement should be the responsible agency. A respondent may explicitly 
state that another party (such as the U.S. Congress, the President, an uninvolved government 
agency, a non-governmental organization, etc.) should address a demand. The responsible 
agency cannot, however, direct any of these entities to act. An agency can, though, coordinate 
cooperative effort, seek authorization, request additional support, etc. In very limited 
circumstances an agency may be able to provide a meaningful response to a PC that identifies 
another agency as the primary actor (advice should be sought from the project editor or team 
leader regarding this possibility within a project). If an analyst cannot identify language that 
accurately captures the sentiment of the comment segment AND states it as an action within the 
authority of the responsible agency, the comment segment should be reviewed for compliance 
with SS criteria. 

Public Concern: The National Park Service should request full Congressional 
funding for projects to repair recreational facilities. 
“Congress should fully fund all Park Service efforts to repair recreational facilities.” 

When the “should” Statement Is Implied: 
“CASPOs rely on dense, old growth stands for nesting. Over the past thirty years intensive logging of 
Pacific Northwest ecosystems has reduced the availability of adequate CASPO habitat.” 
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Some respondents do not clearly state what they want the agency to do in response to a proposal 
even though it may be clear they are expressing a concern. If a more direct SS cannot be 
identified, use helpful process phrases such as those detailed earlier to capture the implied action 
within our PC format. 

Public Concern: The Forest Service should consider the impacts of timber 
management practices on California Spotted Owl habitat. 
“CASPOs rely on dense, old growth stands for nesting. Over the past thirty years intensive logging of 
Pacific Northwest ecosystems has reduced the availability of adequate CASPO habitat.” 

When Respondents Provide a Laundry List: 
“First you took away our hunting rights with endangered species laws. Then you cut off weekend recreation 
with road closures and special management areas. Now you want to take away our jobs with reduced 
timber sales and more hoops for mineral exploration. Yet you say you are not responsible for what happens 
to our towns! What happens when we become the endangered species?!” 

Some sample statements include a laundry list of items for consideration or respondents will 
share a concern but for a variety of reasons. To help facilitate the response to comment PC 
statements should not include a list of considerations. In these situations the analyst should look 
for a thematic phrase to capture the central concept. Phrases such as “cumulative effects” and 
“systemic impacts” can help to concisely capture a closely related list. 

Public Concern: The Forest Service should consider the cumulative impacts of 
management decisions on local communities. 
“First you took away our hunting rights with endangered species laws. Then you cut off weekend recreation 
with road closures and special management areas. Now you want to take away our jobs with reduced 
timber sales and more hoops for mineral exploration. Yet you say you are not responsible for what happens 
to our towns! What happens when we become the endangered species?!” 

Section 10.4 ~ Subconcerns 
A subconcern (SC) is a topic of public comment that is most logically evaluated within the 
parameters of a larger PC. A SC is constituted upon an expression that could stand alone but is 
so interrelated with a broader PC that separating it out as its own PC would likely produce a 
redundant response from the agency ID team. There are two scenarios that are most likely to 
produce a SC: 

• Many respondents express the same idea but provide a myriad of distinct rationales to 
support their common conclusion. 

Public Concern: The Yosemite Valley Plan should retain historic bridges in 
Yosemite Valley. 
“I join many of my constituents in objection to the removal of the Sugar Pine, Stoneman and Housekeeping 
bridges from Yosemite Valley. As I mentioned to you in our meeting, I believe very strongly that these 
bridges are an important and valued historical attribute of Yosemite National Park and that all efforts 
should be made to preserve them as part of any future management of Yosemite Valley.” 

“I am opposed to the removal of historic bridges, particularly Stoneman and Sugar Pine Bridges. These 
stone bridges are truly a work of art. I believe these stone bridges are in keeping with the natural setting and 
do not detract from the visitor’s experience. These bridges also can serve a continuing useful purpose if 
used for pedestrian and bicycle paths.” 
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PROVIDE PROOF OF DETRIMENTAL EFFECTS TO THE MERCED RIVER 

“It is very bewildering that if a bridge has been determined to adversely affect the flow of the Merced 
River, then all Alternatives should address that problem; remove, rebuild or relocate. We, therefore, object 
to the removal of any bridge unless absolutely proven that it is detrimental to the river, and that issue has 
never been publicly shown to be true. They have historical value and beauty.” 

MITIGATE BRIDGE IMPACTS ON THE MERCED RIVER 

“The bridges afford important access benefits to disabled visitors, to hikers of limited ability who wish to 
make short ‘loops,’ and to bicyclists who are furthering the SEIS goals by helping to reduce automobile 
congestion in the Valley. If saving these historic resources can be reconciled with a stronger riparian 
management strategy, I would endorse a blended alternative that accomplished this while repairing flood-
damaged facilities.  For example, can levees and channeling be altered to allow the river to meander around 
the bridges, thereby reducing upstream erosion and helping to restore certain surrounding meadows outside 
the campgrounds?” 

• A respondent expresses a topic and rationale similar to others but asserts that the application 
should be focused (geographically, administratively, or conceptually) on a more restricted 
scale. 

Public Concern: The U.S. Department of Defense should consider additional 
alternatives to those identified in the proposed action. 
“The alternatives identified and dismissed in the public notice to transfer management of base lands to the 
BLM are totally inadequate. We’ve provided the Secretary of the Army with several viable alternatives that 
are not even addressed in your document. We demand a substantive evaluation of the SVCOC alternatives 
before the DOD proceeds to a final decision on this matter.” 

ANALYZE ALTERNATIVES FOR USE OF THE AIRFIELD 

“The D-M Airfield is a valuable asset and should not be casually discarded. It should be used to promote 
economic development within the valley. Your proposal doesn’t consider any options other than closure. 
Some base resources may need to be decommissioned for safety or security reasons but the airfield could 
be sold to private investors, transferred to the county, or allocated to a non-profit management group. The 
proposal needs to be redone to include meaningful analysis of these, and possibly other, alternatives.” 

A subconcern is located under a PC and receives a distinct heading to demark it from other SSs 
under the PC. The SC heading should be a brief phrase capturing the fundamental concept that 
distinguishes the SS(s) from the parent PC. SCs are primarily a tool the team uses to organize 
subservient topics and accurately identify highly specific comments within PC lists. 

Section 10.5 ~ How to Structure Sample 
Statements for Use in a Public Concern List 
Sample statements consist of the comment segment within quotation marks followed by an 
attribution. The attribution is a systematic method of identifying contextual information about 
each respondent without revealing the identity of the author. One exception, however, is if the 
respondent is an elected official. In this case, the name of the elected official is included in the 
attribute information. The specific style of attributions will vary from project to project but it is 
of significant importance to maintain consistency of attribution within any given project so as to 
avoid implications of disparate treatment for different authors.  

It is important to emphasize again that every SS must support the PC statement with which it is 
associated. If a comment does not stand alone, with a direct and meaningful relationship to the 
PC, it should not be used as a SS. In other words, a comment should not be included to clarify or 
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support the context of another comment. It may be necessary to rewrite the concern statement to 
establish a direct relationship with each SS. Every PC statement must have at least one SS. 
Ideally PCs will have 3 to 5 SSs. More than five SSs is excessive and likely either includes 
significant overlap or a PC statement that is too broad to accurately capture the associated SSs. 
Conversely, if every PC provides only one SS it may indicate that the PC statements are too 
narrowly worded and reflect hairsplitting differences rather than substantive diversity of public 
concern. ****[Importance of quotes to search strings?]**** 

10.5.1 ~ Editing sample statements 
The analyst’s role is to facilitate the client’s response to comment. This means we also have a 
responsibility to present public comments in a form that will help generate a meaningful 
response from the agency. Minor editing of SSs improves the potential for serious consideration 
of a public comment as well as reduces the potential for publishing an error that was inserted into 
the comment during its entry into the CA database. Use the following guidelines when 
considering edits to SSs: 

• Spelling – Correct misspelled words and remove [sic] marks. Read all SSs thoroughly for 
misspellings. Do not rely on spell check to catch all misspellings. 

• Grammar – Be spare in adding or removing text to achieve grammatical clarity. 
“Wolves the last symbol of everything wild and beautiful. Please let me know how I can keep these 
wonderful creatures extinct.” 

• Appropriate grammatical correction: 
“Wolves are the last symbol of everything wild and beautiful. Please let me know how I can keep these 
wonderful creatures extinct.” 

• Questionable grammatical correction: 
“Wolves are the last symbol of everything wild and beautiful. Please let me know how I can keep these 
wonderful creatures [from becoming] extinct.” 

• Inappropriate/unnecessary grammatical correction: 
“Wolves are the last symbol of everything wild and beautiful. Please let me know how I can help to
keep these wonderful creatures extinct.” 

• Best correction: 
Look for a different SS that captures the concern but lacks the obvious incongruity in this 
quote.

• Capitalization, Punctuation, and Quotation Marks – Use your time judiciously. Capitalize 
words that should be capitalized; insert correct punctuation; and convert internal quotation 
marks to single quotes. Don’t spend an inordinate amount of time trying to decide if caps or 
excess punctuation should be removed. Sometimes authors will capitalize a whole string of 
words or even sentences for emphasis. Use of multiple exclamation marks is another 
common occurrence. While these may be visually distracting, there is no need to spend time 
converting material that is essentially a matter of preference. 

• Editing out text – Ellipsis Marks (Gregg Manual, paragraphs 274-280, 291). Sometimes 
respondents include personal histories, annotated legal precedents, or other digressions in the 
middle of a significant comment. Sometimes an individual will write two or more pages to 
convey one fundamental concept. While this material is important to the author and may 
yield some degree of insight into a comment, they often include information that is irrelevant 
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or redundant.  In either case, the digression usually distracts attention away from a concern 
that legitimately needs to be addressed. Analysts should use the following guidelines when 
editing out text from a SS (this example does not necessarily represent a comment that needs 
to be edited down but simply shows how to accomplish the task for different needs). 
“I believe Yosemite National Park should be protected from money hungry capitalists and massive 
commercialization. Shouldn’t the Park be protected for future generations? I want my children to 
experience it as I did.” 

• Omitted words within a sentence: 
“I believe Yosemite National Park should be protected from . . . massive commercialization. Shouldn’t 
the Park be protected for future generations? I want my children to experience it as I did.” 

• Omitted sentences: 
“I believe Yosemite National Park should be protected from money hungry capitalists and massive 
commercialization. . . . I want my children to experience it as I did.” 

• Omitted words at the end of a sentence: 
“I believe Yosemite National Park should be protected from money hungry capitalists and massive 
commercialization. Shouldn’t the Park be protected . . . ? I want my children to experience it . . . .” 

Section 10.6 ~ Technical and Editorial Comments 
Technical and editorial (T&E) comments are primarily remarks that identify text corrections with 
the intended purpose to provide greater clarity/consistency within the proposal rather than a 
change in meaning. T&E comments of this nature include the following: 

• Identification of grammatical mistakes. 

• Corrections of inaccurate support material references. 

• Suggestions of alternative word choices to clarify language without changing the intended 
meaning. 

• Identification of inconsistent terminology/phraseology. 

In addition, comments that suggest a more accurate application of scientific models or procedural 
decisionmaking may be considered T&E comments if their application would not constitute a 
change in the intention of the proposal. In this case, the author would have to explicitly state that 
their suggestion would not change the intentions of the proposal. Otherwise, such a comment 
should be captured within a PC. 

For some projects (and under limited circumstances) the team may identify another type of 
comment within the T&E category. If the client agrees to the circumstances, analysts may 
identify as T&E statements that provide such a highly technical response to the proposal so that 
only the agency’s Interdisciplinary Team can properly evaluate their meaning and intention. In 
these cases, the comments are so dependant on context that an adequate PC statement would 
have to recapitulate most of the SS and would be best handled by direct agency review. This 
provision does not mean that the T&E category is an appropriate place to shove troublesome 
SSs. Again, the circumstances are restrictive and analysts should always seek advice from the 
editor or team leader before assigning such a comment to the T&E category. 

The Analysis Team does not draft a PC statement for T&E comments. T&Es are usually placed 
at the end of chapters, sections or sub-sections depending on project needs. They are 
distinguished from PCs by a distinct font heading stating only “Technical and Editorial.” If a 
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project requires PC numbering to help facilitate response to comment, then every T&E should 
have its own number. 

Section 10.7 ~ Entering and Ordering Public 
Concerns 
After the analyst has identified SSs within the database and drafted PCs (or noted existing PCs) 
for each SS, these materials should be entered into the document outline as provided by the 
document editor. All PCs and SSs should be grouped under the appropriate chapter and sub-
sections. The editor will provide further instruction on the proper protocols to use when readying 
the document for an initial edit.  

Section 10.8 ~ Public Concern List Review 
Before submitting a public concern list to the project editor, please review your document in 
light of the following checklist: 

• Verify PC-SS agreement for every PC. 

• Review the content and context of every PC for duplication and/or conceptual overlap with 
other PCs—removing duplicate material and combining PCs when possible and logical. 

• Confirm compliance of all PCs with the “how to word a public concern” guidelines (section 
2.3).

• Correct all PCs for spelling, capitalization, and grammar (with particular attention for 
sentence fragments). 

• Correct all SSs according to “editing sample statements” guidelines (section 2.5.1). 

• Review all project specific style sheets and attribution lists. 
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Chapter 11 ~ Writing Narratives 
Although some analysis projects only require the team to create a list of public concerns, most 
require us to write a narrative description of those public concerns. Narratives generally fall into 
one of two categories: executive/thematic summary or full summary. Thematic summaries 
require the analysis and discussion of the main themes extracted from the database and public 
concern list (hence the term “thematic”). Conversely, full summaries, which are often considered 
more difficult to write because of their specificity, require the discussion of each and every 
public concern. 

Section 11.1 ~ General Narrative Writing 
“It is an old observation that the best writers sometimes disregard the rules of rhetoric. When they do so, 
however, the reader will usually find in the sentence some compensating merit, attained at the cost of the 
violation. Unless he is certain of doing as well, he will probably do best to follow the rules.” – William Strunk 

An author must first know the rules of good writing in order to effectively break them. Disregard 
for these rules—without purpose—generates a muddled, incoherent, or meaningless expression 
that frustrates rather than enlightens the reader. While ‘purpose’ is an effective starting point, 
Professor Strunk argued that writers also need skill to successfully pull off composition 
transgressions. Narrative writing shares this fundamental truth. Certain skills are requisite to 
writing a narrative summary of public comment that is both creative and meaningful. Our 
narratives should be engaging and informative, clearly structured and astutely representative, 
insightful of complex relationships and useful for decision-makers as well as other interested 
parties. 

Though content analysis is involved in many aspects of government agency decision-making 
(such as public involvement and response to comment) the heart and soul of the content analysis 
is the systematic review of public comment. The application of carefully practiced analytical 
techniques will enhance the consideration of and response to public input. The team’s practical 
goal is to help meet agency legal requirements but our conceptual goal, as intended by existing 
statutes, is to facilitate more inclusive and responsive decision-making. Among the many tools is 
a narrative summary that distills boxes of letters and an entire database of comments into one 
relatively short, coherent, representative, and contextual presentation of the suggestions, 
questions, demands, and perspectives presented by project respondents. A critical step towards 
producing narratives that meet our goals is establishing a shared understanding among team 
members regarding key terms and concepts, basic expectations, and relevant applications of our 
individual knowledge and abilities. Completion of this step will allow us to confidently promise 
clients a meaningful analysis of the context—as well as the content—of what respondents submit 
for consideration. Anybody could break the content of letters into chunks. Most people could 
reasonably organize those chunks. Our narratives should do the first two steps AND make sense 
out of it all—otherwise we would offer no benefit to the decision-making process. 

This chapter of the technical guide presents some advice and tools; however, it does not share 
“tricks” or reveal formulas to success. This chapter does not present the ONLY approach to 
narrative writing. It simply provides a framework for getting started and remaining aware of the 
parameters that must influence all of our activities. The information and advice presented in this 
chapter is founded upon the convictions that GOOD writing (and good analysis) is painful and 
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rewarding; requires personal investment; is structured by the source material rather than stale 
formulas or safe patterns; and results from conscious choices of when to break the rules. 

The process of going from plan to implementation for any public project would go much faster if 
we didn’t evaluate the context of the proposed action. However, statutes (and common sense) 
dictate that faster decision-making doesn’t necessarily equate with better results. A long list of 
laws, regulations, and policies require federal agencies to act expeditiously AND to fully 
evaluate the context of their actions. Narratives should not only help our client agencies meet 
these expectations but should also follow the same principles. We must produce our documents 
in a timely manner while remaining conscious of both the substance and intent of our role in 
decision-making. The team does not simply apply formulas to separate public comment into 
discrete bits of information. The team helps to elucidate the content and context—from specific 
concerns to underlying themes—present within the responses we receive. Conscious decision-
making should be evident in every aspect of our products. 

“Form follows function” is a famous phrase that has been applied to the writing profession. 
Though it is not the answer to all of writing’s confounding problems, it does summarize chapters 
of writing advice into a helpful reminder that the choices an author makes should be guided by a 
purpose. The purpose can be very literal (consistent use of key terms to clarify the relationship 
between ideas) or somewhat implicit (employing passive voice to change the pattern or tone of a 
paragraph). The definitions and examples that follow should help establish a structure for making 
choices regarding the form and function of our key narrative elements. Subsequent segments of 
this section explore the expectations placed upon writers as reflected by the concepts presented 
in this writing workshop as well as some rather philosophical applications of these materials. 

11.1.1 ~ Narrative Analysis 
Much of the analysis takes place during coding and public concern identification, so when you 
are writing narratives, analysis of comments primarily involves explaining why citizens have 
expressed a particular concern. The same reasons for supporting or criticizing one aspect of a 
proposal may underlie more than one public concern; look for ways to connect such concerns in 
your narrative. Keep in mind, however, that narratives are more useful to clients if they explicitly 
incorporate the “why” that goes with each “what”; in other words, the premises that support the 
conclusion.

The reasons people support a particular course of action can be found in the sample statements 
that accompany your public concerns. It is a good idea to reread your sample statements to better 
understand and paraphrase exactly what the public is saying. To add stylistic variety, you may 
include cogent and clear quotations that elucidate a particular concern. However, as our job is to 
synthesize and analyze the public comment on a project, not replicate it, use direct quotations 
sparingly. 

The narrative is written in the present tense. People continue to feel, believe, and consider while 
we are writing the analysis. You should also avoid the urge to use esoteric jargon or “bureau-
speak” like “publics.” While our primary audience is usually the client, our documents should 
communicate clearly to both the agencies that hire us and the people who submit comments. 

Before you start writing your narrative in earnest, there are a few additional writing rules to keep 
in mind. Although you should avoid using acronyms in public concern statements, you usually 
can use them within narratives. Just be sure to write out the acronym the first time it is used in 
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each chapter, and follow it immediately by the acronym in parentheses. Subsequent use of the 
acronym alone is acceptable: 

“Despite the fact that the proposed rule does not recommend changes in protection or management for 
the Southwestern Distinct Population Segment (SWDPS), many people offer comments on how the 
SWDPS should be designated and managed.” (Gray Wolf Narrative, Southwest Distinct Population 
Segment)

Section 11.2 ~ Thematic Summary 

11.2.1 ~ Definitions and Examples 
Professional Writing Style/Creative Presentation of Factual Material – A concise, coherent, 
grammatically and structurally correct analysis of key ideas is the starting point for writing in a 
professional style. Further, professional writing should present objective analysis while 
creatively engaging readers such that they want to understand the material being presented and 
they are able to identify some meaning or relevancy to their own lives. Writers must recognize 
that our work will likely be read by more than just agency line officers—potential litigants and 
respondents to the proposal are strong possibilities—so the language and structure of our 
analysis should be accessible to multiple audiences. We don’t intend to ‘dumb down’ our 
narratives, but simply write to a ‘reasonably well informed’ reader who is not well versed in 
technical jargon. Clearly exploring complex relationships between disparate ideas and 
elucidating the contextual nature of strong arguments are important ways to accomplish the task 
of reaching out to multiple audiences. 

1. Introduction – An introduction serves several purposes: establish a central theme or range 
of topics; provide background to understand the context of topics and themes; offer an 
overview of what will be covered; and generate interest in the material (provide a “hook”). 
Introductions should be written for every chapter, section, subsection and paragraph. Ranging 
from several paragraphs to a single sentence, the detail of an introduction should be 
determined by the nature of the material to be presented. Try to avoid imparting too much 
content and context within your introduction. It will be more useful to the audience if you err 
towards keeping your introduction short rather than incline towards overloading it. The body 
of the narrative section is the appropriate place to examine the nuances of complex issues and 
divergent perspectives. 

1.1. Topic Statement – Though many fields of professional writing do not distinguish 
between topic statements and topic sentences, the analysis team does distinguish because 
they serve significantly different functions. A topic statement simply provides a list of 
topics that may or may not be discussed further within the narrative. These statements are 
often used within introductions but can also be helpful for body or conclusion paragraphs. 
Providing a concise list of topics can achieve valid purposes: offer a quick overview of 
topics to be covered; acknowledge a long list of related concepts without needing to 
detail each individually; or establish a logical development between seemingly disparate 
ideas. The primary problem with topic statements is that they are content-centered, 
unable to reveal the context that allows the reader to understand a greater meaning to the 
topics.
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“Chapter One offers a comprehensive overview of public comment concerning the Herger-
Feinstein Quincy Library Group (HFQLG) Pilot Project and related project documents, 
including the Draft Environmental Impact Statement (EIS).” (QLG Narrative, Purpose and 
Need)

“Numerous comments ask that the U.S. Fish and Wildlife Service designate new DPSs for 
various geographic regions: the Pacific Coast states, including Washington, Oregon, and 
California; Southern Oregon/Northern California; the central states, including Nebraska, 
Kansas, Missouri, and Iowa; and the Southeast, including Virginia, Kentucky, the Carolinas, 
Georgia, and Tennessee.” (Gray Wolf Narrative, Distinct Population Segments)

1.2. Topic Sentence – Often referred to as a “thesis statement” in persuasive writing, 
topic sentences precipitate our role as public comment analysts. They introduce key 
concepts as well as the context that will be further explored. The context provided within 
a topic sentence may range from unexpected interpretations of prevalent issues, 
conflicting positions among respondents, or informative relationships between issues and 
respondents. Topic sentences should challenge the reader to consider the complexity 
underlying public comment and agency decision-making. 

“In general, those who support the proposed rule see it as a necessary step to improving and 
preserving the health of roadless areas with respect to a number of factors; while those 
opposed see it as a barrier to forest health.” (2000 Roadless Narrative, Environmental Effects)

“Though the breadth of public input regarding the Bitterroot National Forest’s Draft EIS 
addresses a wealth of resource areas, the comments, concerns, and requests they offer are 
rooted in the reality of the 2000 fires, how to manage the fuels that feed fires, and the desired 
future conditions of the Bitterroot Valley landscape.” (BBAR Narrative, Fire and Fuels)

1.3. Introductory Paragraph – Whether employing a topic statement or sentence, 
introductory paragraphs should do more than simply begin analysis of a topic area. These 
paragraphs should provide enough background to help the reader understand why the 
topic area is of concern and how it relates to other segments of the analysis. 

“[Background - “hook”] Fire and fuels provided the genesis for the Bitterroot National 
Forest’s Burned Area Recovery project. During the summer of 2000 natural fire and forest 
fuels combined to transform much of the Bitterroot Valley landscape. This transformation 
crossed federal, state, and private boundaries. Decisions on how to deal with the transformed 
landscapes, as well as objectives to prepare for future fire events, cross those same 
boundaries. [Topic Sentence] Though the breadth of public input regarding the Bitterroot 
National Forest’s Draft EIS addresses a wealth of resource areas, the comments, concerns, 
and requests they offer are rooted in the reality of the 2000 fires, how to manage the fuels that 
feed fires, and the desired future conditions of the Bitterroot Valley landscape. [Overview]
Fires - whether ignited naturally, accidentally, or intentionally by fire managers - directly 
impact particulate levels and visibility conditions throughout a region. For this reason, public 
comments regarding air quality are also addressed in this section.” (BBAR Narrative, Fire 
and Fuels)

“[Background - context] The planning process detailed in Chapter 1 of the Draft EIS 
establishes the framework for decision-making that the Bitterroot National Forest will follow 
to rehabilitate the landscapes burned or directly affected by the fires of 2000. Some of the 
fundamental steps to creating an adequate planning process include: clearly determining a 
purpose and need for action; defining what areas (resources, geography, conceptual scales) 
and management actions are within the scope of the purpose and need; identifying relevant 
sources for scheduling, reviewing, and implementing the proposed actions; and establishing 
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methods to monitor the effectiveness of decisions and actions. [Topic Statement and 
Overview] In reflection of these elements, public comments on the Burned Area Recovery 
(BAR) project’s planning process are focused upon compliance with laws, regulations, and 
policies governing the stated purpose and need; clarification of the document’s language and 
intent; adherence to public involvement and scientific analysis requirements; and provision 
for adequate monitoring of effects.” (BBAR Narrative, Planning Process and Policy)

2. Body – The bulk of our analysis appears in the body of the narrative. The body is where 
we are able to explore the nuances and interrelationships between issues and perspectives. 
Although the exact structure of paragraphs should vary throughout a section, there are some 
fundamental traits that should always be present: 1) meaningful topic sentences; 2) clear 
differentiation between general and specific ideas; 3) logical transition between themes and 
topics; 4) consistent references to link disparate material; 5) insightful development of ideas 
rather than repetition of key terms; 5) obvious relationship to the paragraphs which precede 
and follow. 

2.1. Transition – [highlight relationships] [flow of ideas] [word(s), phrases, or whole 
sentences] [introduce a new topic or perspective] [introduction or middle of paragraph] 

“However, some respondents think the Preferred Alternative has the potential to backfire . . . 
.” (Santa Fe Narrative, Alternatives)

“[A paragraph about where and when many respondents believe wolves should be 
reintroduced.] 

While many believe that the U.S. Fish and Wildlife Service’s primary goal should be the 
reintroduction and recovery of the gray wolf throughout its former range, others contend that 
the agency’s paramount concern should be the education of the public...” (Gray Wolf 
Narrative, Purpose and Need for the Proposed Action)

2.2. Parallel Structure – Words, phrases, and clauses should be parallel within a 
sentence. Additionally, words, phrases, and clauses can be parallel between different 
sentences to clarify the relationship between concepts. For parallel structure within a 
sentence, balance nouns with nouns, prepositional phrases with prepositional phrases, 
main clauses with main clauses, and so on. Parallel structure allows the writer to 1) create 
an easy information flow, 2) make points concisely, and 3) emphasize logical progression 
or inter-relationships. Each portion of a parallel structure should read logically within the 
sentence if the other portions are removed. This technique is useful for complex 
sentences but should not be overused as it quickly becomes tedious and distracting. 

“This proposed rule would (1) establish four Distinct Population Segments for the gray wolf 
in the conterminous United States and Mexico, (2) reclassify naturally occurring gray wolves 
within three of these Distinct Population Segments from endangered to threatened status, (3) 
delist gray wolves in areas outside Distinct Population Segments, and (4) establish three 
special regulations under section 4(d) of the ESA.” (Gray Wolf Narrative, Introduction)

“To aid the reader in understanding the relationship between themes elucidated in this 
summary and the content of the Draft Environmental Impact Statement (EIS), this report is 
organized into four general sections that parallel chapters in the Draft EIS. Section one 
addresses concerns regarding the plan, its purpose, and the planning process in general. 
Section two includes analysis of public comment about the various alternatives offered in the 
Draft EIS. Section three summarizes public concerns regarding effects on the biological 
environment. Section four explores issues that affect the human and social environment.” 
(Santa Fe Narrative, Introduction)
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2.3. Internal Reference – Another way of tying sentences, paragraphs, and sections 
together involves internal reference, such as using reference words that point back to an 
idea mentioned previously. This, these, those, such, and that are obvious reference words 
but they must be combined with the important words and phrases from previous 
sentences or paragraphs to make the connection complete. Descriptive phrases can also 
tie together disparate elements of a narrative. 

“The concerns over threats facing gray wolves nationwide are similar to those voiced 
concerning wolves in the NEDPS.” (Gray Wolf Narrative, Northeastern Distinct Population 
Segment) 

“As noted in the introduction to this summary, many of these people view development of 
new rules for forest road management as an opportunity to implement a permanent ban on 
road building in roadless areas.” (1999 Roads Narrative, Purpose and Need)

3. Conclusion – Conclusions are often the most difficult part of the analysis to write. 
However, writers need to keep in mind that the conclusion is often what readers remember 
most. The conclusion should: synthesize the topics and major perspectives addressed within 
the segment, reassert the significance of the issues analyzed, and give the segment an element 
of closure. Formal conclusions need to be written for all chapters and sections. Informal 
conclusions, such as a closing sentence, should be provided for all subsections as well. 
Conclusions should: answer the question “So What?” (reassert what is meaningful and 
useful); synthesize rather than summarize (confirm that the material and your analysis was 
not random, but fits together); and reestablish a larger context (redirect readers to consider 
how these ideas impact the agency’s proposal). 

“In summary, respondents voice a number of concerns relative to access, identification of other 
unroaded areas, exemptions, environmental effects, public involvement, forest dependent 
communities, cumulative effects, and the alternatives and development of the rule. Concerns are 
rich and varied, reflecting as they do the rich and varied perspectives of individual citizens and 
groups. For the most part, however, respondents tend to support or oppose the proposed rule 
depending on their beliefs and assumptions regarding the nature and role of forest lands. As 
pointed out earlier, proponents see the rule as a positive step toward protecting what wildlands we 
have left, ultimately toward improving human well-being and preserving the health of our planet. 
Opponents see it as an assault on human freedom, an attack on their way of life, and a recipe for 
forest degradation. These competing beliefs shape the concerns respondents raise relative to 
specific issues and inform the deeply emotional character of this debate.” (2000 Roadless 
Narrative, Development of the Rule)

4. Contextual Analysis of Content
4.1. Concerns/Topics/Themes – Concerns, topics and themes (within the realm of 
content analysis) are largely dependent concepts that are best defined by their 
relationships to each other. Concerns are the relatively specific concepts we identify from 
public responses. They are direct expressions that may take the form of questions, 
suggestions, clarifications, requests, or declarations. Topics are the larger subjects, 
resources, or issues that often generate the specific concerns people submit in response to 
an agency proposal. They tend to connect multiple concerns, although a single concern 
may present a topic. Conceptually, topics overlay concerns in that they represent a 
grouping, synthesis, or simplification of concerns. They may be directly expressed or 
may need to be extrapolated from direct expressions. Topics can take many forms, from 
an entire resource area addressed within an EIS, to methods of conducting a preferred 
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action, to support/oppose dichotomies. Themes capture the underlying context that gives 
meaning to and reveals relationships between both concerns and topics. Themes are 
almost exclusively the product of extrapolation and may be expressed through a variety 
of forms. Identifying common characteristics between respondents (‘valley residents,’ 
‘professional foresters,’ ‘supporters of the proposed action,’ etc.), presenting a spectrum 
of viewpoints from which to examine extreme positions as well as compromise 
perspectives (‘though most respondents either support or oppose the proposal, many 
suggest alternative approaches’), and recognizing implicit associations (‘though few 
directly express a preference for the No Action Alternative, many ask the FS to maintain 
current management directions’) are all examples of the forms the team uses to capture a 
theme. 
The following is an imprecise simplification, but it may help clarify the relationship 
between these concepts. People possess motivations, beliefs, and/or goals that inspire 
them to respond to an agency’s proposal (revealed as themes). These elements are 
focused by choices to write about certain issues (organized by topics). In writing a 
response, they detail specific points-of-view (expressed as concerns). 

“Those favoring restoration and accompanying reduction (or outright ban) of developed 
activities are not insensitive to those whose livelihood and cultural traditions are deeply 
rooted in commodity production from these Forests. [long sentence detailing concepts 
supporting this analysis]” (Southwest Idaho Ecogroup Narrative, Public Comment – General 
Overview)

“With a few notable exceptions, the majority of public comments regarding forest vegetation 
extend from one of two basic positions: to remove burned trees or to leave them. Respondents 
give many different reasons for and against removal, and, generally, these either emphasize 
the benefits of leaving burned timber for ecological reasons or emphasize the economic 
benefits of salvage logging.” (BBAR Narrative, Forest Plant Communities—Threatened, 
Endangered, and Sensitive Plants)

From a reverse perspective, a section of our analysis may contain the following four 
concerns: ‘the agency should evaluate the impacts of W;’ ‘the agency should evaluate the 
impacts of X;’ ‘the agency should include report Y in their analysis of impacts;’ ‘the 
agency should consider Z as an alternate approach.’ One topic that can be identified 
among these truncated concern statements is failure to adequately analyze impacts. We 
can examine that topic further by reading the sample statements to search for a theme. 
We may find the SSs for all four PCs are based in a belief that the agency’s proposal will 
significantly damage the landscape—that evaluating W and X, including report Y, and 
considering Z are all just different ways of saying they want the agency to choose a 
direction with less potential for environmental damage. We’ve found a theme; now we 
should further explore the relationships between these expressions because the topic we 
identified may still be an important part of the context. Even though the concern 
statements for numbers three and four may not say anything about adequate analysis, the 
SSs may reveal an important relationship—if the agency includes report Y it will force 
them to acknowledge inadequate analysis AND if they consider Z it will require more 
comprehensive analysis—that gives more substance/meaning to this expression than 
simply stating, “some respondents don’t support the agency’s proposal.” 
4.2. Attribution – It is imperative that we link specific sentiments to those respondents 
who explicitly stated them. Just as important is that we try to provide our audience with 
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some context to which respondents express the themes we identify. Meaningful 
attribution should move beyond, “Many people believe . . . . Others argue . . . .” We 
should not force titles or categories upon respondents but our analysis will become more 
consequential to the audience when we acknowledge relevant relationships between those 
who are presenting similar OR contrasting ideas. 

“Responses to some sections of the Affected Environment and Environmental Consequences 
chapter are dominated by funded entities––conservation organizations, timber representatives, 
and professional resource experts. However, an array of individuals and organizations (local, 
regional, and national) present concerns regarding the Fire and Fuels section of this chapter.” 
(BBAR Narrative, Fire, Fuels and Air Quality)

“These respondents, including numerous elected representatives and government agency 
officials, assert the proposal will circumvent local Forest Service authority.” (1999 Roads 
Narrative, Local and Regional Expertise/Authority)

4.2. Extrapolation – A collection of respondents will often express the same basic idea 
in different ways. These differences may be expressed through slight alterations of text or 
drastically different styles. Our analysis often requires that we extrapolate one concern, 
one topic, or one theme from these expressions. Additionally we often must extrapolate 
connections between different sections of an analysis even if the public concerns and 
sample statements we use a references for that section do not explicitly make the 
connection for us. 

“Although several people believe the EIS team should carefully consider the impacts of the 
pilot project on ephemeral streams and advocate selection of Alternative 5 for its water 
quality protection emphasis, others question whether interference with these streams truly 
poses a threat to forests' ecological integrity.” (QLG Narrative, Aquatic, Riparian, and Wet 
Meadow Ecosystems Management)

“It is fair to characterize many of the comments as either pro-salvage logging or anti-salvage 
logging, even though respondents offer a wide spectrum of considerations to support their 
positions.” (BBAR Narrative, Forest Plant Communities—Threatened, Endangered, and 
Sensitive Plants)

5. Internal Integrity – Usually several authors contribute to the documents, introducing the 
potential for glaring differences in style, language, and structure. One of the primary roles of 
the project editor is to establish an electronic template, style guide, and attribution sheet for 
every project in order to reduce these impacts on the final product. In general, final 
documents can accommodate some minor differences in style but should be consistent in 
approach and tone. It is important to note that internal integrity encompasses more than just 
aesthetic and procedural elements. We must strive to give proportional representation (not 
necessarily equal) to every section incorporated into the final document. Thus, internal 
integrity refers to both the style and the substance of the documents. 
6. Self-conscious Authorship – Acknowledging our role in the analysis of public comment 
strengthens our work and downplays the perception that we are simply recapitulating what 
people wrote. We make decisions to condense or expand our analysis throughout the process 
of coding letters, evaluating the database reports, drafting public concerns, and writing 
narratives. Our decision-making should be explicit in the narrative analysis rather than 
subverted.
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“Throughout this section you will read about conservation organizations, professional societies, 
and individuals accusing the Bitterroot National Forest of failure to adequately consider and 
disclose long-term, cumulative impacts. . . . Conversely, a strong contingent of timber industry 
representatives and local citizens (though by no means exclusively or unanimously local) focus 
attention on the isolated, short-term impacts they believe necessitate immediate action. . . .” 
(BBAR Narrative, Affected Environment and Environmental Consequences)

“Though some respondents delineate a direct connection between their comments on the interim 
rule and the 2000 rule, in most cases the link is implicit at best. Additionally, a few individuals 
express alarm regarding the contents of an unpublished, internal-draft document detailing 
substantive revisions of the 2000 regulations. The nature of these comments necessitates separate 
review in order to avoid misrepresenting concerns by placing them within a context the author 
may not have intended.” (2001 Planning Regulations Interim Rule, The 2000 Regulations and 
Future Revisions)

Adequacy of Analysis – We must remain mindful of the relationship between the narrative 
summary and the public concern list. The narrative summary is organized primarily to assist 
decision-makers and members of the public in understanding the overarching context, emotions, 
and relationships present in public comments. The public concern list is organized primarily to 
assist the client’s resource specialists in identifying specific matters that need to be addressed 
within the planning process. Therefore, the public concern list is intended to be specific, while 
the narrative is intended to be more general. Ultimately, the analyst must decide whether or not 
she or he has adequately captured the depth and breadth of public comment directed to a 
particular section of the analysis. There is no direct correspondence between the number of 
concerns and the length of narrative summary but a general rule is that no section should be 
longer than five pages. Presenting the major themes within a meaningful context is the objective 
from which to gauge the adequacy of a narrative analysis. 

Meeting Timeframes – All content analysis products, including narrative summaries, must be 
conducted in accord with a balance of thoughtfulness and timeliness. While the team strives for 
an engaging style and a thoughtful analysis, the analyst’s narrative approach must also be 
determined by the amount of time and resources available. The analysis team maintains a solemn 
objective to deliver products by the dates specified in our contracts. Overtime work is one means 
to achieving this objective but this option is not a substitute for doing good work in a timely 
manner. The team must remain committed to working efficiently.

Section 11.3 ~ Full Summary 
Ordering Your PC List 

A systematic approach to writing full and narrative summaries follows. This is only one of many 
possible writing approaches; it is designed for beginning writers but may also be useful for more 
experienced people suffering from writer’s block or working on an extremely tight deadline. If 
you have done a good job of creating your public concern list, you will have already ordered 
your concerns in a logical manner to facilitate narrative writing. If not, this is your first and most 
important writing task. Similar concerns should be grouped together, and within each sub-group, 
concerns should be ordered from general to specific, if possible. Arranging your public concerns 
in a logical, easy-to-write order is literally half of the narrative writing task.  

Once your public concern list is complete and ordered, you can begin writing your narrative. 
Your public concerns and sample statements should already be in a document template with all 
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the correct formatting in place. A quick and easy way to construct a good outline of your 
narrative is to simply copy your public concern statements and paste them into paragraphs in the 
CA body text font. Since we will be using sample statements later on in the process to help flesh 
out the narrative, some writers like to paste both their public concern statements and at least one 
sample statement into CA body text font. The examples that follow will only contain the public 
concern statements. 

For full summaries, all public concerns are incorporated into your narrative in the order they 
appear in your public concern list. Unlike thematic summaries, full summary sections have 
public concerns and sample statements attached, so it is important to first order your entire list of 
public concerns into logical paragraphs. Not only does this give you structure and a starting 
point, but it also ensures that you will be writing about your concerns in the order they appear in 
your list. Such an outline has been created below from the public concerns identified in one 
section of a CA document: 

The Yosemite Valley Plan should provide for the restoration of sensitive habitats. The 
Yosemite Valley Plan should protect meadow, black oak, and riparian areas from 
pedestrian traffic. The Yosemite Valley Plan should allow grazing in meadows in 
Yosemite National Park. 

The Yosemite Valley Plan should prohibit the removal of any trees in Yosemite Valley. 
The Yosemite Valley Plan should require the retention of tall pine trees in Yosemite 
Valley. The Yosemite Valley Plan should require low-impact management techniques for 
restoration of closed campgrounds. 

The National Park Service should utilize carefully managed prescribed fire to improve 
habitat conditions. The National Park Service should consider mechanical treatments to 
enhance Yosemite National Park vegetation. The National Park Service should eliminate 
controlled burning in Yosemite National Park. 

The first paragraph deals with general vegetation restoration practices as well as meadow 
communities. The second paragraph groups concerns regarding trees in the valley, while the 
third paragraph addresses fire management and its effects on vegetation. 

When writing a full narrative, writers often find it easier to group similar concerns into 
subsections, thus eliminating the need to create transitions between disparate subject areas. 
Sections that contain 15 or more public concerns probably should be divided into subsections for 
both the ease of the writer and reader. Generally speaking, two pages of full narrative is the 
maximum limit of comprehension and readability. If your full narrative exceeds two pages, you 
either need to cut text or split your section into subsections. 

In the example we are using, we could split the section into three subsections: meadows, trees, 
and fire. Although our use of subsections has eliminated the need to connect the three 
subsections with transitional sentences, it would be a good idea to start off such a subdivided 
section with a general road map. (It is important to note that such roadmaps are generally only 
used at the beginning of chapters and subdivided sections; non-subdivided sections do not 
necessitate such a road map.) 
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Section 4.5 ~ Vegetation 
Protecting and enhancing the vegetative components of impacted ecosystems in Yosemite 
Valley is an important consideration for many respondents. Section 4.5.1 summarizes 
concerns addressing the adequacy of analysis of vegetative impacts and the restoration of 
meadows. Comments regarding the removal of trees in Yosemite Valley are covered in 
section 4.5.2, while concerns relating to the use of prescribed fire can be found in section 
4.5.3.

4.5.1 ~ Meadows 
The Yosemite Valley Plan should provide for the restoration of sensitive habitats. The 
Yosemite Valley Plan should protect meadow, black oak, and riparian areas from 
pedestrian traffic. The Yosemite Valley Plan should allow grazing in meadows in 
Yosemite National Park. 

4.5.2 ~ Trees 
The Yosemite Valley Plan should prohibit the removal of any trees in Yosemite Valley. 
The Yosemite Valley Plan should require the retention of tall pine trees in Yosemite 
Valley. The Yosemite Valley Plan should require low-impact management techniques for 
restoration of closed campgrounds. 

4.5.3 ~ Fire Management 
The National Park Service should utilize carefully managed prescribed fire to improve 
habitat conditions. The National Park Service should consider mechanical treatments to 
enhance Yosemite National Park vegetation. The National Park Service should eliminate 
controlled burning in Yosemite National Park. 

We’ve mapped out a starting structure, but because we only have nine concerns in this example, 
we probably don’t need to divide them into subsections (and we won’t). 

11.3.1 ~ Converting Public Concerns into Full Narrative 
Since we are summarizing and analyzing the comments of others, all statements within your 
narrative must attribute the action expressed in your sentence to the person or group that 
submitted it. Attributions comprise two components, an actor and a verb, and are essential to 
creating a document that objectively presents public comment. (A list of attribution actors and 
verbs is included in section 3.4 of this chapter). Preliminary sentences can be created by simply 
choosing an attribution actor and verb and then connecting those to your public concerns. 

A common mistake for writers is starting all paragraphs and sentences with “many respondents 
believe” or similar constructions written in subject-verb-object order. These constructions are 
often the most clear and direct, and many editors recommend them for other types of writing. In 
writing, however, subjects (respondents, people, individuals, organizations) and verbs (believe, 
suggest, recommend, advise) vary little from sentence to sentence. If all sentences follow the 
same pattern, narratives become painfully monotonous.  



Technical Guide 

Chapter 11 ~ Writing Narratives 11-12

To improve readability, vary the placement of your attributions. They can be placed at the 
beginning, middle, or end of sentences. But keep in mind that attributions that work at the 
beginning of a sentence do not always work as well at the end. Placing the attribution at the end 
of a sentence may turn it into a run-on. This placement only works with very short sentences. 
Even then, such constructions can sometimes be awkward and require more careful phrasing. For 
long or complex sentences, try to place the attribution closer to the beginning of the sentence. If 
the sentence is very long and you cannot logically shorten it, use the subject-verb-object order 
discussed above.

For variation, you can also replace general attributions with more specific attributions associated 
with the public concern. For example, if a person has a title (e.g., Tribal Chairman, US Senator), 
use it. You can also refer to the type of organization submitting the letter (e.g., conservation 
organization). Just read through your final sentence carefully to ensure that you are not giving 
false impressions regarding how many people, organizations, etc. are responding.  

Let’s examine a few different ways to convert two public concern statements into narrative: 

The Yosemite Valley Plan should provide for the restoration of sensitive habitats. The 
Yosemite Valley Plan should protect meadow, black oak, and riparian areas from 
pedestrian traffic. 

Can be written as: 

Many respondents believe that the Yosemite Valley Plan should provide for the 
restoration of sensitive habitats. Still others recommend that the Yosemite Valley Plan 
protect meadow, black oak, and riparian areas from pedestrian traffic. 

OR: 

The Yosemite Valley Plan should provide for the restoration of sensitive habitats, suggest 
many respondents. Of those recommending habitat restoration, several ask that the 
Yosemite Valley Plan protect meadow, black oak, and riparian areas from pedestrian 
traffic. 

OR: 

Many respondents believe that the National Park Service should restore sensitive 
habitats—in particular meadow, black oak, and riparian areas. 

Now that we have sentences constructed, we need to add topic sentences and transitions. 
Whether you are writing a full or a thematic summary, a topic sentence describing the general 
direction of the subsequent section or paragraph is a writing requirement. Transitions between 
paragraphs are also required since they help the reader follow the logical order of your topics. If 
the topics between two paragraphs are very different, consider creating subsections (as 
previously mentioned), or just create a “two-clause” transition. A “two-clause” transition takes 
the topic from the first paragraph in the first clause and connects it to the topic in the second 
paragraph in a second clause: 

While timeframes are problematic for some, the lack of economic analysis also raises 
many concerns. 
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Although there really isn’t a logical connection between these two thoughts (other than the fact 
that people care about both), this type of transition will at least move the reader from one set of 
concerns to another. 

11.3.2 ~ Example of a Full Narrative 
Here is what your section may look like once you have included an analysis of the sample 
statements and included all necessary topic sentences and transitions: 

Section 4.5 ~ Vegetation 
Protecting and enhancing the vegetative components of impacted ecosystems in Yosemite 
Valley is an important consideration for numerous citizens. Of these respondents, many 
request that the National Park Service restore sensitive habitats—in particular meadow, 
black oak, and riparian areas. While some believe that preservation and education will 
lead to vegetative restoration, others contend that the Yosemite Valley Plan should allow 
grazing in the Valley. Such grazing, they maintain, will keep the meadows open and 
promote the establishment of healthy perennial grasses. 

In addition to supporting meadow protection, many respondents support the preservation 
of the Valley’s trees. One constituent opposes the removal of the “beautiful tall pine trees 
which give the Valley so much of its present day character.” The disturbance or removal 
of vegetation and trees during restoration of closed campgrounds concerns many as well. 
“By removing trees, it could deface these sites for generations,” offers an individual.  

The use of fire is another vegetative management tool that elicits several comments. 
While some believe the National Park Service should utilize carefully managed 
prescribed fire to improve habitat conditions, others feel that the National Park Service 
should eliminate all controlled burning in Yosemite National Park. Additionally, the 
National Park Service should consider mechanical treatments to enhance Yosemite 
National Park vegetation, according to another, “where fire cannot by itself sufficiently 
enhance the Park’s pine/oak forest/meadows mixture.”  

Public Concern: The Yosemite Valley Plan should provide for the 
restoration of sensitive habitats. 
“I support removing roads and utilities to restore sensitive meadow areas, as well as restoring any other 
sensitive types of habitat by removing structures and limiting access. I am a big fan of restoring areas to 
healthy and natural conditions. I feel that wherever possible, removing structures and restoring the area 
should be done. I am also a big fan of continuing to monitor areas after they have been restored. All 
restoration areas should have some kind of monitoring and evaluation schedule set up, as well as continued 
maintenance until the area has fully recovered.”  (Individual, Columbia, CA - #4235) 

“There is too much emphasis in the various alternatives in the draft plan on moving facilities from one 
place to another and on constructing new facilities in places unimpacted in the past. Emphasis should be 
placed on restoration under a clearly articulated set of priorities.”  (Conservation Organization, Fresno, CA 
- #7881) 
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Public Concern: The Yosemite Valley Plan should protect meadow, black 
oak, and riparian areas from pedestrian traffic. 
“Some areas, which are in need of protection, are the meadow areas, the California black oak communities, 
and the riparian habitats. We respect that the protection of these areas is not always compatible with the 
goals of tourism in the area, however, with significant interpretive and educational services to visitors to 
the Park, the long-term protection may be achieved. Immediate preservation actions that may be taken 
could be the construction of raised wooden paths in certain areas of the meadow and California black oak 
habitats, along with construction of paths through a limited area of the riparian habitat. We believe that the 
only way that visitors will respect the ecological significance of the area is through educational programs 
that highlight the fragile nature of such communities.”  (Individual, San Luis Obispo, CA - #1510) 

Public Concern: The Yosemite Valley Plan should allow grazing in 
meadows in Yosemite National Park. 
“Meadows should not be closed due to unsubstantiated claims of over-grazing or because of excessive use 
by another user group. Actions limiting use of any grazing area should be after a monitoring program 
acceptable to both users and administrators indicates a need for action, and after review by experts in range 
management. Responsible cattle grazing, where allowed by agency regulation, are an acceptable 
component of the ‘Multiple Use’ concept and should be tolerated by all users as trails are not closed to 
other user groups.”  (Recreational Organization, No Address - #3701) 

“Grazing of meadows by work animals should be implemented to help keep them open and promote 
healthy stands of perennial grasses. Hay transportation and feeding should be controlled, with only weed-
free certified hay, covered when transported, and with feeding locations controlled to help prevent the 
spread of noxious weeds.”  (Individual, Sutter Creek, CA - #7305) 

Public Concern: The Yosemite Valley Plan should prohibit the removal of 
any trees in Yosemite Valley. 
“Don’t remove the trees, please. I think that they deserve to continue living. Maybe they are in the wrong 
place, but it’s not their fault.”  (Public Hearing, San Jose, CA - #20520) 

Public Concern: The Yosemite Valley Plan should require the retention of 
tall pine trees in Yosemite Valley. 
“[I oppose] restoring vegetation in such a way as to eventually eliminate the beautiful tall pine trees which 
give the Valley so much of its present day character. Doing this in the name of some distorted view of what 
the place looked like 100 years ago bears no relevance to what is most enjoyable for visitors of today. I still 
recall my first impression of Yosemite Valley. On my first visit, I was overwhelmed by the enormous 
(especially for me as non-Californian) pine trees that fit so well with the larger-than-life magnificent views 
of cliffs, and monoliths and water coming down everywhere.”  (Individual, Los Altos, CA - #3165) 

Public Concern: The Yosemite Valley Plan should require low-impact 
management techniques for restoration of closed campgrounds. 
“I urge you to limit restoration of closed campgrounds to removing structures, pavement and subgrade, and 
possibly some underground utilities; then loosening soil and planting, where necessary. I see no merit in 
removing imported fill to restore the topography of the closed campgrounds. It would add to the cost of 
restoration - and likely postpone its start. It would add pollution and traffic of its own. It would destroy 
existing vegetation, particularly in Camp 9 and Lower River, where revegetation is already well underway. 
By removing trees, it could deface these sites for generations.”  (Individual, Oakland, CA - #3835) 

Public Concern: The National Park Service should utilize carefully managed 
prescribed fire to improve habitat conditions. 
“I feel that prescribed fire can and must be performed in an ever more sophisticated manner to avoid partial 
results and disasters as have occurred elsewhere in recent times. With that in mind, fire managers and 
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resource managers must cooperate ever more closely to promote habitats that approach pre-settlement 
conditions.”  (Individual, Walnut Creek, CA - #3565) 

Public Concern: The National Park Service should eliminate controlled 
burning in Yosemite National Park. 
“Please end all ‘controlled burning’ within this (and all) Park systems. Allow private (and supervised) 
clearing and utilization of wood resources.”  (Individual, Planada, CA - #20513) 

Public Concern: The National Park Service should consider mechanical 
treatments to enhance Yosemite National Park vegetation. 
“Where fire cannot by itself sufficiently enhance the Park’s pine/oak forest/meadows mixture, then some 
mechanical removal of the Valley’s pine overstory along the lines of a natural landscape design should be 
promoted.”  (Individual, Walnut Creek, CA - #3565) 

Section 11.4 ~ Advice and Reference Materials 

11.4.1 ~ General Writing Advice 
Keep a dictionary and thesaurus at your desk. If you encounter an unfamiliar word, LOOK IT UP 
AND ADD IT TO YOUR VOCABULARY! If you use the same word repeatedly, FIND A 
NEW ONE! Take control of your language; don’t let it control you. 

Practice clear and meaningful writing. Don’t ignore emails, letters to family or friends, and 
instructions to a coworker as opportunities to practice and improve writing skills such as 
organization, clarity of ideas, parallel structure, and internal reference. 

Simplify your writing. This does not mean “dumb it down.” It means clarity must precede 
complexity—only when foundations and structures are clear can the nuances that reveal 
relationships and juxtapositions between ideas be meaningfully explored. 

Eliminate unnecessary, redundant, or tangential phrases that are an acceptable part of verbal 
exchanges but clutter or confuse written communication and often misrepresent reality. In 
particular, avoid pat phrases (“concerned about the environment”—the environment is a 
multifaceted thing and concern for it is not necessarily the antithesis of multiple-use), 
clichés/clichéd constructs (‘loggers vs. environmentalists’—though extreme positions are an 
obvious reality within any public debate, we must ask ourselves every time whether the range of 
comment on a project is so clearly dichotomized and whether these groups are really the best 
examples), and excess/unexplained jargon (“defensible fuel profile zones”—if the agency’s 
proposal discusses this term at length, it’s ok to use it in the narrative but you should still provide 
readers some context). 

Try planning out your writing before you start typing. Don’t let fuzzy thoughts become fuzzy 
narrative. If thinking fuzzily helps you get started, follow that direction to its fuzzy conclusion, 
but leave yourself plenty of time to revise your narrative for clarity! A free-association approach 
may help you get started but don’t expect anyone else will want to get fuzzy with you, especially 
when a deadline is looming. 

Though not always recommended (as it may precipitate commitment papers), try reading your 
writing out loud. Find an acceptable place, away from coworkers who need to concentrate on 
their own work, to sound it out. Vocalization can tell you a lot about your writing. For example, 
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if you are repeatedly out of breath after reading sentences, evaluate where you can vary the 
length/complexity of your sentences. Further, if you confuse yourself while trying to read a 
sentence as one coherent expression it is a good bet the reader will have even more difficulty. 
Ask yourself if too many sentences sound the same. Imagine a listener is hearing your material 
for the first time, is that person going to ask you, “What does that really mean?” when you are 
done? 

11.4.1.a ~ Strategies for Overcoming Writer’s Block 
Writer’s block is often caused by conflicted feelings. We want the writing to be engaging AND 
we want the thing done as soon as possible. We know what we know but we don’t know what 
our readers know. We have all the public concerns; we’ve sketched out the themes, but we don’t 
know what the final analysis should look like. We know what we have to say but we are afraid 
that it won’t measure up to our expectations or to our readers’. 

All of these feelings are natural and normal. Everyone finds writing a challenge. Many analysts, 
however, compound their problems by employing weak writing strategies. When these methods 
fail, they give up. 

Weak Strategies: 

1. Trial and error—since our short-term memory is limited, trying to juggle in your head all the 
possible ways to phrase something usually means we repeat the same rejected phrases over and 
over. One way to avoid this is to make a quick list of alternative phrases. 

2. Insisting on a perfect draft—the surest way to writer’s block. Expecting everything to jell at 
once leads to paralysis and heartburn. This is really much slower than several quick drafts 
focusing on different goals. 

3. Waiting for inspiration—sometimes it works, sometimes it doesn’t. What seems like 
inspiration is usually the result of internalized hard work. In a moment we’ll talk about some 
useful strategies for pushing “inspiration” along. 

4.Words looking for an idea—we all know those phrases which click so easily into the keyboard 
but then go nowhere: “due to the fact that...” “it is imperative that...” “a wide variety ranging 
from ... to....” These phrases can be building blocks but they won’t help much until you know 
what you’re building. 

Powerful Strategies for Avoiding Writer’s Block: 

1. Making notes—jot down ideas and phrases as they occur to you. Free yourself from 
paragraphs and sentences for the moment—use flow charts, arrows, boxes, outlines, even 
pictures. Right now, you are worried about getting things down before you forget them. 

2. Freewriting/Brainstorming—when you’re not just blocked, when you’re stonewalled, try 
freewriting. Sit down for ten minutes and write down everything you remember about the 
concepts expressed in your public concern list. The object is to write without stopping for the 
whole ten minutes. If you can think of anything to say, write “blah, blah, blah” over and over. If 
other things occur to you as you write, go ahead and record them, even if they are not directly 
related to your topic. These distractions may be part of what is keeping you blocked. 
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Freewriting is good for uncovering ideas—it’s a good way to nudge “inspiration.” But the main 
purpose of freewriting is to get you moving! Most of what you write in those ten minutes will go 
in the recycling bin, but you’ll be warmed up and your serious writing should go more smoothly. 

Brainstorming resembles freewriting but it is more goal-directed. You start not only with a topic, 
say ‘pros and cons of timber extraction’, but also with a goal: “What do readers need to know 
about the specific debates evident in this public comment project?” Then allow yourself to jot 
down ideas for a set amount of time without censoring any possibilities and without striving for 
perfect prose. When the “storm” has passed you can rearrange ideas, put thoughts into complete 
sentences, edit and polish. 

3. Piecework—sometimes, starting at the beginning induces Perfect Draft Syndrome. It may be 
easier to get started if you approach the task sideways. If you’ve got a plan for the section, 
choose a segment from the middle or a point you know well and start there. Then do another 
segment. After you’ve gained some confidence, you can work on the opening and smooth out the 
transitions. 

4. What I Really Mean Is (WIRMI)—when you’re stuck in a quagmire trying to find the perfect 
phrase, switch to What I Really Mean Is and just say it the way you think it. Once you know 
what you mean, it is easier to refine the phrasing. 

5. Satisficing (satisfy + suffice)—you ‘satisfice’ when you take the first reasonable solution 
instead of searching endlessly for just the right word or sentence. If you’re unhappy with the 
choice, you can bracket it and promise yourself you’ll fix it later. 

11.4.2 ~ Further Advice on Attributions 
As aforementioned, attributions are essential to presenting public comments as objectively as 
possible. Using attributions ensures that public concerns are presented as the thoughts and 
feelings of the citizens stating them, not as facts.  

It is best to vary the placement of your attributions, as well as the type of actor, for readability’s 
sake. Good narrative consists of a mix of general, specific, and pronominal actors. Don’t forget 
to look at the actual attribution at the end of the sample statement to help you add variety to your 
list of actors; however, review your final sentence carefully to ensure it does not give the 
impression that this respondent was not the only one to make this type of comment. While 
editors prefer active voice over passive, you may occasionally use passive voice to create 
syntactic variety. 

Although attributions can be placed at the beginning, middle, or end of sentences, some 
placement can cause confusion. For example, it is confusing to the reader if the attribution is 
tacked on to the end of a very long sentence. Another common mistake is including an 
interrupting attribution within the body of the sentence without setting it off with commas. 

BAD 

Including the SWDPS would “divert agency resources and attention away from important 
restoration opportunities and may create significant and unnecessary complication with key 
cooperators in Mexico,” one person writes. 

Including the SWPDS one person writes would “divert . . . in Mexico.” 
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Including the SWDPS, one person writes would “divert . . . in Mexico.” 

GOOD 

Including the SWDPS, one person writes, would “divert . . . in Mexico.” 

General Pronominal Specific 

respondent(s) some representative(s) of (a business) 

person  many member(s) of (a recreational organization) 

people others director of (a local environmental group) 

citizen(s) several (timber industry) representative 

constituent(s) a few lawyer representing (a local homeowners group) 

individual(s) one president of (a small banana republic) 

11.4.3 ~ General Writing Directives (borrowed from various sources)

Vary the structure and length of sentences. Narrative prose becomes choppy (and dull) when 
every sentence begins with the main subject followed by a verb, and when sentences are of 
uniform length: Also, use transitional words and phrases to show relationships between 
sentences. “I stopped exercising. I gained 50 pounds.” We could improve these sentences by 
combining them: “After I stopped exercising, I gained 50 pounds.” Notice how, without any 
transitional words, we cannot be sure what the relationship is between “I stopped exercising” and 
“I gained 50 pounds.” Did the speaker stop exercising because he had gained fifty pounds? Or 
did he gain fifty pounds because he stopped exercising? Did exercise or the lack thereof have 
anything to do with the speaker’s weight gain? A revision should clarify this relationship. The 
following are some additional writing directives: 

1. Omit ‘which’ or ‘that’ when possible.  

Wordy: “Because the fluid, which was brown and poisonous, was dumped into the river, the 
company that was negligent had to shut down.” Concise: “Because the brown, poisonous fluid 
was dumped into the river, the negligent company had to shut down.” 

2. Replace ‘is,’ ‘are,’ ‘was,’ ‘were,’ or ‘have + a gerund’ to a simple present or past tense verb.  

Wordy: “The South African government was undergoing significant changes.” Concise: “The 
South African government underwent significant changes.” 

3. Replace ‘should,’ ‘would,’ or ‘could’ with strong verbs.  

Wordy: “The environmental council could see several solutions.” Concise: “The environmental 
council saw several solutions.” 

4. Substitute strong verbs for ‘-tion’ and ‘-sion’ words whenever possible.  

Wordy: “I submitted an application for the job.” Concise: “I applied for the job.” 
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5. Replace prepositional phrases with one-word modifiers when possible. Prepositional phrases, 
those little relationship words like ‘of,’ ‘from,’ ‘after,’ etc., tend to bring in a lot of ‘-tion’ and ‘-
sion’ words too.

Wordy: “The President of the Student Senate was in charge of the lobbying against the merger at 
the Minnesota Congress.” Concise: “The Student Senate President oversaw lobbying the 
Minnesota Congress against the merger.” 

6. Use a colon after a statement preceding a sentence of explanation, and leave out the beginning 
of the next sentence  

Wordy: “The Theater has three main technical areas. These areas are costumes, scenery, and 
lighting.” Concise: “The theater has three main technical areas: costumes, scenery, and lighting.” 

7. Eliminate clutter, which often appears in the form of prepositional phrases, but also watch out 
for senseless or redundant phrases. 

Wordy: “There are many people who find success intimidating.” Concise: “Success intimidates 
many people” or “Many people fear success.” Wordy: “With careless nonchalance, she threw the 
bag over her shoulder.” Concise: “Carelessly, she threw the bag over her shoulder.” or 
“Nonchalantly, she threw the bag over her shoulder.” 

8. Avoid Misplaced and Dangling Modifiers 

Sometimes we become careless and place descriptive phrases far away from the words they 
modify, making our sentences unclear or inaccurate. These phrases are called misplaced 
modifiers. For example, in “I was told that I had been awarded the scholarship by my professor,” 
does this mean the professor did the telling or the awarding? If the professor did the telling, we 
could make the meaning of this sentence clearer by repositioning the phrase: “I was told by my 
professor that I had been awarded the scholarship.” Other times we write descriptive phrases that 
point to or modify words that are not clearly stated in our sentences, making our sentences 
illogical. These phrases are called dangling modifiers. For example, in “Walking to college on a 
subzero morning, my left ear became frozen,” the underlined phrase modifies “my left ear.” This 
doesn’t make sense; some person must have been doing the walking. We can clarify the sentence 
by putting a logical word after the phrase: for example, “Walking to college on a subzero 
morning, I froze my left ear.” Or, we can change the phrase so that it has a logical subject and 
verb in it: “When I was walking to college on a subzero morning, my left ear became frozen.” 

11.4.3.a ~ Using Commas Correctly (adapted from Sherman & Johnson, Modern 
Technical Writing)

The comma is important because it is the main device by which the grousing of words, phrases 
and clauses is indicated. Consequently it is used, and unfortunately misused, more than all the 
other marks combined.

Its use, however, is not haphazard. Competent writers almost always use commas for one of two 
purposes: to set off some element of the sentence from what precedes, what follows, or both, or 
else to separate two elements as they might be separated by a pause or rising inflection of the 
voice if one were speaking. The few uses that fall into neither of these categories are the arbitrary 
use of commas on certain specific occasions, to be pointed out below, and the insertion of a 
comma when its presence is necessary for the sake of clarity.  
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The rules that follow, though numbered consecutively throughout, are grouped in accordance 
with the uses referred to above.  

Commas Used to Set Off  

1. An appositive or a term of direct address is set off by commas: “The original factory, an old 
stone structure, is still standing.” 

Note: No comma is used when a noun and its appositive are so closely related as to join in 
expressing a single idea. For example: “The invasion was led by my brother John.” 

2. An adverbial clause preceding its principal clause, or an adverbial phrase at the beginning of a 
clause, is usually set off by a comma: “On all floors except the second and the fourth, the fire 
hazards have been removed.” 

Note: If an adverbial clause or phrase is extremely short, and if omission of the comma could not 
cause confusion, the comma may be omitted.  For example: “When he arrived he was 
immediately seated.” “During July the plant will be closed.” 

3. Independent elements, participial phrases, gerund phrases, and other such constructions at the 
beginning of a sentence are set off by commas: “No, the shipment has not yet arrived.” “Worried 
by the complaints, we began an investigation.” 

4. A conjunctive adverb (however, moreover, therefore, etc.) is usually set off by commas when 
it comes within the clause to which it applies. When it comes at the beginning of a clause, it may 
or may not be followed by a comma but will always be preceded by a period or semicolon: “His 
objection, therefore, was ignored.” “I had heard the rumor before; consequently, I did not believe 
it.” 

5. Any mildly parenthetical element is enclosed in commas if it seems desirable to set it apart 
from the rest of the sentence. A writer is called upon to use his own judgment in applying this 
rule, for too many commas will make a sentence jerky and hard to read: “The frame, he insisted, 
was too tight.” “The central section, for example, was undamaged.” 

6. A terms such as namely or that is, used to introduce an example or a list, is usually set apart 
from that example or list by a comma. (The mark that precedes such an expression depends on 
the sentence structure.): “The crops—that is, wheat, peas and alfalfa—are in good condition.” 
“Three species of tree were observed, namely, pine, fir, and cedar.” 

7. Nonrestrictive clauses are set off by commas. Restrictive clauses, however, are not set off: 
“The south side, which had been exposed to the sun, was badly faded.” “He moved to Arizona, 
where the climate was not so moist.” 

Note: In these examples, the clauses introduced respectively by “which” and “where” merely add 
some additional facts. If they were omitted, the meaning of the remainder of the sentence would 
be unchanged. Hence they are nonrestrictive. However, some clauses introduced by “where” or 
“who” are restrictive. Each is used to limit—to restrict—the meaning of the main statement, 
which would be radically changed if the clause in question were omitted. “The roads went to 
pieces where the permafrost had been disturbed.” “All motorists who drive recklessly should be 
fined heavily.” 

Note: Sometimes a sentence does not make sense unless a clause is interpreted in a single way—
restrictive or nonrestrictive. When this is true, an error in punctuation merely increases the 
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difficulty of reading. There are times, however, when restrictive and nonrestrictive 
interpretations are equally reasonable. When this is the case, an error in punctuation leads a 
reader to misunderstand the meaning. Note how the meaning of the two sentences that follow 
depends on punctuation: “The people from Troy, who had come early, obtained seats.” “The 
people from Troy who had come early obtained seat choices.” 

8. A word or phrase placed in an abnormal position in a sentence should be set off by a comma 
or commas: “To a trained accountant, the problem would look easy.” 

9. A direct quotation is set off by a comma or commas: *“The tires are threadbare,” he asserted, 
“and will blow out at any moment.”* 

Exceptions: A quotation that blends into the regular structure of the sentence is not set off by 
commas. A title in quotation marks is not set off by commas unless some other rule makes 
commas necessary: *The poet’s prophecy about “airy navies grappling in the central blue” has 
become an unpleasant reality.* *The rhythm of “The Raven” is very striking.* 

Commas Used to Separate  

10. A comma is ordinarily used between two independent clauses that are joined by a 
coordinating conjunction. The coordinating conjunctions are “and,” “but,” “for,” “or,” and “nor.” 
(“Yet” and “so” may also be treated as coordinating conjunctions when this rule is applied.) “The 
building is old, but it has been kept in good condition.” 

Note: When both clauses are extremely short and simple, the comma may be omitted: “It was 
damaged but it still is usable.” 

Note: If a comma is used within one or both of two independent clauses, the comma between 
them is sometimes replaced by a semicolon.  

11. When a sentence contains a series, the elements in the series are normally separated by 
commas: “Cattle, sheep, and hogs are now selling for higher prices.” 

Note: If a comma is used within any element in a series, it is often better to use semicolons rather 
than commas between the elements: “We visited Paris, Cannes, and Avignon in France; 
Frankfurt, Bonn, and Berlin in Germany; and Madrid and Seville in Spain.” 

Note: Opinions differ over whether to use a comma before a conjunction (“and” or “or”) that 
precedes the last item in a series. In technical and scientific periodicals and in material published 
by the United States Government, use of the comma is predominant. In journalistic and popular 
publications, usage is divided. Sometimes a comma is essential for clarity because of “and” or 
“or” being used within one of the items. For example: “The panels were painted red, green, 
yellow, and black and white.” 

Without the comma after “yellow,” it would be impossible to know whether “black” belonged 
with “yellow” or with “white.” In view of this, it seems advisable to regard the comma as normal 
punctuation rather than trying to check each series to see whether a comma is needed for clarity.  

12. Two or more adjectives preceding a noun are ordinarily separated by commas. (The comma 
before the last adjective is omitted, however, if that adjective is so closely associated with the 
noun that the two merge into a single thought unit.) Also, a comma is used between adverbs that 
modify the same object: “He has a modest, unassuming manner.” “The watchman was a feeble 
old man.” “Slowly, relentlessly, the stream wore away the dike.” 
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13. Commas are variously used to separate items in dates, places, and numbers. In dates: “He 
was born on December 4, 1963, in Princeton.” In places and addresses: “San Francisco, 
California, is an important shipping point.” To separate adjacent sets of figures: “In 1950, 675 
men were added to the payroll.” Between the digits of Numbers: “C10,984; 234,617; and 
1,856,445.” (The comma is omitted in a number with only four digits unless the number occurs 
in a column containing numbers in which commas are used.) 

Commas Used Arbitrarily  

14. A comma is used between the last and the first name of a person when the last name appears 
first and also after the first name unless the sentence structure calls for some other mark: “Please 
insert the name Fitzgerald, Duane, in the proper place in the alphabetical list.” 

15. A comma is sometimes used to indicate the omission of one or more words: “July will be 
devoted to writing; August, to revision.” 

16. A comma may be used whenever it is necessary to force a pause for the sake of clarity: 
“Inside, the building was in better condition.” 

11.4.3.b ~ Transitions and Connective Phrases 
(adapted from the University of Wisconsin-Madison, Writing Center Handbook)

To Join (Conjunctions)
and   but 
or   for 
nor   neither 
so   yet 

To Introduce a Topic
as for 
concerning 
with regard to 
with respect to 

To Summarize
in all  that is 
briefly  in short 
in other words 
in summary 

To Show Purpose
in order that 
in order to 
so that 

To Show Cause and Effect
accordingly 
as a consequence 
as a result 
consequently 
for this reason 
hence 
it follows that 
so/so that 
then 
therefore 
thus 

To Compare
by comparison 
here again 
in the same way 
in a similar manner 
likewise 
similarly 
so too 
as 
also 
equally 

To Contrast
conversely 
however 
instead 
in spite of that 
anyhow 
on the contrary 
on the other hand 
otherwise 
rather than 
still
yet 

To Explain/Reason
actually 
admittedly 
because 
certainly 
for example 
in fact 
indeed 
really 
of course 
since 
that is 

To Add Information/Reasons
add to this 
again 
also 
besides 
equally 
further 
furthermore 
in addition 
moreover 
once more 
then too 
too 
yet again 

To Show Various Conditions
in these circumstances 
under such circumstances 
this (that) being so 
provided that 
in spite of 
none/nevertheless 
at the same time 
even if 
unless 
otherwise 
although 
even though 
though 

To Show Conviction
at least 
apparently 
even so 
evidently 
certainly 
conceivably 
conclusively 
doubtless 
no doubt 
perhaps 
possibly 
presumably 
surely 

To Show Concession
admittedly 
after all 
all the same 
at any rate 
granted 
however 
in any case 
in spite of 
it is true that 
nevertheless 
obviously 
of course 
still
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yet another despite undoubtedly to be sure 

To Show Chronological Order
after that    afterwards 
later     shortly 
subsequently   concurrently 
in the meantime  in the meanwhile 
now     simultaneously 
when/while   first, second, etc. 
formerly    earlier 
previously   before that 
then     already 
at last    at length 
by that time   finally 

To List or Show Logical Order
for example   for instance 
in particular   to illustrate 
the one ... the other this ... that 
these ... those  here ... there  
either ... or   neither ... nor
whether ... or   though ... yet
wherever ... there  since ... then 
the more ... the more not only ... but also 

11.4.3.c ~ Attribution Verbs 
(adapted from M. Metz, “Thoughts from a Fully Modern Grammar Wrangler”)

  Note: Look up unfamiliar words before you use them 

NEUTRAL
advance 
advise 
articulate 
ask 
believe 
call for 
comment 
conclude 
consider 
counsel 
credit
deem 
encourage 
express  
extend 
hold 
indicate 
inform 
introduce 
maintain 
mention 

NEUTRAL
observe 
offer 
point out 
pose 
postulate 
present 
propose 
recommend 
reflect 
regard 
relate
remark 
request 
say 
state 
speak 
submit 
suggest 
tell
view 
write 

STRONGER
advocate (+) 
affirm (+) 
assert 
attest
aver (+) 
avouch (+) 
avow 
claim 
contend 
doubt (-) 
notify 
profess 
pronounce 
propound 
put forward 
question (-) 
uphold 
inform 
introduce 

STRONGEST
accuse (-) 
announce 
allege 
assume 
charge 
contest 
declare
espouse 
exhort 
impugn (-) 
insist 
persist 
proclaim 
protest (-) 
swear 
urge 
warn (+) 

       INDIRECT
allude    denote   
 connote 
ascribe    hint   
  impute 
attribute    imply   
 convey 

    FUTURE
forecast    predict 
imagine    presage

11.4.3.d ~ Internet Resources on the Writing Process 
There are at least a hundred web sites where one can find self-help documents on the writing 
process. Many are gopher-based collections; a few are true hyperlinked writing guides that allow 
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the user to follow links to different topics. Materials available vary widely in quality, 
presentation, and degree of detail. The following are some helpful website.. 

The University of Victoria’s Hypertext Writer’s Guide—
http://www.clearcf.uvic.ca/writersguide/welcome.html

The Write Place, St. Cloud State University—http://leo.stcloudstate.edu/ 

University of Wisconsin-Madison Writing Center—
http://www.wisc.edu/writing/Handbook/handbook.html

Temple University Writing Center—http://www.temple.edu/writingctr/cweb500.htm

Resources for Writers and Writing Instructors, Rutgers University—
http://andromeda.rutgers.edu/~jlynch/Writing/links.html
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Chapter 12 ~ Editing Documents 
Section 12.1 ~ Introduction 
Both writers and editors share responsibility for editing documents. As timelines are short, 
writers are expected to edit their own work before providing it to editors, and they also may 
serve as editors to other writers when needed. This chapter is designed for people serving both 
roles. 

The analysis team uses the The Gregg Reference Manual and the U.S. Government Printing 
Office Style Manual 2000 as its guides for grammar, usage, and style. This chapter offers specific 
guidance for ensuring consistency in documents, but does not attempt to teach material covered 
by the manuals. 

Section 12.2 ~ Roles and Expectations 
Short timelines require cooperation on the part of all employees. Following are expectations for 
writers, editors, and team leaders during the writing process. 

Writers will:  

• Submit first drafts for review as opposed to rough drafts. A first draft consists of a document 
that has been edited by the author with reference to all writing and attribution guidelines 
established for the project. Before submitting a draft for editing, writers should review their 
documents in light of the following checklist: 

• Confirm compliance with the Public Concern Rules, Proofreading Checklist, and 
Attribution Sheet.

• Correct any sentence fragments and grammatically awkward sentences. 

• Verify Public Concern/Sample Statement agreement for each Public Concern. 

• Ensure that styles and formatting are used correctly and consistently.  

Particular to narrative writing 

• Confirm the order of public concerns matches the order of ideas presented in the narrative 
(for full summaries, not thematic summaries). 

• Trace a coherent theme or juxtaposition within each paragraph. 

• Establish a coherent progression of ideas within the overall organization of the narrative 
(with begrudging acceptance of periodic outlying issues). 

• Use a topic sentence to introduce sections. 

• Avoid beginning each paragraph with the same phrase or sentence structure. 

• Notify editors/team leaders of necessary adjustments in scheduled deadlines as soon as 
possible.

• Recognize that editing is an evolving process and a first edit may not catch all possible or 
necessary edits. 

• Accept editorial guidance in light of the intent to improve documents. 
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Editors will: 

• Offer clear and concise feedback focused on clarity and accessibility of the final document, 
as opposed to directions based on personal preference and writing style. 

• Provide clear delineation between required changes and optional considerations. 

• Focus on providing constructive feedback, including positive as well as corrective remarks. 

• Establish consistent expectations and guidelines so writers do not receive conflicting 
feedback from different editors. 

If writers fail to meet these expectations, editors have the right to return documents to their 
authors and ask for corrections. Similarly, if editors fail to meet these expectations, writers have 
the right to return documents to the editors. 

Content Analysis Team Leaders will: 

• Assign roles and responsibilities to allow writers to work with the same editor as much as 
possible.

• Intervene in situations where a writer and editor are unable to reconcile differences in 
approach to the writing assignment or failure to meet expectations. 

Section 12.3 ~ Elements of Editing 

12.3.1 ~ Reference Materials 
For writing and editing documents, use the following references: 

• The Gregg Reference Manual. Use the Gregg to check grammar and usage, and for 
editing/proofreading marks.

• Technical Guide. Use the following resources from the technical guide: Public Concern 
Rules, Writing Rules, Find and Replace Checklist, Editing Checklist, Trusty/Creative Verb 
List. (provide location in tech guide) 

• Project-Specific Guidance.

• Coding Structure and Letter Attribution Codes. 

12.3.2 ~ Mandatory versus Discretionary Edits 
Mandatory edits are marked by one or more of the following visual clues: 

• Text is crossed out (replacement text may or may not be provided); 

• Direct command words such as “rewrite” or “restructure” as well as fundamental writing 
trigger words/symbols such as “agreement (with arrows)” and the paragraph symbol. 

Discretionary edits are marked by one or more of the following visual clues: 

• Suggestion written above existing text but no text is crossed out; 

• Suggestion is followed by a question mark. 
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12.3.3 ~ Editing Marks 
We use basic editing marks found in the AP Stylebook and The Gregg Reference Manual (see
sample below). For complex editing changes, editors are encouraged to use notes to help explain 
what is required of the writers. 
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12.3.4 ~ Proofreading Checklist 
Spell check: Run spell check. While you are editing, misspellings may distract you and cause 
you to miss other errors. 

Attributions: See the attribution sheet. 

Numbers: Spell out one through nine; use numerals for 10 and above. Use a comma as a 
thousands separator. 

Percentages: Spell out “percent” except in tables or charts. 

Acronyms: Introduce acronyms upon first reference in each chapter. Example:  “The National 
Park Service (NPS) requires . . .”  

States: Do not abbreviate in text. 

Measurements: Spell out; avoid abbreviations. 

Slashes: For clarity, avoid the use of “and/or” constructions. 

Quotations (The Gregg Reference Manual, paragraphs 227-284): Use smart quotes. Use 
double quotes around sample statements and around quotations within narratives and public 
concerns. Use single quotes for quotations within sample statements. 

Punctuation inside quotations (The Gregg Reference Manual, paragraphs 245-246): Make 
sure all periods and commas are inside quotation marks. Semi-colons and colons may be located 
inside or outside quotations, depending on the material.  

Commas (The Gregg Reference Manual, paragraphs 122-175): Use a comma before the last 
item in a series. Example: “Please buy apples, oranges, and pears.”  

Hyphenation (The Gregg Reference Manual, paragraphs 801-841): Words ending with “-ly,” 
such as “federally,” do not get a hyphen. This is one of the few inviolable rules regarding 
hyphenation. Some words are hyphenated when used as adjectives but not hyphenated when used 
as adverbs. Consult the style sheet for each project, the dictionary, or The Gregg Reference 
Manual for specifics regarding hyphenation. Because the hyphenation or non-hyphenation of 
some words may be dictated by preference, make sure the entire document is consistent. 

Ellipsis marks (The Gregg Reference Manual, paragraphs 274-280, 291): To show the 
omission of one or more words in the middle of a quoted sentence, use a standard ellipsis 
consisting of three spaced periods, with one space before and after each period. For the omission 
of words at the end of a quoted sentence, use a standard ellipsis followed by a period. If words 
are omitted at the beginning of a sentence, and the fragment can be read as a complete sentence, 
capitalize the first word of the remaining quoted material and do not use an ellipsis. If the 
fragment cannot be read as a complete sentence, use an ellipsis to indicate the omitted words. 

Omitted words within a sentence: “I believe Yosemite National Park should be protected 
from . . . massive commercialization.”

Omitted words at the end of a sentence: “Yosemite should be protected for future generations 
. . . . I want my children to experience it.” 

Spaces after periods: Use one space after periods.  
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Spaces after colons: Use one space after colons.  

Fonts: Use the Word document template. 

Headers and footers: Check headers and footers for style, alignment, and page numbering. 

FIND: REPLACE WITH: 

Capitalization 

fish and wildlife service U.S. Fish and Wildlife Service 

forest service Forest Service 

yosemite national park Yosemite National Park 

environmental impact statement Environmental Impact Statement 

Acronyms (examples) 

EIS Environmental Impact Statement  

[spell out first time in narrative; add (EIS) 
immediately after the proper name; then use 
EIS later] 

FWS U.S. Fish and Wildlife Service  

(same as above) 

BLM Bureau of Land Management (same as 
above)

FS Forest Service (same as above)  

Words and Phrasing (Gregg Paragraph 1101) 

pubic public 

affect/effect affect (v) to change 

affect/effect effect (n)  a result (effect can also be used as 
a verb, as in “to effect a change”) 

currently delete if unnecessary 

ongoing delete if unnecessary 

about approximately 

utilize use 

insure ensure 

publics anything but “publics” (groups, 

stakeholders, etc.) 

concerned about concerned with 

scooping scoping 
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Hyphens (Gregg Paragraphs 801-841) 

e-mail email 

re-evaluate reevaluate 

re-emphasize reemphasize 

deemphasize de-emphasize 

preexisting pre-existing 

Punctuation (dashes represent spaces) 

.-- .- 

?-- ?- 

:-- :- 

.”-- .”- 

.’-- .’- (make sure this doesn’t apply to 
measurements in feet) 

’. .’ 

”. .” 

”, ,” 

’, ,’ 

.”-(attribution) .”--(attribution) 

Section Titles 

subsection 1.12.1 1.12.1  

Section 3.1 ~ Natural Resources Section 3.1. Natural Resources 

Section 3.01 Section 3.1 
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12.3.5 ~ Editing Checklist  
Bureauspeak: Replace bureaucratic language (such as “utilize” and other “-izes”) with 
common language wherever possible. When you must use jargon (such as “pig launcher”), 
remember to define your terms. Consider adding uncommon terms to the glossary. 

Comprised of: Comprise means “includes” or “consists of.” Avoid using “Comprised of,” as it 
is only correct when used as an intransitive verb.  

Dialog: Do not use this word as a verb. Avoid the popular yet incorrect inclination to use nouns 
as verbs. 

Due to: Avoid this construction unless you’re sure you can use it correctly. Only use “due to” 
when modifying a noun. 

Extraneous words and phrases: Delete extraneous words, phrases, and sentences. 

Fragments: Check for incomplete sentences. “While many people believe the forests should be 
harvested” is not a complete sentence. 

Gender-neutral language: In your narratives, do not use “he” to refer to a respondent even if 
you know the person is male. Sometimes you can avoid gender references by using plural 
subjects. But don’t fall into the trap of using “they” or “their” to refer to a singular subject. You 
can get by with this in conversation but not in formal writing. 

Misplaced modifiers: According to Strunk and White, “A participial phrase at the beginning of 
the sentence must refer to the grammatical subject.” They provide an example: “Being in a 
dilapidated condition, I was able to buy the house very cheap.” Reword sentences to avoid this 
kind of error. 

Parallel structure: Make sure you use parallel structure in lists, items in a series, and other 
appropriate places. 

Passive speech: Eliminate passive language wherever possible and use strong action verbs. 

Subject-verb agreement: When subjects and verbs are separated by several words, writers 
sometimes forget the two are related. Make sure a singular subject gets a singular verb and a 
plural subject receives a plural verb. 

Tense: Documents use present tense when discussing respondents’ comments. 

Word repetition: Avoid using the same word repeatedly, unless it is very common (such as 
“said”). Strive for variation.  
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12.3.6 ~ Sample Attribution Sheet 
GOVERNMENT AGENCY, ELECTED OFFICIALS 

N – International Agency 
Example: (North Atlantic Treaty Organization, Brussels, Belgium - #2142)

N – International Elected Official  
Example: (Prime Minister, Ottawa, Canada - #2142) 

G – Federal Agency 
Example: (U.S. Environmental Protection Agency, Washington, DC - #2142) 

G – Federal Elected Official  
Examples: (Name, U.S. Senator, Arkansas - #2142) 

    (Name, U.S. Representative, Tennessee - #2142) 

S – State Agency 
Example: (Oregon Department of Fish, Wildlife and Parks, Salem, OR - #2142) 

S – State Elected Official 
Examples:  (Name, Governor, Augusta, ME - #2142) 

     (Name, State Representative, Tulsa, OK - #2142) 

S – State Government Association 
Example:  (Association of State Governments, Denver, CO - #2142) 

C – County Agency 
Example: (Coconino County Department of Public Health, Flagstaff, AZ - #2142) 

C – County Elected Official    
Example: (Name, Chairman, Tuolumne County Board of Supervisors, Sonora, CA - #2142) 

C – County Government Association 
Example:  (Association of County Governments, Boise, ID - #2142) 

T – Town/City Agency or Department 
Example: (Grayling Animal Control Board, Grayling, MI - #2142) 

T  - Town/City Elected Official 
Example: (Name, Mayor, Jericho, VT - #2142) 

T – Town/City Government Association 
Example:  (Association of Municipal Governments, Chehalis, WA - #2142) 

Q – Tribal Government 
Example: (Name, Chair, Confederated Salish Kootenai Tribes, Pablo, MT - #2142) 

Q – Tribal Government Association 
Example:  (Association of Tribal Governments, Washington, DC - #2142) 

INTEREST GROUPS 

QQ – Tribal Member 
Example:  (Tribal Member, Belcourt, ND - #2142) 

QQ – Non-Governmental Tribal Organization 
Example:  (Non-Governmental Tribal Organization, Santa Fe, NM - #2142) 
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D – Livestock Industry/Organization 
Example: (Livestock Industry/Organization, Kabetogama, MN- #2142) 

W – Agricultural Industry/Organization 
Example: (Agricultural Industry/Organization, Lac du Flambeau, WI - #2142) 

HT – Hunting and Trapping Industry/Organization 
Example: (Hunting and Trapping Industry, Northumberland, NH - #2142) 

L – Wood Products Industry/Organization 
Example: (Wood Products Industry/Organization, Ottumwa, IA - #2142) 

J – Mining Industry/Organization 
Example: (Mining Industry/Organization, Rapid City, SD - #2142) 

M – Oil Industry/Organization 
Example: (Oil Industry/Organization, Sleetmute, AK - #2142) 

B – Business 
Example: (Business, Ely, NV - #2142)

P – Conservation Organization 
Example: (Conservation Organization, Seeley Lake, MT - #2142) 

AR – Animal Rights/Humane Treatment Organization 
Example: (Animal Rights Organization, Lompoc, CA - #2142) 

R – Recreational Organization 
Example: (Recreational Organization, Estes Park, CO - #2142) 

E – Place-Based Organization 
Example: (Place-Based Organization, Lajitas, TX - #2142) 

F – Property Rights Organization 
Example: (Property Rights Organization, Elmira, ID - #2142) 

Z – Multiple Use Organization 
Example: (Multiple Use Organization, Cebolla, NM - #2142) 

U – Utility 
Example: (Public Utility, Scranton, PA - #2142)

Y – Other 
Example: (Other, Great Neck, NY - #2142) 

OTHER TYPE 

I – Unaffiliated Individual 
Example: (Individual, Rutland, NH - #2142) 

I – No Address 
Example: (Individual, No Address - #2142) 

A – University 
Example: (Department of Pedology, Whattsamatta University, Frostbite Falls, MN - #2142) 

A – Professional Society 
Example: (Professional Society, Wausau, WI - #2142) 



Technical Guide 

Chapter 13 ~ Creating Appendices for Content Analysis Documents 13-1 

Chapter 13 ~ Creating Appendices for 
Content Analysis Documents 
This chapter discusses the typical complement of appendices provided with each content analysis 
summary. A standard summary document may include the following appendices: Content 
Analysis Process, Coding Structure, List of Preparers, Demographics, Immediate Attention 
Report, Information Request Report, and Organized Response Report. Sometimes, when 
requested by the agency, the analysis also includes an acronym appendix.   

Section 13.1 ~ Using the Appendices Templates 
We have created templates for each of the commonly used appendices. These templates include 
styles as well as blocks of sample text that need only a few changes. Templates and file locations 
are listed below. You may want to refer to the templates while reading the instructions for 
completing appendices. 

• Appendix A ~ Content Analysis Process 

• Appendix B ~ Coding Structure 

• Appendix C ~ Public Concern List  

• Appendix D ~ Demographics dot

• Appendix E ~ Immediate Attention Letters  

• Appendix F ~ Information Requests 

• Appendix G ~ Organized Response Report Appendix H ~ List of Preparers  
Open the file and use the Save As command to rename the file and save it to the desired 
location.

In each appendix, you will need to complete the tables and all the highlighted fields. After 
entering all the required information, you should also read through the entire document once to 
make sure no other pertinent details, including your header and footer, have changed for your 
project. As a final step, you should use the Template Organizer to ensure that the styles used in 
the appendix match those used in your project template. Copy all the styles in your final template 
over those used in each document. See page 273 in Using Word 2000 for help in using the 
Template Organizer. 

If you need to create an entirely new appendix, you can use the general appendix template or 
save an existing template to a new file and delete all extraneous text. 

Section 13.2 ~ Content Analysis Process 
Option 1: Provided in brief form with final document. 

Option 2: Provided in expanded form with final document. 

This appendix generally supplies a brief description of the content analysis process and provides 
information about how people can review letters firsthand. The team also can expand this 
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appendix to provide a much more thorough description. The template for this appendix includes 
sample text for the brief version, which is used in most cases. Several fields must be completed. 

Section 13.3 ~ Coding Structure 
Option 1: Provided with final document.  

The coding structure is included as an appendix with the content analysis summary. Formatting 
is easiest if the coding structure is created with the coding structure template. You can leave this 
appendix in the landscape format, but make sure it is set apart from the rest of the document in a 
separate file or is delineated by section breaks.  

The template for this appendix includes coding structure styles. You may want to change the 
page setup to landscape before inserting the coding structure file. (If you like, leave the title page 
in portrait, insert a section break, and then change to landscape beginning on the second page. 
Then insert the coding structure file on the second page.) 

Section 13.4 ~ Public Concerns List 
This list is prepared automatically by using the Table of Contents feature in MS Word (see 
7.2.3d). To delete the hyperlinks, use the following instructions: 

Eliminating Hyperlinks in Public Concerns Lists 

1) Place the mouse pointer to the left of the beginning of the public concerns list. 

2) Click and drag the pointer into the public concerns list. This should select the entire 
thing. 

3) Key Ctrl+Shft+F9. This should convert the public concerns list to normal text. You may 
need to select the entire list and perform a Ctrl+Spacebar, because strange formatting is 
sometimes generated in the conversion to text. 

Note: If you change something within a document after the public concerns list has been 
generated, you will need to insert the list again, if you have eliminated the hyperlinks. If you 
have not eliminated the hyperlinks, you can select the public concerns list as described above 
and key Ctrl+F9. This is the command to Update Fields. You can also do a right-mouse-click on 
the list to view a drop-down menu.

Section 13.5 ~ List of Preparers  
Option 1: Provided with final document. 

A list of employees who worked on a particular project is supplied with the content analysis 
summary, or if no summary is being prepared, the final public concern list.  

The template for this appendix includes sample text. In this appendix, you will not want the body 
text style to work exactly as planned. As it is a paragraph style, it will put extra space after each 
return; in this list, it would put extra space after each name. To avoid these extra spaces, use a 
different kind of return at the end of each name in a list. Use Shift+Enter to move to the next 
line without creating full paragraph spaces.  
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Section 13.6 ~ Demographics 
Option 1: Provided with final document. (Reports include Number of Responses/ Signatures by 
Organizational Affiliation, Geographic Representation of Response by Country and State, Number 
of Responses/Signatures by Response Type.) 

Option 2: Provided following project validation. (Reports include Number of 
Responses/Signatures by Organizational Affiliation, Geographic Representation of Response by 
Country and State, Number of Responses/Signatures by Response Type.) 

Option 3: Provided with final document and provided in partial form mid-project on timeline 
negotiated with client. (Reports include Number of Responses/Signatures by Organizational 
Affiliation, Geographic Representation of Response by Country and State, Number of 
Responses/Signatures by Response Type.) 

Canned Reports in CA Oracle Program will generate these reports. Project specific report needs 
will require an Oracle Administrator.  

The template for this appendix includes sample text and empty tables, which you will complete 
from the computer demographics reports. Demographics reports are most accurate following 
project validation. However, clients often want these reports earlier, sometimes even mid-
project. Some errors do not become apparent until you run demographics reports from the 
database. Especially if you are running demographics mid-project, you will want to give yourself 
a little extra time to check discrepancies and correct problems.  

Petitions also can cause discrepancies in demographic reports, depending on how clients have 
asked that petitions be processed. If only one mail ID is assigned to each petition, you can 
include petitions in demographics reports and the numbers will be accurate. If more than one 
mail ID is assigned to each petition, however, you will not be able to include petitions because 
they will create discrepancies.* If clients insist on multiple mail IDs per petition, follow the 
method used for Sierra Nevada Framework Plan demographics in August 2000 (see example 
below). Petitions were separated from regular letters and reported on a different line. They were 
not broken out by state. 

Geographic Representation of Response by Country and State  
Example with Petitions Not Broken Out By State 

Country State Number of 
Responses 

Number of Signatures 

United States Alaska   

 Alabama   

    

    

 Unknown Location   

Total Without Petitions    

Petitions (not broken out by state)   

Total Including Petitions 0 0 

If demographic reports are supplied mid-project, it’s important to note that total numbers will 
only include records that have been entered into the project database. 



Technical Guide 

Chapter 13 ~ Creating Appendices for Content Analysis Documents 13-4 

Section 13.7 ~ Early Attention Letters 
Option 1: Provided as interim reports as needed throughout the project. 

Option 2: Provided with final document. 

For each project, the analysis team determines the type of letters to which the agency wishes to 
be alerted. During the coding process, these letters receive a specific header code and are marked 
with a red flag. 

The template for this report includes sample text and empty tables, which can be completed 
using either a low-tech or high-tech method. The low-tech method involves physically checking 
all letters, pulling letters with red flags, and completing required report fields from all the red-
flagged letters. This method works best when the project is very small. The high-tech method 
involves exporting name, address, and red-flag information from Oracle or Access directly into 
Word using a mail merge feature. This method, described below in Section 13.9, works best on 
larger projects because you can save a lot of time by not typing in all the names and addresses. 
For this method, you will need the assistance of the computer technician or specialist.  

Section 13.8 ~ Information and Comment 
Extension Requests 
Option 1: Provided with final document. 

Option 2: Provided with final document and throughout project on timeline negotiated by the 
agency. 

Option 3: Not tracked or provided.  

Needs from Computer Technician/Specialist: For low-tech method, none. For high-tech method, 
information exported from Oracle into Access. 

The analysis team often provides a report that tracks information requests received on a 
particular project. During the coding process, letters with information requests receive a specific 
header code and are marked with a blue and yellow flag. For instructions on how to compile this 
report, see Immediate Attention Letters.

Section 13.9 ~ Organized Campaign Responses 
Option 1: Forms report provided with final document; petition report not provided. 

Option 2: Forms and petition reports provided with final document. 

Option 3: One or both reports provided with final document and mid-project on timeline 
negotiated with client. 

Needs from Computer Technician/Specialist: For forms, a report listing the number of each form 
received. For petitions, a report listing letter numbers and number of signatures for each petition. 

Typically, the analysis team supplies a form report for all projects. For some projects, the team 
may also supply a petition report. The template for this appendix includes sample text and empty 
tables which you will complete using the computer reports. (For large projects in which 
databases are kept for forms, you can use the method described in below.) To complete the 
“description” block, you will need to use hard copies of forms and petitions and write your own 
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summaries. When summarizing the form or petition (see tables in Organized Response template), 
be brief—keep your description to one sentence if possible. 

As with demographics reports, if supplied mid-project, forms reports comprise only those 
records that have been entered into the project database.*** 

Section 13.10 ~ Mail Merge Function for 
Reporting 

13.10.1 ~ Converting Database Fields to Word Tables via Mail 
Merge
Selected data from the Red (IA), Blue (RI), and Yellow (CE) Flag and Forms database tables 
must be converted into Word tables for interim reports and the final appendices. This seemingly 
unfathomable task can easily be accomplished with the help of Mail Merge, an MSWord tool. 

1) From the Menu Toolbar, select Tools, then select Mail Merge.

The Mail Merge Helper will appear. 

2) Select Create, and then select Catalog.

3) Select New Main Document.
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4) Select Get Data, and then Open Data Source.

5) Open the source database (Access, Oracle, etc.). You will need help from the local database 
guru or computer specialist to find it the first time. At the bottom of the dialog box for Open 

Data Source, make sure you select the file type you’re looking for (.mdb for Access) in the block 
Files of type or your files will not appear.  
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6)Now that you have your database open, you are ready to edit your Main Document. 

Select Edit Main Document.

7) First you need to set up the table format. 

Go to the Menu Toolbar and Select Table,

Then select Insert. 

The Insert Table window appears 

Here you set up the parameters for your Table (# Rows, # Columns, etc.). 

Sample of Empty Table 
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8) Now it’s time to move the data from the data source into the table columns and format it for 
output.

In the left side of the window above the ruler, select Insert Merge Fields and a list of fields 
from the data source appears in a drop-down menu. 

Here you select only the fields that you need in your table. 

9) Place the cursor in the first cell of the Table. 

Select the field(s) that you want displayed in the first cell from the drop down menu entitled 
Insert Merge Fields on the right side of the window. 

Press Enter. 

Sample of Table with First Field Inserted 

«ltr_no» 

You can place more than one field in a cell and arrange and format them so they print out any 
way you want them to.  
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Screen Captures Showing Fields Inserted 
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Sample Table Showing Multiple Fields Inserted and Formatted 

«ltr_no» «respondent_name» 

«address_1» 

«city», «state»  «zip_code» 

«blue_flag_description» 

You can add commas, spacing and other formatting between the fields. 

10) The table is now ready to merge!! Select 
Merge from the Mail Merge Helper window. 

The Merge window will appear. 

11) Select Merge. 
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Sample of Merged Table  

12) Before you send the final report to the client, you will need to do several things. 

• Change the column margins to best fit your data. “Letter #” doesn’t require one-third of the 
page width. 

• Apply the Table Title, Table Heading, and Table Text styles to the appropriate text. 

• Check text for incomprehensible or awkward abbreviations and repair as necessary. 

• Add a header row, and tell Word to make it repeat on every page. (Select the row and go to 
Table, Table Properties. Select the Row tab and check the box that says Repeat as header 
row at the top of each page).

• If you don’t want rows to break across pages, select all rows and go to Table, Table 
Properties. Select the Row tab and uncheck the box that says Allow row to break across 
pages.

• Remove the data source. (Need detailed instructions for this). 

Sample of Merged Table After Formatting 

Letter # Name and Address Remarks 
47 PAT CROWSON 

1953 ROCK CUT PL 
CONLEY, GA  30288 

General request for other information: 

152 CHRISTINE C BOGDANOWICZ 
G 14 STIMSON HALL 
ITHACA, NY  14853 

General request for other information: 

382 DAWN  LEARY 
PO BOX 1961 
TAVARES, FL  32778 

General request for other information: 

47 PAT  CROWSON 
1953 ROCK CUT PL 
CONLEY, GA  30288 

General request for other information: 

152 CHRISTINE C BOGDANOWICZ 
G 14 STIMSON HALL 
ITHACA, NY  14853 

General request for other information: 

382 DAWN  LEARY 
PO BOX 1961 
TAVARES, FL  32778 

General request for other information: 

528 HEATHER  MITCHELL 
PO BOX 1218 
POINT LOOKOUT, MO  65726-
1218

General request for other information: 

599 KRISTAL  MUELLER 
23762 CASA BONITA 
QUAIL VALLEY, CA  92587 

General request for other information: 
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Letter # Name and Address Remarks 
528 HEATHER  MITCHELL 

PO BOX 1218 
POINT LOOKOUT, MO  65726-1218 

General request for other information: 

599 KRISTAL  MUELLER 
23762 CASA BONITA 
QUAIL VALLEY, CA  92587 

General request for other information: 

Note:  An Immediate Attention and Request for Information forms exist in the Oracle CAET 
Content Analysis Application. These forms can be used to record Letter #, respondent and 
remarks information. Reports can be generated that will provide the necessary output similar to 
the information above. You must provide information in the remarks field in order for that 
respondent’s information to appear in the report. This information can then be given to the 
responsible team members to handle these types of requests.  
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Appendix A ~ Frequently Asked Questions (FAQs) 
The following is a list of Frequently Asked Questions about the CAET Oracle program. They are 
divided into subject categories: General Inquiries, Content Analysis application, Mail ID
application, Header Entry form, Mail ID LOV form, and Query Comments form. 

General Inquiries 
What are the buttons at the bottom of the forms? 

The buttons at the bottom of the Mail ID and Content Analysis applications open the various 
forms of the CAET program. In the bottom, right-hand corner of each form is a Close button that 
closes the form currently displayed on the screen.  

What do the field colors signify? 

Blue and pink fields are required fields, yellow fields indicate the application is in query mode, 
white fields are optional fields, and the information in gray fields fills in automatically. 

Is there a keyboard shortcut for closing message boxes that appear on my screen? 

Yes. Press [Enter] and the boxes will close. 

How do I close a form when it is in query mode? 

Click on the [Close] button located at the bottom right-hand corner of the form. A message box 
appears that says “Query Cancelled,” press [Enter] to cancel the query and close the form. 

How do I know what task each button in the toolbar performs? 

Rest the mouse over the button and a prompt appears providing the function of the button and its 
keyboard shortcut. 

Why should I not minimize forms? 

Minimizing forms is not recommended. In the Oracle program there is only one window (called 
the “Dummy Window”) in which different forms exist. There are not separate windows like in a 
Microsoft Office program. The forms in the CAET program do not need to be minimized 
because the buttons can be used to navigate to the different forms. If you do minimize a form, it 
will minimize behind the Welcome form, which will then need to be minimized as well. 

Figure 1.3: Prompt for Edit Button 

Figure 1.1: Buttons Displayed in the Content Analysis Application 

Figure 1.2: Buttons Displayed in the Mail ID Application 
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The “Dummy Window” is the gray window you will see when logging on to the program. If this 
window displays, minimize it and ignore it. 

Is there a way to move from the Content Analysis application to the Mail ID application 
without clicking on the button at the bottom left-hand corner of the form? 

Yes. Use the Windows keyboard shortcut <<<<Alt+W> to access the Windows drop-down menu. 
The menu lists all of the open forms in the CAET program, a number precedes each form name 
and a check mark indicates the title of the form currently viewed. Enter the number of the desired 
form and it will display on the screen. This shortcut will not work if the form currently viewed is 
in query mode. 

Why can’t I open a different form? 

Check to see that the form you are currently viewing is in query mode. You cannot open a 
different form if the form currently viewed is in query mode. Remember, the fields of the form 
are yellow when the form is in query mode. 

Content Analysis Application 
What’s the difference between “Number of Signatures” and “Total Signatures?” 

The “Number of Signatures” in the Respondents block displays the number of signatures 
associated with the MID displayed. 

The “Total Signatures” field displays the total number of signatures for all MIDs associated with 
the response. 

Figure 1.4: Window Drop-Down Menu 

Total Signatures 

Number of Signatures 

Figure 1.5: Signature Fields in the Content Analysis Form 
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Figure 1.5: Query by Profile 

Is there a way to move the cursor from the Respondents block to the Comments block 
without using the mouse? 

Yes. Use the keyboard shortcut <<<<Ctrl+Page Down> to move the cursor from the Respondents 
block to the Comments block. An alternate method is the <<<<Alt+R> shortcut that lists the Record 
drop-down menu. From the Record menu press <N> (which selects Next Record) then press 
[[[[Enter].

How do I enter a response with multiple MIDs? 

Enter the first MID number then press the [down arrow] key. This clears the field so a new MID 
can be added. If the Mail ID field is not clear, typing a different MID will replace the MID 
displayed in the Mail ID field. 

In the Respondent’s block, why do the “Org” and “Number of Sigs” fields default to I and 
1? The majority of the responses CAET receives is sent from individuals and has only one 
signature. The Organization field and the Number of Signatures field default to “I” and “1.” If 
the Org type or the number of signatures is different than the default update those fields. 

Is there a way to commit and begin a new comment without using the mouse? 

Yes. Press [F10] to commit then press [F6] to insert a new record. This moves the cursor from 
the “Comment” field to the “Comment Number” field. 

Why does the Content Analysis Application Project block open in query mode? 

The block opens in query mode to ensure the correct Project ID is entered. When the Project ID 
is queried and the correct Project ID is retrieved, there is no chance of a typographical error. 

Mail ID Application 
Why do the “City,” “State” and “County” fields fill in automatically when I enter the zip 
code? 

This feature saves time and improves accuracy. It is important to verify that the city and state 
fields display the correct information. Navigate the cursor through the city and state fields and 
they highlight to remind you to check that the information corresponds to the information the 
response.

Does the fax field automatically add dashes when I exit the field? 

Yes. This occurs in both the Mail ID application and the Foreign Mail ID form. 

Are the MID fields in the same order as how they will print on a label? 

Yes. This is true for the Mail ID application and the Foreign 
Mail ID form. 

How do I query all of the MIDs I have created and modified 
for one day? 

Enter your profile in the “Created by” field and the date you 
want to query in the “Create Date” field. Be sure to add a % 
after the date, this retrieves all of the MIDs for the day. 
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Header Entry Form 
Why do I execute instead of commit, when saving information in the Header Entry form? 

Use the “Execute” button because the information you have just entered will be validated. The 
letter numbers and MIDs are checked against the project ID. If a letter number or MID is not 
attached to the project ID listed in the Header Entry form an error message is displayed on the 
screen.

When I am using the Header Entry form how many responses and MIDs can be entered 
before I need to execute? 

The number of MIDs and letter numbers that can be entered in this form are limitless, in theory. 
If you reach a maximum, however, there are several explanations. The limitation could be due to 
the memory of your PC, how many windows you have open (Word, Internet, etc.), and the 
physical limitations of your Server Database. You may need to close a program to avoid this. 

Mail ID LOV Form 
Why does the LOV form take so long to appear? 

The LOV form is slow to appear because the form is associated with a large database that takes 
time to retrieve. 

Why do the Content Analysis application and the Mail ID application size when the LOV 
form is selected? 

In Windows, if a form is sized (reduced from maximum size) then all forms are sized. The LOV 
form is sized to allow the user to check the Mail ID application in case they need to verify what 
they are querying. Therefore, all of the open forms are sized to permit the user to view the Mail 
ID application. 

Query Comments Form 
In the Query Comments form, when I enter query mode and the cursor is in the “Letter 
No” field, the cursor automatically moves to the “Comment” field. Why? 

This form exists for querying comments. The “Comments” block will most likely be the block 
that is queried in this window. The cursor defaulting to this field saves time. 
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Appendix B ~ Glossary 

Alternative Code Additional codes used on some projects to identify specific 
information not provided by subject and category codes. These 
codes are comment-specific and follow the subject and category 
code entries in the left margin of the coded letter. Examples 
include codes for standards and guidelines numbers, regulation 
numbers, alternative numbers, and geographic areas. 

Application 

Attachment 

A set of Oracle programs that solve a company’s business needs. 

A supplemental document attached to an original response 

Block A container for fields in Oracle Forms. Blocks can be related to 
tables in the database. 

Blue Flag Blue post-it flag attached to the left margin of a letter to show that 
it contains an information request. These letters are often referred 
to as “blue flag letters.” 

Brackets [ ] A) A set of characters used in the Remarks field of the Mailing 
List Application. B) A set of characters used to indicate the 
beginning and end of a coded comment. C) A set of characters 
used to indicate ISM added text in a comment. 

CAET Program CAET Oracle database used to enter CA respondent information. 

Category Code Five-digit numeric code that defines a specific subtopic within a 
subject code. These codes are comment-specific and are written 
in the left margin of the coded letter. 

Clean Copy A copy of a project related response that is kept free of any 
project related markings or notations except the letter number. 

Code An alpha or numeric sequence used to categorize and sort 
information. To code is to assign these sequences to letters or 
comments.

Coding Structure A topical outline with alpha and numeric codes attached. A 
coding structure is used as a tool to identify public comments and 
sort them into recognizable categories. 
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Comment A coherent segment of text that will stand alone as a suggestion, 
idea, request, or critique. Each comment is assigned a subject and 
category code from the coding structure. 

Commit An instruction for the database to save all of the changes made to 
the database. 

Common Interest 
Classification 

A code used in some past projects to record preference for 
specific alternatives (currently not being used). 

Content Analysis A systematic method of compiling, categorizing, and capturing 
the full range of public viewpoints and concerns regarding a plan 
or project.

Content Analysis 
Application 

The application wherein the comments of a response and its Mail 
ID are linked and added to the database. 

Database Report A printout of comments sorted by subject code, category code, 
letter number, and comment number. 

Date Received Stamp The mark on the letter identifying the date received the response. 

Delivery Address 
Components 

The specific elements that comprise the delivery address line of 
an address. 

Demographic Codes Numeric codes that identify organization affiliation, response 
type, and number of respondents for a letter. 

Drop-Down Menu A menu of command options that appears temporarily when you 
click the mouse button on a selection. The menu appears directly 
beneath the command selected. 

Duplicate Letter Also referred to as “duplicate response.” A letter that exactly 
matches the content of a letter already received. 

Duplicate Letter Number The same number that is inadvertently assigned to two different 
responses.
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Field A space allocated for a particular item of information. Fields are 
the smallest units of information in a database. A field can be 
required, optional or calculated. A required field (pink in the 
CAET program) is one in which you must enter data, while an 
optional field (white in the CAET program) is one you may leave 
blank. A calculated field (gray in the CAET program) is one 
whose value is derived from some formula involving other fields. 
You do not enter data into a calculated field; the system 
automatically determines the correct value. 

Footnotes A note of reference, explanation, or comment usually placed 
below the text on a response. Enter coded footnotes as “[Footnote 
1: content]” exactly where it appears in the text of the letter. 

Form Five or more responses received separately but containing 
identical text.  

Form Master A form chosen from a group of identical forms. The form master 
is coded and entered into the database and it is used as a template 
for all of the forms it represents. 

Form with Additional 
Comments 

Identical to an already identified form but with one or more 
comments included which may or may not be codable. 

Full Summary A comprehensive narrative that summarizes and discusses all 
public concerns identified for a project. 

Header Codes Alpha and numeric codes contained within a stamped set of 8 
boxes located at the top of each letter. The header comprises both 
demographic and administrative codes, including the following: 
organization type, number of signatures, response type, 
immediate attention, user type, form number, common interest 
class, and information request. Organization type, number of 
signatures, and response type are always supplied. The 
completion of other boxes depends on both the individual letter 
and the needs of the project. 

Immediate Attention 
Code 

A numeric code applied to letters requiring an immediate 
response from the client. The agency works together to determine 
which categories of letters require this designation. A letter that 
requires immediate attention receives a red flag on its left margin 
and a specific code in its header box. 
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Information Request 
Code 

An alpha code applied only to letters with specific requests for 
information pertaining to the proposal. The client determines the 
level of specificity for identifying and flagging information 
requests. A letter that meets client specification receives a blue 
flag on its left margin and a specific code in its header box. 

Interim Report A general term applied to any report provided a client before the 
completion of the project. Interim reports are sometimes 
produced for public concerns, Immediate Attention letters, 
information requests, organized response campaigns, and 
demographics. 

Network Drive The network drive that allows the sharing of files between any 
computers that are logged on to the network. 

Letter Commonly used to refer to any document submitted as comment 
on a project, including mail, email, public hearing transcripts, 
comment forms, resolutions, forms, and petitions. For Response 
Type code, “letter” specifically refers to mailed and faxed 
correspondence.  

Letter Generator Responses containing selected comments that are identical to 
those from a larger form. These responses are usually created 
through an interactive website that offers people a selection of 
comments and allows them to choose which to use in creating a 
letter. 

List of Values In each form in the CAET program there are buttons indicating a 
List of Values (LOV). This list displays all of the possible entries 
for a field.  

Letter Number A number applied to any document or piece of correspondence 
submitted as comment on a project. Letter numbers are assigned 
sequentially for each project. 

Correspondence Log A tracking system in the form of an Access Database that 
provides a list of each letter number and its corresponding 
respondent. Also includes date received dates. 
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Mail ID A unique number defined by the mailing and/or demographic 
information provided by an entity or individual that is used to link 
the respondent’s mailing information to their response. This 
number can follow an entity or individual from project to project. 

Mail Log in Sheet The sheet used to track the letter number blocks assigned in the 
Central Processing Area on a given day. The mail processor then 
knows at which number to begin the following day. 

 Mailing Label Used for project related mailings. Each label contains the mailing 
information of each respondent. Labels are only printed for 
respondents that are on the mailing list of a project.  

Mailing List Application The application used for creating and updating Mail Identification 
Numbers for each respondent on a project. 

Management Action These additional codes are used on some projects to identify 
specific actions that management should take that have potential 
effects on the environment. Management codes also provide an 
efficient way to access data for some reports. Examples of 
possible management action codes are national forest acronyms, 
regulation numbers, standard and guideline numbers, region 
numbers, and Environmental Impact Statement (EIS) alternative 
numbers.

Military Address 
Components 

The parts of a military address for both domestic and overseas 
locations. The components include APO (Army Post Office), 
FPO (Fleet Post Office), AE (armed forces in Europe, the Middle 
East, Africa and Canada), AP (armed forces in the Pacific), AA 
(armed forces in the Americas). 

Narrative A generic term that refers to any written summary—full or 
thematic—produced for a project. 

Oracle Oracle's relational database stores information and the Oracle 
application is used to develop forms & reports. 

Organization Type A code that identifies a specific type of organization, association, 
agency, government agency, elected official, or individual. 
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Organized Response 
Campaign 

A term that refers to both forms and petitions.  

Original Response That from which a clean, client, and working copies are made. 
The original is used in the logging process. 

Out of Scope Letters considered beyond the range of concerns contained in a 
specific project. 

Petition A single response signed by multiple members of the public.  

Phase Used to identify where the project is in the NEPA process (e.g., 
prescoping, scoping, draft and final). 

Balloon Help On-screen help displayed in a cartoon-style dialogue box that 
appears when the pointer (cursor) is placed over the object in 
question.

Protected Field A field that is filled in automatically and cannot be updated by 
the user. 

Public Concern A statement that extracts a key concept from public comment and 
presents the matter as an action or decision to be made by the 
client agency, or a topic to be addressed in subsequent 
publications of the agency’s proposal. Conceptually, it conveys 
the “who,” “what,” and “where,” upon which the agency’s 
response to comment is founded. A concern statement suggests 
who should respond (which may actually be a document); what is 
the question, problem, suggestion, or interest expressed by the 
respondent; and where (hierarchically or geographically) the 
question, problem, suggestion, or interest would most likely be 
addressed. Most public concerns are written as “should” 
statements: e.g., “Public Concern: The National Park Service 
should allow camel tours on backcountry trails in Yosemite 
National Park.” 

Query Specifying a set to data to be retrieved from a database. 

Record A group of related fields. 
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Red Flag Red post-it flag attached to the left side of a letter to show that it 
meets the requirements for one of the Immediate Attention 
categories. Immediate Attention letters are often referred to as 
“red flag letters.” 

Remarks The information in the Mailing List application that specifies the 
responses and projects for each respondent in the database. 

Replicate The function used when one or more of the comments of one 
response are identical to one or more of the comments of another 
response.

Respondent A person, organization, association, or other entity submitting 
comment on a project. On reports, “number of respondents” and 
“number of signatures” is synonymous. 

Response Any document submitted as comment on a project, including 
mailed or faxed letters, emails, public hearing transcripts, 
comment forms, resolutions, forms, and petitions. For reports, the 
“number of responses” equals the total number of letter numbers. 
“Response” is synonymous with the word “letter.” 

Response Type The specific format of correspondence, e.g., mailed letters, 
emails, etc. A code recording this specific format is marked in the 
header box at the top of each letter.  

Sample Statement A relevant, coherent excerpt from a respondent’s letter that 
expresses distinct concepts the client agency can or should 
address.

Section Symbol § Date entry notes the section symbol as “[section].” 

SIC Literally means, “this is the way it was.” Used in entering 
comments with misspellings, improper grammar usage, and 
nonsensical statements. 

Signatures The number of names attached to a letter. This number is 
recorded in the header box at the top of each letter. For reports, 
“number of signatures” is synonymous as “number of 
respondents.”
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Site Specific Additional codes that are used on some projects to identify 
geographic locations; i.e., Tally Lake RD, Kootenai NF.  

SQL (Structured Query Language) A language used to interrogate and 
process data in the Oracle database. 

Stage of Process The Stage of Process indicates a period of time that is within the 
phase of the project. 

Standard Abbreviations Abbreviations that follow the standards of the United States 
Postal Service. 

Subject Code Five-character alpha codes that represent broad themes associated 
with a project, such as natural resources, economics, wildlife, etc. 
These codes are comment-specific and are written in the left 
margin of the coded letter. 

Thematic Summary A concise summary that discusses the major themes and concerns 
identified for a project. 

User Type An optional code that defines the purpose for which an 
individual, organization, or agency uses public lands. User types 
vary depending on the project or on client needs. If user types are 
being recorded for a particular project, a code for user type is 
marked in the header box at the top of each letter. 

Validation The process by which a project database is checked for accuracy 
and completeness. 

Validation The act of verifying all entered data in the database. 

Working Copy The copy of the response that is put through the process (e.g., 
assigned a MID, coded and entered into the database). 

Zip+4 Website Displays the standardized mailing address based on the 
information entered into the form provided. 
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Appendix C ~ Mail ID Samples 
The following are formatting examples of Mail IDs to be used as guidelines while entering 
mailing information into the Mail ID application. 

Governmental Bodies 

Federal
Example of Org: Federal (United States Department of Commerce) 
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Example of Org: Federal (US House of Representatives/House District #) 
Title: Representative (REP) 
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Example of Org: Federal (United States Department of Agriculture Forest Service/Nine 
Mile Ranger District) 
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Example of Org: Federal (US Department of Interior/Fish & Wildlife Services)
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Example of Org: Lead Agency Employee (Yosemite National Park Project-Lead 
Agency) 
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Example of Org: Federal (US Senate)
Title: Senator (SEN)
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State
Example of Org: State  
Addr: Fifth Floor 
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Example of Org: State (State Legislature/House of Representatives/HD #) 
Title: Representative (REP) 
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Example of Org: State (Governor’s Office) 
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Example of Org: State (State Legislature/House of Representatives/HD #) 
Title: Representative (REP) 
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Example of Org: State / Department / Division  
Addr: Room 
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Example of Org: State (Department / Division)  

Attn: (used only when specified by the author) 
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Example of Org: State (State Legislature/Senate/Senate District #) 
Title: Senator (SEN)
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County
Example of Org: County (Planning Commission)
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Example of Org: County (Board of Supervisors)



Technical Guide 

Appendix C ~ Mail ID Samples C-16 

Town/City 
Example of Org: Town/City Agency or Department
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Tribal
. Example of Org: Tribal (General Council [with no address] representing Cherokee 
Nation) 
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Utility Group or Organization 
Example of Org: Utility (Bonneville Power Administration)
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Conservation District 
Example of Org: Conservation District
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International 
Example of Org: Business 
Addr: Foreign (Ukraine) 
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Example of Org: Business 
Addr: Foreign (Canadian)
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Industry and Business  

Oil, Coal, and Pipeline Industries 
Example of Org: Oil & Pipeline Industries 

MSC: Mail Stop Code 
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Mining Industry/Association 
Example of Org: Consultants / legal representatives writing on behalf of Mining 
Industry  
Client: Mining Inc (Asarco Incorporated) 
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Example of Org: Mining Industry
Addr: Highway Contract (keep HC and Box # on same line) 
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Timber/Wood Products Industry/Association 
Example of Org: Wood Products Industry/Company 
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Agricultural Industry/Association 
. Example of Org: Agricultural Industry or Association (Farm Bureau) 



Technical Guide 

Appendix C ~ Mail ID Samples C-27 

Range/Grazing Organization 
Example of Org: Grazing (South Umpqua Grazing Association) 
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Civic Organizations 

Preservation/Conservation Organizations 
Example of Org: Preservation / Conservation (with a group) 
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Recreational Organizations (Non-Motorized) 
. Example of Org: Recreational (non-motorized) 
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Recreational Organizations (Motorized) 
Example of Org: Recreational (motorized)
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Multiple Use, Wise Use, and Land Rights Organizations 
Example of Org: Multiple Use/Land Rights
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Place-Based Groups 
Example of Org: Place Base Group (Quincy Library Group)
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Civic Groups 
Example of Org: Civic Group 
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University/Professional Society/Researchers/Scientists 
Example of Org: University or Professional Society (writing on behalf of University 
“We”) 
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Government Employee Organizations and Unions 
Example of Org: Government Employee Org/Union



Technical Guide 

Appendix C ~ Mail ID Samples C-36 

Individuals 
. Example of Org: Individual 
Addr: Ranch (writing on behalf of self, not the ranch) 
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C-38 

Example of Org: Individual 
First Name ONLY (exception): Use first name for Sisters of the Catholic Church 



C-39 

Example of Org: Individual (enrolled at college/university) 
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Appendix D ~ Database Reports 
After public comments, mailing address information, and associated project setup codes are 
entered into the database organize the data in order to efficiently analyze it. This can be achieved 
by running database reports in which the data is sorted by certain project setup codes. 

Categories of Reports 
• Validation Reports corroborate data within the database. 

• Mailing List Reports generate the name and address information of respondents. 

• Content Analysis Reports consist of report sub-categories and individual reports: 

• Report sub-categories are: 
• Demographic Reports (Responses/Respondents/Signatures) 
• Comment Reports (text of comments, respondent and coding information) 

• Reports are: 
• Comments by subject (form) 
• Immediate Attention Description 
• Information Request Description 

Running Database Reports 
From any form in the CAT program, go to the File drop-down menu to display the three 
categories of reports.  Select a category, and another menu appears containing either a sub-
category of reports or a list of reports.  Another list of reports will be within the sub-menu of the 
selected sub-category. 

Report Category 

Report Sub-category 

Report

Figure D.1: Accessing Database Reports 
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Select the required report. A prompt screen appears requesting report parameters. 

• Select the appropriate Output Device:

• Screen: Displays the report on the screen, without any printer formatting 

• Preview: Displays the report on the screen, with printer formatting (similar to print 
preview). Use preview if you are going to print the report.

• Printer: Sends the report directly to the printer without displaying it on the screen. 

• File: Writes the report to a file. 

• Mail:  Sends the report via email as a postscript (.eps) file. 

• Select the correct Report Parameters (Project ID, Phase, and Stage of Process) from the 
drop-down menus.

• Click the Run Report button.  A Report Progress screen appears until the report is done. 

• The Report Previewer screen appears showing the completed report.  In the Previewer 
screen, you can view, print or mail the report. 

Report Parameters

Figure D.2: Selecting the Report 
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• View:  Click on the Next button to view the next page of the report.  Click on the 
Previous button to view the previous page of the report.  The First button will display 
the first page of the report and the Last button will display the last page. 

• Print:  Click the Print button.  A Print screen appears.  Select the appropriate printer 
from the Printer Name drop-down menu.  Click the OK button. 

• Mail:  Click the Mail button.

• If it is the first time you use the mail option, a setup wizard will appear.  In the first 
window choose Lotus Notes only then click next.  Enter your Lotus Notes password then 
click next.  A confirmation screen appears – click Next.  In the Next screen click Finish,
and then setup will be complete. 

• A mail screen appears.  Put the appropriate e-mail address in the To field.  When 
sending the report to another Forest Service employee, use their outside e-mail 
address (example: sbear@fs.fed.us).  Click the yellow envelope icon to send the 
report.

Report Descriptions and Examples 

Validation Reports 
Last Names 

• Lists all names from all mail ID’s sorted by last name.  This report is used for eliminating 
duplicate mail id’s and errors in names. 

Figure D.3: Validation Report 
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Organization 

• Lists all organizations from all mail id’s sorted by organization.  This report is used to keep 
organization names consistent regarding abbreviations and spelling. 

Zip Codes 

• Lists every variation of city, state, and zip for all mail ids.  This report is used to ensure cities 
are tied to the correct zip code and state. (No longer necessary due to postal software)  

Figure D.5: Validate City/State/Zip Report 

Figure D.4: Validate Organization Report 
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City Names 

• This lists every variation of city and state for all mail ids.  This report is used to validate city 
spellings and city/state relationships. (No longer necessary due to postal software) 

Duplicate Mail IDs 

• Lists name, title, organization, address 1, address 2, city, state, zip, and e-mail address when 
there is more than one mail id with the same values in these fields.  This report is used to 
eliminate duplicate mail ids. 

Figure D.7: Duplicate Mail IDs Report 

Figure D.6: Validate City/State Report 
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Mail ID’s for a Project 

• Lists mail id, letter number, mailing list status, form number, creator, and respondent 
information for all letters from a certain project, sorted by mail id.  

Letter numbers for a Project 

• Lists the letter number, mail id, respondent information, and entered by fields from all of the 
letters from a certain project. 

Figure D.9: Validate Letter Numbers Entered Report 

Figure D.8: Validate Mail IDs for Letter Entered Report 
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Mailing List Reports 
Name/address by Last Name 

• Lists name and address information for all respondents from a certain project, sorted by last 
name.

Name/address by zip 

• Lists name and address information for all respondents from a certain project, sorted by zip 
code.

Figure D.10: Name and Address by Last Name Report 

Figure D.11: Name and Address by ZIP Code Report 
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Name/address by mail ID 

• This lists the mail ID, mailing list status, and letter number, name, and address information 
for all respondents from a certain project, sorted by mail ID. 

Name/address for Immediate Attention 

• Lists the organization type, immediate attention code, and letter number, name, and address 
information for respondents with an immediate attention code from a certain project, sorted 
by immediate attention code, then letter number. 

Figure D.11: Name and Address by Mail ID 

Figure D.12: Name and Address by IA Report 
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Avery 8462 labels 

• Prints out address information for all complete address respondents for a certain project, 
sorted by zip code.  This report is formatted to print Avery 8462 labels (4” x 1.33”/14 labels 
per page). Only those respondents that have a Mailing List Status of “Y” will print.  

Content Analysis Reports 

Responses/Respondents/Signatures (Demographic Reports) 
Demographic Reports list the number of responses, respondents, and signatures for a certain 
project, broken down by certain codes (see examples below).  

Response: a piece of correspondence 

Respondent: a mail id (can be more than one person, i.e. two people writing from the same 
address.)

Signatures: Represents a signature on a response. 

Figure D.13: Avery 8462 Labels Report 
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Responses/Respondents/Signatures by Comment Period Extension 
This lists each comment period extension code and the number of responses, respondents, and 
signatures within that code for a certain project. 

Responses/Respondents/Signatures by Common Interest Class 

• This lists each common interest class code and the number of responses, respondents, and 
signatures within that code for a certain project. 

Figure D.14: Responses/Respondents/Signatures by 
Comment Period Extension Report

Figure D.15:Responses/Respondents/Signatures by Common 
Interest Class Report
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Responses/Respondents/Signatures by county 

• This lists each county and the number of responses, respondents, and signatures from that 
county for a certain project. 

Responses/Respondents/Signatures by city 

• This lists each city and the number of responses, respondents, and signatures from that city 
for a certain project. 

Figure D.16: Responses/Respondents/Signatures by County 
Report

Figure E.17: Responses/Respondents/Signatures by City 
ReportFigure D.17: Responses/Respondents/Signatures by City 

Report 
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Responses/Respondents/Signatures by Foreign Country 
This lists each foreign country and the number of responses, respondents, and signatures from 
that foreign country for a certain project. 

Responses/Respondents/Signatures by Form Number 

• This lists each form number and the number of responses, respondents, and signatures from 
that form number for a certain project. 

Figure D.18: Responses/Respondents/Signatures by Foreign 
Address Report 

Figure D.19: Responses/Respondents/Signatures by Form 
Number Report 
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Responses/Respondents/Signatures by Immediate Attention 

• This lists each immediate attention code and the number of responses, respondents, and 
signatures from that code for a certain project. 

Responses/Respondents/Signatures by Letter Generator Number 

• This lists each letter generator number and the number of responses, respondents, and 
signatures from that letter generator number for a certain project. 

Figure D.20: Responses/Respondents/Signatures by 
Immediate Attention Report 

Figure D.21: Responses/Respondents/Signatures by Letter 
Generator Report 



Appendix D ~ Database Reports D-14 

Responses/Respondents/Signatures by Organization Type 

• This lists each organization type code and the number of responses, respondents, and 
signatures from that code for a certain project. 

Responses/Respondents/Signatures by Request for Information 

• This lists each request for information code and the number of responses, respondents, and 
signatures from that code for a certain project. 

Figure D.22: Responses/Respondents/Signatures by 
Organization Type Report 

Figure D.23: Responses/Respondents/Signatures by Request 
for Information Report 
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Responses/Respondents/Signatures by Response Type 

• This lists each response type and the number of responses, respondents, and signatures from 
that response type for a certain project. 

Responses/Respondents/Signatures by State 

• This lists each state and the number of responses, respondents, and signatures from that state 
for a certain project. 

Figure D.24: Responses/Respondents/Signatures by 
Response Type Report 

Figure D.25: Responses/Respondents/Signatures by State 
Report 
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Responses/Respondents/Signatures by User Type 

• This lists each user type and the number of responses, respondents, and signatures from that 
user type for a certain project. 

Responses/Respondents/Signatures by Zip Code 

• This lists each zip code and the number of responses, respondents, and signatures from that 
zip code for a certain project. 

Figure D.26: Responses/Respondents/Signatures by User 
Type Report 

Figure D.27: Responses/Respondents/Signatures by Zip 
Code Report 
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•
Comments by Category  
Selected SOP (Stage of Process) 

• Lists respondent information, organization type, form number, letter number, management 
action, subject code, category code, comment number, and comment text, for a selected 
project and stage of process, sorted by category code. 

All SOP’s (Stages of Process) 

• Lists stage of process, respondent information, organization type, form number, letter 
number, management action, subject code, category code, comment number, and comment 
text, for a selected project, sorted by category code. 

Figure D.28: Comments by Category Report 

Figure D.29: Comments by Category (All SOPs) Report 
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Immediate Attention Comments 

• Lists immediate attention code, respondent information, organization type, form number, 
letter number, management action, subject code, category code, comment number, and 
comment text, for all letters for a certain project that have an immediate attention code, 
sorted by category code. 

Optional Reports 

Comments by subject (form)

• You can query the letter number, comment number, category code, and text for a certain 
project in this form.  This is used for cutting and pasting sample statements into a document. 

Figure D.30: Immediate Attention Comments Report 
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Immediate Attention Description 

• This lists the letter number, immediate attention code, and a previously entered comment 
about the letter for all letters from a certain project. 

Information Request Description 

• This lists the letter number, information request code, and a previously entered comment 
about the letter for all letters from a certain project.  

Figure D.31: Immediate Attention Description Report 

Figure D.32: Request for Information Report 
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Additional Database Reports 
The computer staff provides database reports other than the reports that are available through the 
Content Analysis Application.  These reports consist of any requested fields from the database 
and are available in a wide variety of formats: 

• Word processing programs:  reports can be put into most word processing programs 
format. 

• Spreadsheets:  reports can be put into any type of spreadsheet format. 

• Databases:  reports can be put into any type of database format. 

• Text:  reports can be formatted as a text file. 
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Appendix E ~ Letter Numbering Labels 

• Purchase AVERY 5167 labels (80 labels per sheet) 

• Open the Excel Program 

• In the first and second cell, enter the assigned or first letter(s) to the Project before the letter 
(respondent) number 

• Highlight the first two cells, put cursor on the right corner and drag, making sure the number 
ends in 80 or multiples of it (80 labels to a sheet) 

Go to File > Save as > Desktop > and name this File > SaveFile > Save as > Desktop > and name this File > SaveFile > Save as > Desktop > and name this File > SaveFile > Save as > Desktop > and name this File > Save 

Figure E.1: Excel Spreadsheet 

Figure E.2: Creating Letter Numbers 
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Figure E.3: Saving Excel Spreadsheet 

• Open the Access Program  

• On the Microsoft Access box click Blank 
Access Database > OK

• Save on the Desktop and Name the File > 
Create

                                                                                                    

                Figure E.4: Blank Access Database 
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Figure E.5: Saving New Database 

File > Get External Data > Import 

• When the Import Box comes up, click on your Desktop and go to Files of type and click on 
the drop down menu 

• Click in Excel (*.xls) and highlight the file you saved, click Import

Figure E.6: Importing Excel File 
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• Import Spreadsheet Wizard box appears 

Click Next > Next> Next > No Primary Key >Next 

Figure E.7: Import Spreadsheet Wizard 

• Name the table and Click Finish > OK

                             Figure E.8:  Successful Import   
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Figure E.9: Label Wizard 

• On the Database screen click on Reports > Create report by using Wizard> New

• The New Report box comes up click on Label Wizard

• Click on the drop down box, the name of the file you saved should be there 

• Double click to insert the File and click OK

Figure E.10: Label Selection 

• In the Label Wizard box go to Label Type to the drop-down menu first, and choose Avery 
USA 5167 

• After you choose the type of label you need the Unit of Measure, click English

• Scroll down until you find Avery USA 5167 ½½½½” x 1 3/4", this is the right size for letter 
numbering 



Appendix E ~ Letter Numbering Labels E-6 

• Click Next

• The next screen will ask 
you to choose the Text 
Appearance for your labels 

• Size should be 18 or 20
font

• Click Next

                                Figure E.11: Sample Label 

• What would you like on your mailing 
label?  Click on arrow ({Field1})

• Click Next

                                  

                                                                                                         Figure E.12: Label Fields 
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• Which fields would you like to sort by? None> Next

Figure E.13: Label Wizard 

• Name your table and Click Finish

Figure E.14: Naming Labels 
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Figure E.15: Preview of Labels 

• This screen will give a 
preview of what your 
labels look like. If you 
want to format (change 
font, size etc., center) your 
labels, go to View > 
Design View

• Click on the box and make 
your changes (Always 
Center) 

• Go to File > Save any 
changes that you have 
made

• When you are ready to 
print, put label sheet(s) in printer according to manufacturer instructions 

• Go to File > Print > Print   Figure E.16: Design View
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Appendix F ~ Coding Structure Templates and Flag 
Report Examples 

Appendix F contains the following Coding Structure Templates and Interim Flag Report 
Examples: 

• Standard and Optional Demographic or Letter Attribution Codes (OT, S, RT, DT, IA, 
UT, LG, F CIC, RI and CE ) 

• Standard Management Action Codes (Subject and Category fields) for Forest Plans 

• Example of Chequamegon-Nicolet DEIS Forest Plan Revision Coding Structure 

• Standard Alternative Codes (Affected Resource-Category 2 field, Theme Codes-Optional 
1 field) 

• Standard Management Action Codes for Proposed Rules 

• Example of  Early Attention Flag Report 

• Example of  Request for Information/Comment Extension Flag Report 

• Example of Planning Regulations Proposed Rule 02/03 
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Letter Attributions 

[Project Name] 
Letter Attribution Codes 

Coders will identify organization type, number of signatures, response type and delivery type on 
all letters by filling in the proper box. Use CIC (Common Interest Class) field only if this 
information is requested by the Administration. Fill in additional fields when necessary. 

Header Order: MID, OT, S, and RT, and DT fields are required. IA, UT, LG, F, CIC, RI, and 
CE fields are optional fields and used only where necessary. The TS (Total Signatures) field will 
tally automatically in Oracle. A stamp containing these fields will be placed on the working 
copy. 

         

MID OT S RT DT IA UT LG F CIC RI CE TS 

MID FIELD - Mail Identification – required 

MID is a unique respondent number assigned in the CAET Oracle Program. The Oracle form 
contains mailing information needed to create mailing labels and also is needed to obtain project 
specific demographic information about a respondent.

OT FIELD - Organization Type - required

The Organization Type code identifies a specific type of organization, association, agency, 
elected official or individual. The following are standard organization types: 

Government Agency/Elected Officials 

Code Description 

F Federal Agency/Elected Official 
N International Government/Association  
S State Government Agency/Elected Official/Association 
C County Government Agency/Elected Official/Association 
T Town/City Government Agency/Elected Official/Association 
Q Tribal Government/Elected Official/Tribal Member/Assn 

Interest Group (includes legal representatives of interest groups) 

A Agriculture Industry or Associations (Farm Bureau) 
B Business (my/our (someone speaking for or as a business owner), 

chamber of commerce) 
D Place Based Group (homeowner’s associations, planning 

cooperatives, i.e. Quincy Library Group) 
E Government Employee/Union 
G Domestic Livestock Industry (incl. permittees) 
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Letter Attributions 

H Consultants/legal representatives 
I Individual (unaffiliated, unknown or unidentifiable) 
J Civic Group (Kiwanis, Elks, Community Councils) 
K Special Use Permittee (Rec. homes, Backcountry huts, 

Outfitter/Guides) 
L Timber or Wood Products Industry or Associations 
M Mining Industry/Association (locatable) 
O Oil, Natural Gas, Coal, or Pipeline Industry (leasable) 
P Preservation/Conservation 
R Recreational (motorized/non-motorized, conservation, non-specific 

(-use this general code when client does not require the specific 
recreational organizations- see below) 

U Utility Group (water, electrical, gas) 
X Conservation District 
Y Other or unidentified Organization 
Z Multiple Use or Land Rights Organization 

Optional Organization Codes (Project Specific) 

AD Academic (professor, research scientist, university department) 
AR Animal Rights (humane treatment org) 
BL BLM employee 
BI BIA employee 
CF Commercial Fishing 
CH Church/Religious Group 
EO Extension Office (University) 
FS Forest Service Employee (analyzed separately) 
HT Hunting/trapping industry or Organization 
KS Special Use; Ski Industry (operators, management, interest group 
LO Private Land Owner 
MN Miners (unspecified) 
NP National Park Employee 
PA Professional Association/Society 
QQ Tribal Non-Governmental Organization/Member 
RB Mechanized Recreation (bicycling) 
RC Recreation/Conservation Organization (Trout Unlimited, Elk 

Foundation) 
RM Motorized Recreation (4X4, OHV, snowmobiling) 
RN Non-Motorized/Non-Mechanized Recreation (hiking, x-c ski, 

horse/stock animals) 
SF Small farms/farmers 
XX Regional/other governmental agency (multi-jurisdictional) 

Notes on Organization Type Identification: 
Letters from businesses are categorized as “B” only if you believe or they assert they are 
impacted by the decision, otherwise they are considered to be individual responses. A letter from 
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a member of an organization is considered to be an individual response unless the author is 
writing on behalf of the organization.  

Letters from government employees submitted as personal are categorized as “I” rather than as 
codes F, N, S, C, T Q, which are reserved for official comments from an elected official or 
government agency or department. Letters from government employees submitted on 
government letterhead or via government email are considered to be internal comment, and are 
separated from public comment and analyzed separately.

S FIELD - Signatures - required

To determine the number of Signatures, look first at the signature itself.  If the correspondence is 
signed John Doe, but the return address says John and Jane Doe, count it as one signature, 
because it was signed by one person.  If the return address says John Doe, but is signed by John
and Jane Doe, or Mr. and Mrs. Doe, count it as two signatures.  If no signature is present or 
response is anonymous, count it as one. If signed John Doe and Family, count it as one.   

RT FIELD - Response Type - required 

The Response Type identifies the specific format of the correspondence.  

Code Description 

1 Letter (postal service, express service, etc.) 
2 Form or Letter Generator 
3 Resolution 
4 Action Alert 
5 Transcript (dictated audio, video or telephone response) 

Optional RT codes (Project Specific)

6 Public Meeting Comment Form 
7 Public Meeting Transcript (hearing/oral testimony) 
8 Public meeting/workshop group notes 
9 Workshop notes (other than at Public Meetings) 

         10 Web-based comments (optional project specific) 
 11 Petition 

DT FIELD - Delivery Type – required 

The Delivery Type is the method by which the response is originally delivered. 

Code Description 

 E Email 
 F FAX 
 H Hand-delivered or oral testimony (personally delivered) 
 M US Mail or commercial carrier (UPS, FedEx) 
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 T Telephone 
 U Unknown 

IA FIELD - Immediate Attention - Red Flags (place on LEFT side of copy) 

Immediate Attention codes are applied only to those documents requiring an immediate response 
from the team. The Immediate Attention codes are listed in order of priority. If more than one 
code applies to a single document, the code with the highest priority is attached. Fore example, if 
a State Congressman threatens bodily harm to a Forest Service representative, the letter would 
receive a “1” instead of a “6”. A red flag is attached to the left side of the page with the IA code 
written on it.  

Code Description

1 Threat of harm  
2 Notice of appeal or litigation  
3 Freedom of Information Act request (FOIA)  
4 Provides proposals for new alternatives  
5 Requires detailed review 
6 Government entities  
7 Requests public hearing 

Optional IA codes (Project Specific)

5a Provides extensive technical edits – deletions/replacements  
5m Map(s) attached  
6a Requests cooperating agency status  

UT FIELD - User Type 

This is an optional project specific code. A User Type code defines the purpose for which an 
individual, organization, or agency uses public lands. User types vary depending on the project 
or client needs. Examples: 

Code    Description
A Area residents 
B Businesses and services 
K Bikers 
C Campers 
F Anglers 
H Hikers 
P Photographers 
W Non-motorized watercraft users 
R Rock climbers 
S Stock users 
X No identifiable type
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LG FIELD - Letter Generator 

A Letter Generator is a response that enables respondents to extract specific text from a 
selection of prewritten comments. These responses are usually created through an interactive 
website that offers a selection of comments and allows the respondent to choose which 
paragraphs to include in their personal letter. Assign a consecutive LG number to these 
responses. Enter this number. 

F FIELD - Forms (Organized Response Campaigns) 

Forms or organized response campaign responses are identified when the mail processor 
receives 5 or more responses with identical text from different (unaffiliated) respondents. Enter 
the form number assigned by the team.   

CIC FIELD - Common Interest Class  

The Common Interest Classification codes are an optional. The code represents an effort to 
capture each respondent’s overall view on a proposal. The range of views on a project assumes 
an almost infinite number of values, as each respondent contributes something personal and 
subjective to the analysis. 

CIC codes are not used as a voting procedure. However, CIC categories provide managers with 
an estimate of the respondent’s range of interests, including a range of management actions that 
respondents deem appropriate. CIC Roman numeral codes vary depending on the customer 
needs.

Some examples of Common Interest Classifications are: 

Code Description

0 No preference stated. Category O responses are requests for information 
or are requests to extend the comment period and contain no indication of 
position or preference. 

I Respondent favors a more restrictive combination of alternatives/policy 
options. This category includes all responses that claim the chosen 
alternatives do not offer strong enough protection to roadless areas.  
These responses may include suggestions for policies not discussed. 

II Respondent favors a less restrictive combination of alternatives/policy 
options. 

III This category includes most responses that convey a degree of support 
for the direction of the policy, but with specific exceptions. 

IV Respondent favors no action, a combination of alternatives, or general 
opposition to the plan. 

V Respondent favors the preferred combination of alternatives or expresses 
general support for the plan.
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RI FIELD - Requests for Information - Blue flag (place on LEFT side of copy) 

Requests for Information codes are applied only to those responses with specific requests for 
information pertaining to the proposal. The client determines the level of specificity for 
identifying information requests. A blue flag is attached to the left side of the page with the IR 
code written on it.

Code Description 

A Mailing list only or nothing to code (do not attach a flag)
B Request to be removed from mailing list (do not attach a flag)
C Request copy of Federal Register Notice 
D Other request for specific information 
E Request for confirmation of receipt of letter 

Optional RI codes (project specific)

F Request for hard copy of summary of the DEIS 
G Request for full hard copy of DEIS 
H Request for full CD version of DEIS 
I Request for hard copy of summary of FEIS 
J Request for full hard copy of FEIS 
K Request for CD version of FEIS 
L Request for draft copy of proposed rule/policy 
M Request for final copy of rule/policy 
Ch Request for hard copy of Fed Register Notice of the Proposed Rule 
Cd Request for CD of Fed Register Notice of Proposed Rule 
Ce Request for electronic copy of Fed Register of Proposed Rule 

CE FIELD - Comment Extension - Yellow Flag (place on LEFT side of copy)

Comment Extension codes are used when a respondent has a specific request for extending the 
comment period. 

Code Description 

  0  No specific time mentioned or other 
15 Request for 15 Day comment period extension 

 30 Request for 30 Day comment period extension 
 45 Request for 45 Day comment period extension 
 60 Request for 60 Day comment period extension 
 90 Request for 90 Day comment period extension 
         120 Request for 120 Day comment period extension 

TS FIELD - Total Signatures  

The Oracle automated field totals all signatures for all MIDs assigned to a response. Do not enter 
any codes here. 
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STANDARD CODING STRUCTURE TEMPLATE  
FOREST PLANS 

Primary Codes – Subject/Category 

PLANN 10000-19999 
10000 Purpose and Need for Proposed Action 
11000 Decision making  

11100 Role/Authority 
11110 PRESIDENT/EXECUTIVE BRANCH
11120 USDA/FOREST SERVICE
11130 LEGISLATIVE BRANCH (CONGRESS)
11140 JUDICIAL BRANCH (COURTS)
11150 STATE, COUNTY, AND MUNICIPAL GOVERNMENTS

11200 Role/influence of Interest Groups 
11210 ENVIRONMENTAL GROUPS
11220 MULTIPLE USE/ WISE USE GROUPS
11230 INDUSTRY/BUSINESS GROUPS

11300 Role/influence of General Public  
11310 LOCAL CITIZENS/COMMUNITIES
11320 NATIONWIDE CITIZENS/COMMUNITIES

12000 Public Involvement 
12100 Adequacy/Availability of Information 
12200 Outreach/Agency Communication Efforts 
12300  Educate the Public 
12400 Use of Public Involvement/Comment 

12410 METHODOLOGY AND TECHNIQUES
12500 Public Meetings 
12600 Adequacy of Comment Period 

12610 EXTENSION NEEDED
12620 NO EXTENSION NEEDED

12700 Adequacy of Entire Timeframe 
   13000 Collaboration with Other Government Entities 
 13100  Tribal Agencies or Officials 
 13200  Other Federal Agencies or Elected Officials 
 13300  State Agencies or Elected Officials 
 13400  County and Municipal Agencies or Elected Officials 

14000 Trust and Credibility 
 14100  Current Administration 
 14200  USDA Forest Service 
15000 Use of Science in Decision making General 

15100 Best Available Science 
16000 Agency Organization and Funding 

16100 General Comments about the Agency 
16200 Funding, General 
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16210 FUNDING FOR PLANNING PROCESS
16220 FUNDING FOR IMPLEMENTATION OF PROPOSED ACTION

16300 Staffing General 
16310 STAFF TRAINING, EDUCATION

ALTER 20000-22999 
20000 Alternatives General 

20100 Alternative Development/Range 
20200 Alternatives Not Considered In Detail 
20300 Alternatives Developed by Others 

21000 Specific Alternatives (list) 

LEGAL 23000-25999 
23000 Relation To Laws, Act, Policies General 

23100 Constitution 
23200 Federal Laws, Acts, and Policies 

23210 NEPA 
23220 NFMA 
23230 OTHER
23300 STATE LAWS, ACTS, AND POLICIES

TRIBL 26000-29999 
26000 Tribal Rights and Interests General 

26100 Federal Trust Responsibilities 
26200 Tribal Government Issues 

27000 American Indian Use of Public Lands 
27100 Cultural Interests  
27200 Economic Interests 
27300 Spiritual Interests 

ENVIR 30000-39999 
30000 Environmental Values General 

30100 Multiple Environmental Resources 
30200 Environmental Quality and Ecosystem Integrity 
30300 Short-Term Vs. Long-Term Productivity/Risks 

31000 Physical Elements, General 
31100 Multiple Physical Resources 
31200 Soils and Geology 

31210 SOIL PRODUCTIVITY
31220 SOIL DISTURBANCE (EROSION, COMPACTION, ETC.) 
31230 CAVE RESOURCES

31300 Air Quality 
31400 Noise 
31500 Water Resources 

31510 SURFACE WATER
31520 GROUNDWATER
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31530 RIPARIAN AREAS AND WETLANDS
31540 WATER QUANTITY
31550 WATER QUALITY
31560 WATERSHED CONDITION

31600 Climate, Weather, and Atmospheric Processes 
32000 Biological Elements, General 

32100 Multiple Biological Resources 
32200 Biodiversity  

32210 GENETIC DIVERSITY
32300 Ecosystem/Habitat Composition and Function 

32310 FRAGMENTATION, PERFORATION, AND CONNECTIVITY
33000 Wildlife General 

33100 Wildlife Population Management 
33110 BREEDING PROGRAMS, STOCKING, AND REINTRODUCTIONS
33120 HARVEST LEVELS (HUNTING, FISHING—AS POPULATION 

MANAGEMENT ACTIVITIES)
33200 Fisheries and Aquatic Wildlife 

33210 AQUATIC WILDLIFE AND HABITAT
33220 FISHERIES, NATIVE AND NON-SPORT
33230 FISHERIES, SPORT
33240 THREATENED, ENDANGERED, AND SENSITIVE SPECIES

33300 Terrestrial Wildlife and Habitat 
33310 NON-GAME WILDLIFE
33320 GAME SPECIES
33330 AVIFAUNA
33340 INVERTEBRATES AND INSECTS
33350 THREATENED, ENDANGERED, AND SENSITIVE SPECIES

34000 Forested Vegetation 
34100 Forest Structure/Mosaic 
       34110 SPECIES COMPOSITION

34120 AGE COMPOSITION
 34121 LATE SUCCESSIONAL/OLD GROWTH
 34122 EARLY SUCCESSIONAL
34140 DOWNED WOODY DEBRIS
34150 DISTURBANCE REGIMES (INSECTS & DISEASE, BLOW DOWNS)
34160 CLEARINGS AND CANOPY OPENINGS

35000 Botanical Resources 
35100 Threatened, Endangered, and Sensitive Species 

36000 Non-Forested/Rangeland Vegetation 
36100 Invasive Non-Native Species 

TRANS  40000-44999 
40000 Forest Transportation System General (infrastructure) 
41000 Roads Infrastructure Management General (For Use of Roads/Restrict or 

don’t Restrict Access, Use RECRE codes) 
41100 Construction 
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41110 FOR PRIVATE PROPERTY ACCESS ACROSS AGENCY-
ADMINISTERED LANDS

41200 Road Maintenance 
41300 Road /Removal/Decommissioning (for closures and use mgmt., 

use RECRE codes) 
42000 Trails Infrastructure Management General  

42100 Trails Construction 
42200 Trails Maintenance 
42300 Trails /Removal/Decommissioning  

43000 User-Created Roads and Trails 

RECRE 45000-49999 
45000 Recreation Management General 

45100 Multiple Recreational Activities/Laundry Lists 
45200 Use of Volunteers 
45300 User Conflicts 

46000 Recreation Types:  Non-Commercial, Dispersed, or Unspecified 
46100 Motorized Recreation General 

46110 SUMMER OR YEAR-ROUND
46120 WINTER

46200 Mechanized Recreation 
46300 Non-Motorized, Non-Mechanized Recreation, summer or Year-

Round 
46310 SKIING, BACKCOUNTRY/CROSS-COUNTRY

46400 Hunting and Fishing 
46500 Camping, Dispersed 
46600 Equestrian Recreation 
46700 Other 

47000 Recreation: Developed Facilities, Commercial Use, Special Use Permits, and 
Fees General 

47100 Campgrounds and Picnic Areas 
47200 Trailheads, Signage, and Parking 
47300 Fee Demonstration Project and User Fees 
47400 Outfitter-Guides 
47500 Ski Areas 

48000 Scenery and Visual Resources Management 

LANDS 50000-52999 
50000 Landownership General 

50100 Lands Acquisition By Agency 
50200 Land Exchanges and Disposal 

50210 APPRAISALS AND VALUATION
51000 Rights-of-Way General 

51100 Rights-of-Way to Public Lands across Private Property 
51200 Rights-of-Way to Private Property across Public Lands 
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SPECL 53000-55999 

53000 Special Designations General 
53100 Roadless Areas 

53110  INVENTORIES
53120 IRAS AND WILDERNESS RECOMMENDATIONS (DO/DO NOT

RECOMMEND)
53200 Designated Wilderness 
53300 Other Special Designations 

53310 WILD, SCENIC, AND RECREATIONAL RIVERS
53320 SPECIAL INTEREST AREAS
53330 RESEARCH NATURAL AREAS

54000 Specific Management Prescriptions 
55000 Heritage and Cultural Resource Management 

NRMGT 60000-69999 
60000 Natural Resources Management General 

60100 Multiple Natural Resource/Management Activities 
60200 Guiding Management Philosophy 

60210 MULTIPLE USE MANAGEMENT
60220 ECOSYSTEM MANAGEMENT

60300 ADAPTIVE MANAGEMENT
60310 MONITORING AND EVALUATION

61000 Timber Resource Management 
61100 Allowable Sale Quantity 
61200 Harvest Methods 

62000 Other Forest Products 
63000 Domestic Livestock Management 
64000 Fire Management 

64100 Role of Fire in Ecosystems 
64200 Fire Plans 
64300 Prescribed Fire 

64310 SMOKE MANAGEMENT
64400 Mechanical Thinning 
64500 Wildland Fire 

65000 Forest Health Management 
65100 Forest Health Management Activities 

66000 Mineral Resources 
66100 Leasable (Oil, Gas, Coal, Pipelines) 
66200 Locatable (Hard rock) 
66300 Salable (Gravel, Rock, Etc.) 
66400 Palentological Resources 

67000 Utility Facilities 
67100 Communication Sites and Facilities 
67200 Water Resource Development 
67300 Hydroelectric Development 



[Project Name] 
8/12/2003 

Forest Plan Template CS 

67400 Utility Corridors 
68000 Research and Educational Facilities 

SOCIO  70000-72999 
70000 Social Values General (Includes Socio-Economic General) 

70100 Demographics 
70110 POPULATION
70120 COMMUNITY STRUCTURE AND STABILITY
70130 URBANIZATION AND DEVELOPMENT

70200 Quality of Life 
70300 Public Health and Safety 
70400 Equity  

70410 INTERGENERATIONAL EQUITY (FUTURE GENERATIONS,
LEGACY VALUES)

70420 ENVIRONMENTAL JUSTICE
70430 CLASS AND INCOME EQUITY
70440 TRANSFER OF EFFECTS INTERNATIONALLY
70450 INHERENT VALUES OF ENVIRONMENT (INTERSPECIES EQUITY)

ECONO  73000-75999 
73000 Economic Values General 
74000 Contribution/Role of Agency-Administered Lands and Resources To 

Economy 
74100 International  
74200 Us  
74300 Local/Regional 
74400 Employment 
74500 Business Viability 
74600 Private Property Values 
74700 Tax Base and Payments To States 

75000 Net Public Benefit and Agency Accounting 
75100 Cost Benefit Analysis General 
75200 Non-Market Products and Services (Valuation/Externalities) 
75300 Commodities Valuation and Subsidies 

ATTMT xxxxx (use the next general category code) 
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Chequamegon-Nicolet Forest Plan Revision DEIS 
Coding Structure 

The coding structure is a topical outline with alpha and numeric codes attached. It is a tool to 
identify public comments and sort them into recognizable topic categories. Once comments are 
assigned codes, they are then entered into a database from which they can be reported and sorted 
in any combination needed for analysis. 

The coding structure is organized into required fields called subject and category codes. Subject 
codes are five-character alpha codes that represent broad themes associated with a project. 
Category codes are five-digit numeric codes that define specific subtopics within each subject 
code, and they are generally arranged from the general to specific with subcategories nested 
within categories. 

PLANN (Subject code for Planning) 10000 – 17200 

Category  Description 

10000  Purpose and Need for Proposed Action 

11000  Decisionmaking Authority 

11100  Role / Authority 
11110  President / Executive Branch 
11120  USDA / Forest Service 
11130   Regional Office 
11140  Forest / Supervisor’s Office 
11150  District Offices 
11160  Legislative Branch 
11170  Judicial Branch 
11180  State, County, and City Governments 

11200  Role of Interest Groups 
11210  Environmental Groups 
11220  Multiple Use /  Wise Use Groups 
11230  Industry / Business Groups 

11300  Role of General Public  
11310  Local Citizens / Communities 
11320  Nationwide Citizens / Communities 

12000  Public Involvement 

12100  Adequacy / Availability of Information 
12200  Outreach / Agency Communication Efforts 



[Project Name] 
8/12/2003 

Chequamegon – Nicolet FPR DEIS 

12300  Use of Public Involvement / Comment 
12310  Methodology and Techniques 

12400  Public Meetings 
12500  Adequacy of Comment Period 

12510  Extension Needed 
12520  No Extension Needed 

12600  Adequacy of Timeframe 
12700  Collaboration 

13000  Agency Trust and Credibility 

14000  Use of Science - General 

14100  Best Available Science 
14200  Maps / Inventories / GIS 
14300  Monitoring and Evaluation 

15000  Relation To or Consistency with Other Plans, Directives, Etc. 

15100  Roadless Area Conservation Rule 
15200  National Fire Plan 
15300  Plans of Other Federal Agencies 
15400  Consistency Among Region Nine Forest Plans / EISs 

16000  Agency Organization and Funding 

16100  General Comments About The Agency 
16200  Funding, General 

16210  Funding For Planning Process 
16220  Funding For Implementation of Proposed Action 

16300  Staffing General 
16310  Staff Training, Education 

16400  Staffing and / or Funding for Enforcement Activities 

17000  Editorial or Technical comments / corrections 

17100  Definitions 
17200  Spelling / Grammar 

ALTER 18000 - 19900 

18000  Alternatives General 

18100  Alternative- Development / Range 
18200  Alternative- Not Considered In Detail 

18210  Alternative- Early Successional Habitat / Limited Alt Management Areas / 
Increase Recreation 
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18220  Alternative- Maintenance of Aspen Acres from 1986 Plans / Revision 
Biological Diversity 

18230  Alternative- ATV Off-Road, Off-Trail Cross-Country Use 
18240  Alternative- Increase ATV Intensive Use Areas 
18250  Alternative- Inventoried Roadless Areas / Roadless Conservation Rule ES / 

Wilderness 
18260  Alternative- Maintain ASQs at 1986 Plan / ASQs Calculated in Max Timber 

Benchmark 
18270  Alternative- Permit Departure from Policy of Non-Declining Timber Yield 

18300  Recommendation for New Alternative 

19000  Specific Alternatives  

19100  Alternative 1 No Action; Continues Current Management Direction 
19200  Alternative 2 Emphasizes Production and Maintenance of Early Successional 

Species 
19300  Alternative 3 Emphasizes Level Bio Diversity / Increased Remote, Non-

Motorized Recreational Areas 
19400  Alternative 4 Emphasizes Recommended Areas for Wilderness Designation / 

More Remote, Non-Motorized Recreational Areas 
19500  Alternative 5 Emphasizes Traditional No. Hardwood Management / Meet 

Species Viability 
19600  Alternative 6 Conversion of Early-Succession to Longer-Lived Species / 

Moderate Emphasis on Bio Diversity 
19700  Alternative 7 Emphasizes No. Hardwood Production Sawtimber / Mod to High 

on Bio Diversity 
19800  Alternative 9 Emphasizes Increased ATV Access / Mod to High on Bio 

Diversity 
19900  * (No Alternative 8) 

LEGAL 20000 - 20230  

20000  Laws, Act, Policies General 

20100  Constitution 
20200  Federal Laws, Acts, and Policies 

20210  NEPA 
20220  NFMA 
20230  Other 

TRIBL 21000 - 22300 

21000  Tribal Rights and Interests General 



[Project Name] 
8/12/2003 

Chequamegon – Nicolet FPR DEIS 

21100  Federal Trust Responsibilities 
21200  Tribal Government Issues 

22000  American Indian Use of Public Lands 

22100  Cultural Interests  
22110  Tribal Miscellaneous Forest Products Gathering 

22200  Economic Interests 
22300  Spiritual Interests 

ENVIR 23000 - 30000 

23000  Environmental Values General 

23100  Multiple Environmental Resources 
23200  Environmental Quality and Ecosystem Integrity 
23300  Short-Term Vs. Long-Term Productivity/Risks 

24000  Physical Elements, General 

24100  Multiple Physical Resources 
24200  Soils and Geology 

24210  Soil Productivity 
24220  Soil Disturbance (Erosion, Compaction, Etc.) 

24300  Air Quality 
24400  Noise 
24500  Water Resources 

24510  Surface Water 
24520  Groundwater 
24530  Water Quantity 
24540  Water Quality 
24550  Watershed Condition 
24560  Riparian Areas and Wetlands 
24570  ____________ River Watershed (Specific) 

24600  Climate, Weather, and Atmospheric Processes 

25000  Biological Elements, General 

25100  Multiple Biological Resources 
25200  Biodiversity  

25210  Genetic Diversity 
25300  Ecosystem / Habitat Composition and Function 

25310  Edge Effects 
25320  Fragmentation, Perforation, and Connectivity 
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25330  Ecosystem Restoration 
25340  Management Indicator Communities 

26000  Wildlife General 

26100  Wildlife Population Management 
26110  Breeding Programs, Stocking, and Reintroductions 
26120  Harvest Levels  (hunting, fishing—as population management activities) 

26200  Fisheries and Aquatic Wildlife 
26210  Aquatic Wildlife and Habitat 
26220  Fisheries, Native and Non-Sport 
26230  Fisheries, Sport 
26240  Threatened, Endangered, and Sensitive Species 

26300  Terrestrial Wildlife and Habitat 
26310  Non-Avian Non-Game Wildlife 
26320  Game Species 

26321  Ruffed Grouse 
26322  White Tailed Deer 
26323  Woodcock 
26324  Other

26330  Avifauna 
26340  Invertebrates and Insects 
26350  Threatened, Endangered, and Sensitive Species 
26360  Locally Rare Species 
26370  Management Indicator Species 

27000  Forested Vegetation 

27100  Forest Structure 
27110  Downed Woody Debris 
27120  Old Growth 
27130  Mid to Late Successional  
27140  Early Successional 
27150  Disturbance Processes: Insects and Disease 

28000  Botanical Resources 

28100  Threatened, Endangered, and Sensitive Plant Species 

29000  Non-Forested 

30000  Invasive Non-Native Species 
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TRANS 31000 - 34000 

31000  Forest Transportation System General (Infrastructure) 

32000  Roads Infrastructure Management General (For Use of Roads / Restrict or 
don’t Restrict Access, Use RECRE codes) 

32100  Construction 
32110  For Access to Private Property Across Agency-Administered Lands 
32120  For Access Across Private Property to Agency-Administered Lands 

32200  Road Maintenance 
32300  Road / Removal/Decommissioning (for closures and use mgmt., use RECRE codes) 

33000  Trails Infrastructure Management General  

33100  Trails Construction 
33200  Trails Maintenance 
33300  Trails / Removal/Decommissioning  

34000  User-Created Roads and Trails 

RECRE 35000 - 38000 

35000  Recreation Management General 

35100  Multiple Recreational Activities/Laundry Lists 
35200  Use of Volunteers 
35300  User Conflicts 

36000  Recreation Types / Opportunities 

36100  Motorized Recreation General 
36200  Off-road vehicles 

36211  ATV 
36212  4Wheel Drive 
36213  Other OHV 

36300  Mechanized Recreation 
36400  Non-Motorized, Non-Mechanized Recreation 
36500  Backcountry Recreation 
36600  Hunting and Fishing 
36700  Dispersed Camping 
36800  Equestrian Recreation 
36900  Other 

37000  Recreation: Developed Facilities, Commercial Use, Recreational Special 
Uses, and Fees General 
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37100  Campgrounds and Picnic Areas 
37200  Trailheads, Signage, and Parking 
37300  Fee Demonstration Project and User Fees 
37400  Outfitter-Guides 

38000  Scenery and Visual Resources Management (aesthetics) 

LANDS 39000 - 40200 

39000  Landownership General 

39100  Lands Acquisition By Agency 
39200  Land Exchanges and Disposal 

39210  Appraisals and Valuation 
39220  Subsurface Property Rights 

40000  Rights-of-Way General 

40100  Rights-of-Way to Public Lands Across Private Property 
40200  Rights-of-Way to Private Property Across Public Lands 

SPECL 41000 - 41400 

41000  Special Designations General 

41100  Roadless Areas 
41110   Inventories 
41120   IRAs and Wilderness Recommendations (Do/Do Not Recommend) 

41200  Designated Wilderness 
41300  Other Special Designations 

41310  Semi-Primitive Non-Motorized (SPNM) 
41320  Wild, Scenic, and Recreational Rivers 
41330  Special Management Areas 
41340  Research Natural Areas 

41400  Heritage and Cultural Resource Management 

NRMGT 42000 - 50000 

42000  Natural Resources Management General 

42100  Multiple Natural Resource / Management Activities 
42200  Guiding Management Philosophy 

42210  Multiple Use Management 
42220  Ecosystem Management 
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42230  Adaptive Management 
42240  Monitoring and Evaluation 

43000  Timber Resource Management 

43100  Allowable Sale Quantity 
43200  Harvest Methods 
43300  Lumber and Wood Products 

44000  Other Forest Products 

45000  Domestic Livestock Management 

46000  Fire Management 

46100  Role of Fire In Ecosystems 
46200  Fire Plans 
46300  Prescribed Fire 

46310  Smoke Management 
46400  Mechanical Thinning 
46500  Wildland Fire 

47000  Forest Health Management 

47100  Forest Health Management Activities 
47200  Insect and Disease Management 

48000  Mineral Resources 

48100  Leasable (Oil, Gas, Coal, Pipelines) 
48200  Locatable (Hardrock) 
48300  Salable (Gravel, Rock, Etc.) 
48400  Palentological Resources 

49000  Utility Facilities 

49100  Communication Sites and Facilities  
49200  Water Resource Development 
49300  Utility Corridors 

50000  Research and Educational Facilities 

SOCIO 51000 - 51450 

51000  Social Values General (Includes Socio-Economic General) 

51100  Demographics 
51110  Population 
51120  Community Structure and Stability 
51130  Urbanization and Development 



[Project Name] 
8/12/2003 

Chequamegon – Nicolet FPR DEIS 

51200  Quality of Life 
51300  Public Health and Safety 
51400  Equity  

51410  Intergenerational Equity (Future Generations, Legacy Values)  
51420  Environmental Justice 
51430  Class and Income Equity 
51440  Transfer of Effects Internationally 
51450  Inherent Values of Environment (Interspecies Equity) 

ECONO 52000 - 54300 

52000  Economic Values General 

53000  Contribution / Role of Agency-Administered Lands and Resources to 
Economy 

53100  International  
53200  U.S. 
53300  Local / Regional 
53400  Employment 
53500  Business Viability 
53600  Private Property Values 
53700  Tax Base and Payments to States 

54000  Net Public Benefit and Agency Accounting 

54100  Cost Benefit Analysis General 
54200  Non-Market Products and Services (Valuation / Externalities) 
54300  Commodities Valuation and Subsidies 

ATTMT 53000 (response letter contains an attachment) 
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[Project Title] July 25, 2003 

Rules CS Template 

STANDARD CODING STRUCTURE TEMPLATE  
PROPOSED RULES 

Primary Codes – Subject/Category 

PLANN 10000-19999 
10000 Purpose and Need for Proposed Action 
11000 Decisionmaking  

11100 Role/Authority 
11110 PRESIDENT/EXECUTIVE BRANCH
11120 USDA/FOREST SERVICE
11130 LEGISLATIVE BRANCH (CONGRESS)
11140 JUDICIAL BRANCH (COURTS)
11150 STATE, COUNTY, AND MUNICIPAL GOVERNMENTS

11200 Role/influence of Interest Groups 
11210 ENVIRONMENTAL GROUPS
11220 MULTIPLE USE/ WISE USE GROUPS
11230 INDUSTRY/BUSINESS GROUPS

11300 Role/influence of General Public  
11310 LOCAL CITIZENS/COMMUNITIES
11320 NATIONWIDE CITIZENS/COMMUNITIES

12000 Public Involvement 
12100 Adequacy/Availability of Information 
12200 Outreach/Agency Communication Efforts 
12300  Educate the Public 
12400 Use of Public Involvement/Comment 

12410 METHODOLOGY AND TECHNIQUES
12500 Public Meetings 
12600 Adequacy of Comment Period 

12610 EXTENSION NEEDED
12620 NO EXTENSION NEEDED

12700 Adequacy of Entire Timeframe 
   13000 Collaboration with Other Government Entities 
 13100  Tribal Agencies or Officials 
 13200  Other Federal Agencies or Elected Officials 
 13300  State Agencies or Elected Officials 
 13400  County and Municipal Agencies or Elected Officials 

14000 Trust and Credibility 
 14100  Current Administration 
 14200  USDA Forest Service 
15000 Use of Science in Decisionmaking General 

15100 Best Available Science 
16000 Agency Organization and Funding 

16100 General Comments about the Agency 
16200 Funding, General 



[Project Title] July 25, 2003 

Rules CS Template 

16210 FUNDING FOR PLANNING PROCESS
16220 FUNDING FOR IMPLEMENTATION OF PROPOSED ACTION

16300 Staffing General 
16310 STAFF TRAINING, EDUCATION

LEGAL 20000-25999 
20000 Relation To Laws, Act, Policies General 

20100 Constitution 
20200 Federal Laws, Acts, and Policies 

20210 NEPA 
20220 NFMA 
20230 OTHER

20300        STATE LAWS, ACTS, AND POLICIES

TRIBL 25000-29999 
25000 Tribal Rights and Interests General 

25100 Federal Trust Responsibilities 
25200 Tribal Government Issues 

26000 American Indian Use of Public Lands 
26100 Cultural Interests  
26200 Economic Interests 
26300 Spiritual Interests 

ENVIR 30000-39999 
30000 Environmental Values General 

30100 Multiple Environmental Resources 
30200 Environmental Quality and Ecosystem Integrity 
30300 Short-Term Vs. Long-Term Productivity/Risks 

31000 Physical Elements, General 
31100 Multiple Physical Resources 
31200 Soils and Geology 

31210 SOIL PRODUCTIVITY
31220 SOIL DISTURBANCE (EROSION, COMPACTION, ETC.) 

31300 Air Quality 
 31310  Smoke From Fires/Prescribed Burns 
31400 Noise 
31500 Water Resources 

31510 SURFACE WATER
31520 GROUNDWATER
31530 RIPARIAN AREAS AND WETLANDS
31540 WATER QUANTITY
31550 WATER QUALITY
31560 WATERSHED CONDITION

31600 Climate, Weather, and Atmospheric Processes 
       31610 Global Warming/Greenhouse Effect (Carbon 

Sequestering)   
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Rules CS Template 

32000 Biological Elements, General 
32100 Multiple Biological Resources 
32200 Biodiversity  

32210 GENETIC DIVERSITY
32300 Ecosystem/Habitat Composition and Function 

32310 FRAGMENTATION, PERFORATION, AND CONNECTIVITY
33000 Wildlife General 

33100 Wildlife Population Management 
33200 Fisheries and Aquatic Wildlife 
33300 Terrestrial Wildlife and Habitat 

33310 NON-GAME WILDLIFE
33320 GAME SPECIES
33330 BIRDS
33340 INVERTEBRATES AND INSECTS
33350 THREATENED, ENDANGERED, AND SENSITIVE SPECIES

34000 Forested Vegetation 
34100 Forest Structure/Mosaic 
       34110 SPECIES COMPOSITION

34120 AGE COMPOSITION
 34121 LATE SUCCESSIONAL/OLD GROWTH
 34122 EARLY SUCCESSIONAL
34140 DOWNED WOODY DEBRIS
34150 DISTURBANCE REGIMES (INSECTS & DISEASE, BLOW DOWNS)
34160 CLEARINGS AND CANOPY OPENINGS

35000 Botanical Resources 
35100 Non-Timber Commercial Plants 
35200      Threatened, Endangered, and Sensitive Species 

36000 Non-Forested/Rangeland Vegetation 
36100 Invasive Non-Native Species 

TRANS  40000-44999 
40000 Forest Transportation System General (infrastructure) 
41000 Roads Infrastructure Management General (For Use of Roads/Restrict or 

don’t Restrict Access, Use RECRE codes) 
41100 Construction 

41110 FOR PRIVATE PROPERTY ACCESS ACROSS AGENCY-
ADMINISTERED LANDS

41200 Road Maintenance 
41300 Road /Removal/Decommissioning (for closures and use mgmt., 

use RECRE codes) 
42000 Trails Infrastructure Management General  

42100 Trails Construction 
42200 Trails Maintenance 
42300 Trails /Removal/Decommissioning  

43000 User-Created Roads and Trails 
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RECRE 45000-49999 
45000 Recreation Management General 

45100 Multiple Recreational Activities/Laundry Lists 
45200 Use of Volunteers 
45300 User Conflicts 

46000 Recreation Types:  Non-Commercial, Dispersed, or Unspecified 
46100 Motorized Recreation General 

46110 SUMMER OR YEAR-ROUND
46120 WINTER

46200 Mechanized Recreation 
46300 Non-Motorized, Non-Mechanized Recreation, summer or Year-

Round 
46310 SKIING, BACKCOUNTRY/CROSS-COUNTRY

46400 Hunting and Fishing 
46500 Camping, Dispersed 
46600 Equestrian Recreation 
46700 Other 

47000 Recreation: Developed Facilities, Commercial Use, Special Use Permits, and 
Fees General 

47100 Campgrounds and Picnic Areas 
47200 Trailheads, Signage, and Parking 
47300 Fee Demonstration Project and User Fees 
47400 Outfitter-Guides 
47500 Ski Areas 

48000 Scenery and Visual Resources Management 

LANDS 50000-52999 
50000 Landownership General 

50100 Lands Acquisition By Agency 
50200 Land Exchanges and Disposal 

50210 APPRAISALS AND VALUATION
51000 Rights-of-Way General 

51100 Rights-of-Way to Public Lands across Private Property 
51200 Rights-of-Way to Private Property across Public Lands 

SPECL 53000-55999 

53000 Special Designations General 
53100 Roadless Areas 

53110  INVENTORIES
53120  IRAS AND WILDERNESS STUDY AREAS (DO/DO NOT RECOMMEND 

FOR WILDERNESS)
53200 Designated Wilderness 
53300 Other Special Designations 

53310 WILD, SCENIC, AND RECREATIONAL RIVERS
53320 SPECIAL INTEREST AREAS
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53330 RESEARCH NATURAL AREAS
54000 Heritage and Cultural Resource Management 

NRMGT 60000-69999 
60000 Natural Resources Management General 

60100 Multiple Natural Resource/Management Activities 
60200 Guiding Management Philosophy 

60210 MULTIPLE USE MANAGEMENT EMPHASIS
60220 ECOSYSTEM MANAGEMENT EMPHASIS

60300 ADAPTIVE MANAGEMENT
60310 MONITORING AND EVALUATION

61000 Timber Resource Management 
61100 Allowable Sale Quantity 
61200 Harvest Methods 
61300 Commercial Timber Sale/Harvest 

62000 Other Forest Products 
63000 Domestic Livestock Management 
64000 Fire Management 

64100 Role of Fire In Ecosystems 
64200 Fire Plans 
64300 Prescribed Fire 
64400 Mechanical Thinning 
64500 Wildland Fire 

65000 Forest Health Management 
65100 Forest Health Management Activities 

66000 Mineral Resources 
66100 Leasable (Oil, Gas, Coal, Pipelines) 
66200 Locatable (Hardrock) 
66300 Salable (Gravel, Rock, Etc.) 
66400 Palentological Resources 

67000 Utility Facilities 
67100 Communication Sites and Facilities 
67200 Water Resource Development 
67300 Hydroelectric Development 
67400 Utility Corridors 

68000 Research and Educational Facilities 

SOCIO  70000-72999 
70000 Social Values General (Includes Socio-Economic General) 

70100 Demographics 
70110 POPULATION
70120 COMMUNITY STRUCTURE AND STABILITY
70130 URBANIZATION AND DEVELOPMENT

70200 Quality of Life 
70300 Public Health and Safety 
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70400 Equity  
70410 INTERGENERATIONAL EQUITY (FUTURE GENERATIONS,

LEGACY VALUES)
70420 ENVIRONMENTAL JUSTICE
70430 CLASS AND INCOME EQUITY
70440 TRANSFER OF EFFECTS INTERNATIONALLY
70450 INHERENT VALUES OF ENVIRONMENT (INTERSPECIES EQUITY)

ECONO  73000-75999 
73000 Economic Values General 
74000 Contribution/Role of Agency-Administered Lands and Resources To 

Economy 
74100 International  
74200 Us  
74300 Local/Regional 
74400 Employment 
74500 Business Viability 
74600 Private Property Values 
74700 Tax Base and Payments to States 

75000 Net Public Benefit and Agency Accounting 
75100 Cost Benefit Analysis General 
75200 Non-Market Products and Services (Valuation/Externalities) 
75300 Commodities Valuation and Subsidies 

ATTMT xxxxx (use next general category code)
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Early Attention Interim Report Example 

 [Project Title] 
Early Attention Report 

The following report consists of early attention letters received through [date]. Included in the 
report are [sample-two letters requesting public hearings]. 

This report is intended primarily for an internal audience. The relevant designations are outlined 
below and followed by the report tables. 

1 Threat of harm – Any response that threatens physical harm to project or agency personnel. 

2 Notice of appeal or litigation – Any response that describes respondent’s intent to appeal 
an action or bring legal suit to bear on the agency.  

3 Freedom of Information Act (FOIA) – Any response that officially requests information 
and documentation under the FOIA. 

4 Proposals for new alternatives – Any response that suggests new alternatives to the 
proposed action. These do not include critiques of alternatives or partial changes of existing 
alternative. 

5 Requires detailed review – Any response that requires further review by the client. Well-
written analyses of the issues may need to be reviewed by the client. Response may include 
enclosures that need to be reviewed by the client. 

5a Provides extensive technical edits (deletions/replacements) – Any response that includes 
extensive use of lined out text, suggestions to delete text, and/or replace text. 

5m Provides maps – Any response that includes map enclosures. 

6 Government entities – Any response from an elected official, writing in his/her official 
capacity, from federal, tribal, state, county, or municipal governments; or any official 
correspondence from a government agency. 

6a Cooperating agency status – Any response that requests cooperating agency status. 

7 Public hearing – Any response that requests a public hearing. 



[Project Title] July 25, 2003 
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Immediate Attention Designation 7 – Public Hearing 

Letter 
Number

Name and 
Address 

Remarks 

314 LastName, FirstName 
Address 
City, ST Zip 

Requests public hearing in the future south of 
Wasau. They state that meetings should be held in 
communities with high populations, citing, 
Madison, Milwaukee, and Chicago. 

372 LastName, FirstName  Requests public hearing in LaCrosse, WI. 



Report Title 

Information and Comment Extension Request Interim Report Example

[Project Name] 
Requests for Information and/or Comment Period Interim Report 

Specific requests for additional information, excluding Freedom of Information Act requests, are 
displayed in the table below. Included in the report are five requests for additional information 
and two requests for an additional comment period. 

Requests for Specific Information  

Letter 
Number

Name and 
Address 

Remarks 

323 LastName, FirstName 
Organization  

Requests a winter comment period, stating that the 
current comment period falls during the 
snowmobiling off-season. 

325 LN, FN 
Organization 
Address  
City, ST Zip 

Requests conformation of receipt of letter. 

334 LN, FN Requests a winter comment period, stating that the 
current comment period falls during the 
snowmobiling off-season. 

390 LN, FN Requests hard copy of DEIS before the close of 
comment period. 

461 LN, FN Requests a hard copy of the final forest plan upon 
completion. 

500 LN, FN Requests that FS maps be corrected to demonstrate 
that Forest Service Road 2864 ends on the 
respondent’s landline. Currently the map shows 
that the road crosses his property line. He states 
that members of the public frequently trespass and 
have cut locks off of his gate. 

833 LN, FN Requests to be removed from the mailing list. 



36 CFR Part 219 – Proposed Planning Rule January 22, 2003 

Example Proposed Rule Coding Structure 

36 CFR Part 219 – National Forest System 
Land and Resource Management Planning; 
Proposed Rules 

Planning 

PLANN 

55000  Planning rules, general 

55100  SHOULD implement the rule 
55200 SHOULD NOT implement the rule
55300  Organization and structure of the proposed rules 

55310  Adequacy of planning documents  
55320  Clarity of planning documents 

55400  Need for EA/EIS in development the proposed rules 
55500  General concerns  

55510  Environmental 
55520  Resource Extraction 
55530  Recreation 
55540  Multiple Use 

56000  Decision-making authority, general 

56100  Role/authority (including trust and integrity comments)

56110  President/Current administration 
56120  USDA/Forest Service 
56130  Legislative Branch 
56140  Judicial Branch 
56150  Regional  
56160  State Governments 
56170  County/City Governments 

56200  Role of Interest Groups 
56210  Environmental groups 
56220  Multiple Use/Wise Use groups 
56230  Industry/Business groups 

56300  Role of General Public 
56310  Local Citizens 
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56320  Nationwide citizens/communities 

57000  Public involvement for the proposed rule, general 

57100  Adequacy/availability of information 
57110  Federal Register notice 
57120  Timeliness of notice (date of release, released with other plans)

57200  Outreach/agency communication efforts 
57210  Clarity/comprehensibility 
57220  Website/E-mail 

57300 Use of public involvement/comment (specific to public comment on the proposed 
rule, see 219.19(a), OBJEC regarding public comment and objection) 

57310  Public comment analysis 
57400  Public meetings 

57410  Diversity Workshop 
57500  Adequacy of comment period 

57510  Extension needed 
57600  Adequacy of timeframe 
57700  Collaboration 

58000  Agency organization and funding, general 

58100  General comments about the USFS (planning)

58200  Funding, general 
58300  Funding for the planning process 
58400  Staffing, general 
58500  Staff Training, education 
58600  Use of Science in decision-making  

58610  Relationship and authority of COS (Committee of Scientists) 

59000  Preamble, general (try to code to applicable section of proposed rule) 

59100  Language of Preamble 
59200  Implementation (problems with implementability of the 2000 Rule)

59210  Funding 
59220  Other 

59300  Comparison between proposed rule and 1982 or 2000 rule 

60000  Regulatory Certifications, general 

60100  Regulatory Impacts 
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Example Proposed Rule Coding Structure 

60200  Environmental Impacts 
60300  Energy Effects 
60400  Controlling Paperwork Burdens on the Public 
60500  Federalism 
60600  Consultation with Tribal Governments 
60700  No Takings Implications 
60800  Civil Justice Reform 
60900  Unfunded Mandates 

PURPO 

61000  219.1 Purpose and applicability (general comments on FS purpose, future 
direction, etc) 

61100  (a) (NFMA) National Forest Management Act  
61200  (b) (MUSYA) Multiple-Use to Sustained-Yield Act 

SCOPE 

62000  219.2 Nature and Scope of a land and resource management plan 

62100  (a) Fundamental Purpose of a plan  
62110  FS Stewardship 
62120  FS Mission  

62200  (b) Requirements (see following for specific requirements for planning process)

62210  (1) Must address issues at appropriate time frames and geographic scales, use of 
best science, etc 

62220  (2) Must conducted using interdisciplinary, collaborative approach 
62230  (3) Must consult with States and local governments, Federal agencies, federally 

recognized Indian Tribes 
62240  (4) Must provide opportunities for the public, both organizations and individuals 
62250  (5) Must provide for uses, benefits, products, services, and visitor opportunities 

that are consistent with the multiple use objects 
62260  (6) Must address social, economic and ecological components of sustainability 
62270  (7) Must identify the monitoring and evaluation necessary to assess the 

achievement of desired conditions 
62280  (8) Management direction should reflect the limits/variability of agency budgets 

62300  (c) Integration of authorities 
62310 (1) Statutory authorities (Federal Laws, Acts, Policies and Regulations, for NEPA 

see 21000) 

62320  (2) Agency directives  
62400  (d) Force and effect of plans 
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LEVEL

63000  219.3 Levels of planning and planning authority 

63100  (a) Chief of the Forest Service – national  
63200  (b) Supervisor (National Forest, Grassland or Prairie) – single unit 
63300  (c) Regional Forester – multiple units 
63400  (d) Experimental forests  

DECIS 

64000  219.4 Decisions embodied in plans 

64100  (1) Desired Conditions 
64200  (2) Objectives 
64300  (3) Standards 
64400  (4) Identification of suitable and unsuitable land uses 

64410  Outdoor recreation 
64420  Livestock grazing 
64430 Timber Harvest (general comments pertaining to this section) 

64440  Energy resource development 
64450  Mining/Extraction activities 
64460  Watershed restoration 
64470  Cultural and heritage interpretation 
64480  Other 

64500 (5) Special designations and other management areas (comments specific to this 
section, otherwise code to special designations 30000) 

64510  Wilderness 
64520  Wild and Scenic Rivers 
64530  National Trails 
64540  National Monuments 
64550  National Recreation Areas 
64560  Other 

64600  (6) Monitoring and evaluation requirements 

INDIC 

65000  219.5 Indicators of need to amend or revise plan 

65100  (a) Origination of issues or opportunities 
65200  (b) Consideration of issues and opportunities 

65210  (i) Scientific basis and merit of available information and analysis 
65220  (ii) The scope, complexity, intensity, and geographic scale of the issue 
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65230  (iii) Statutory requirements or valid existing rights 
65240  (iv) Organizational and available resources, including FS budget 
65250  Other

COMPL 

66000  219.6 Compliance with NEPA 

66100  (a) Role of responsible official 
66200  (b) Development, amendment, or revision of plan 

66210  Need for EIS/EA 
66220  Extraordinary Circumstances  
66230  Categorical Exclusions (CE), general 

66231  EIS or EA required to issue CEs 
66232  Cumulative impacts of multiple CEs 
66233  Limit on number of CEs during certain period of time 
66234  Limit on CEs within a certain area 
66235  Public comment 

AMEND 

67000  219.7 Amending a plan 

67100  (a) Purpose (add, modify, or rescind plan decisions)

67200  (b) Issues and opportunities 
67300  (c) Consultations and collaborations (comments specific to this section)

67400  (d) Significant Amendment/Notice of Intent (NOI) 
67500  (e) Objections 
67600  (f) Interim Amendment 

67610  (1) Responsible official 
67620  (2) Duration of the amendment 
67630  (3) Public Notification 
67640  (4) Objection process 

REVIS 

68000  219.8 Revising a plan 

68100  (a) Initiating revision (15-year cycle and as needed)

68110  (1) Preparing revision 
68120  (2) Consultation 

68200  (b) Public notice to revise a plan/Federal Register notice 
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68300  (c) Notice of availability of draft proposed action 
68400  (d) Notice of objection process (code general comments about objection to 219.19)

DEVEL

69000  219.9 Developing a new plan 

69100 (a) Determine need for a new plan for new Forest Unit (new National Forests, 
Grassland, Prairie, etc.) 

69200 (b) Establish separate plan for new Forest Unit (development and approval of new 
plan) 

APPLI 

70000  219.10 Application of plan direction 

70100  (a) Application of new plan, plan amendment or plan revision to existing 
authorizations and approved projects 

70200  (b) Application of plan direction during amendment or revision process 
70300  (c) Application of plan direction to approved projects in light of new information 
70400  (d) Amendments made through site-specific project decisions 
70500  (e) Testing and Research 

MONIT 

71000  219.11 Monitoring and evaluation 

71100  (a) Monitoring requirements  
71110  (1) Changes in Monitoring methods 
71120 (2) Coordinating of monitoring (joint monitoring between FS and other 

government and non-government entities) 

71200  (b) Evaluation requirements (Id trends, validate info, assess, determine 
effectiveness)

71300  (c) Data Sources (specific to monitoring and evaluation)

71400  (d) Recording and Reporting (specific to monitoring and evaluation)

COLLA 

72000  219.12 Collaboration, cooperation and consultation 

72100  (a) Providing opportunities for collaboration in FS planning 
72110  (1) Engaging interested individuals and organizations 
72120  (2) Engaging State and local governments and Federal Agencies 
72130  (3) Engaging Indian Tribes and Alaska Natives 

72200   (b) Forest Service participation in other planning efforts 
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SUSTA 

73000  219.13 Sustainability 

73100  (a) Social and economic components of sustainability (general) 
73110  Social components 
73120  Economic components 
73130  Ecological components 

73131  Options, general (comments specific to Options)

73132  Comparison of Options ( with 2000 Rule, 1983 Rule etc)

73200  OPTION 1 (for Paragraph b) 
73210  (b) Ecological component of sustainability  

73211  (1) Ecological information and analysis 
73212  (i) Consideration and evaluation of ecosystem diversity 

73220  Contribution of National Forest System lands to ecosystem 
diversity 

73230  (A) Characteristics of ecosystem diversity 
73231  (B) Evaluation of ecosystem diversity 

73240  (ii) Consideration and evaluation of species diversity 
73250  (A) Characteristics of species diversity 
73260  (B) Evaluation of species diversity  

73261  (2) Plan decisions 
73270  (i) Ecosystem diversity 
73280  (ii) Species diversity 

73300 OPTION 2 (for Paragraph b)
73310  (b) Ecological component of sustainability  

73311  (1) Ecological information and analysis 
73312  (i) Consideration and evaluation of ecosystem diversity 

73313  (A) Characteristics of ecosystem diversity 
73314  (B) Evaluation of ecosystem diversity 

73315  (ii) Consideration and evaluation of species diversity 
73316  (A) Characteristics of species diversity 
73317  (B) Evaluation of species diversity 

73318  (iii) Further analyses of biological diversity 
73319  (A) Consideration and evaluation of spatial and temporal scales  

      and patterns 
73320  (B) Consideration and evaluation of disturbance regimes 
73321  (C) Consideration and evaluation of landscape context 

73322  (2) Plan decisions 
73323  (i) Biological diversity 
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73324  (ii) Contributions of NFS lands 

SCIEN 

74000  219.14 The consideration of science in planning 

74100  (a) Decision must be consistent with best available science 
74110  (1) Demonstrate how the planning process considered and use best science 
74120  (2) Evaluate and disclose any substantial uncertainties in that science 
74130  (3) Evaluate and disclose substantial risks associated with plan decisions 
74140  (4) Validate that the science was appropriately interpreted and applied  

74200 (b) Responsible official evaluation of consistency and application of science (peer 
review, science advisory board, etc) 

DESIG 

75000  219.15 Special Designations 

75100  Identifying and designating suitable uses (general comments on land classifications) 
75110  (1) Congressional designated areas 

75111  Wilderness areas 
75112  Watersheds/Wild and scenic rivers 
75113  National trails 
75114  Scenic areas 
75115  Recreation areas 
75116  National Monuments 
75117  Other 

75120  (2) Administratively designated areas 
75121  Geological areas 
75122  Significant caves 
75123  Botanical areas 
75124  Cultural/heritage areas 
75125  Research areas 
75126  Scenic byways 
75127  Other

75130  (3) Inventoried roadless areas 
75131  Consideration for potential wilderness designation  
75132  Roadless Area Conservation Rule 

TIMBR 

76000  219.16 Determination of lands available for timber harvest/suitable for 
production
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76100  (a) Lands NOT SUITABLE for timber production 
76110  (1) Land that is not forest land 
76120  (2) Technology not available 
76130  (3) No reasonable assurance of restocking within 5-years 
76140  (4) Lands where timber production would violate statute 
76150  (5) Lands that have been withdrawn from timber production 
76160  (6) No justified based on physical, ecological, social, or economic factors 

76200  (b) Lands SUITABLE for timber production 
76300  (c) Lands where trees may be harvested for Multiple use values other than timber 

production
76310  Temporary or permanent openings for wildlife/fish habitat improvement 
76320  Grazing, mining 
76330  Fire management 

76331  Establish fuel breaks or reduce fuels 
76340  Create vistas 
76350  Non-timber commodities (firewood, mushrooms, hemp) 
76360  Enhance recreation use 
76370  Manage cultural/heritage sites 
76380  Salvage dead or dying trees 
76390  Other multiple use purposes not related to timber production 

77000  219.17 Limitation on timber harvest 

77100  (a) Estimate of the long-term sustained-yield capacity 
77200  (b) Limitation on timber harvest (sustained yield, allowable sale quantity (ASQ) 

requirements)
77300  (c) Exceptions to limitations of timber harvest  

77310  Government subsidized timber sales 

MAINT 

78000  219.18 Plan documentation, maintenance, and availability 

78100  (a) Plan description (text, maps, tables, charts, etc) 
78200  (b) Maintenance of the plan 

78210  (1) Corrections and updates of data and maps 
78220  (2) Corrections of Typographical errors and other non-substantive changes 
78230  (3) Changes in monitoring methods 

78300  (c) Availability of planning documents (public access to documents, etc) 
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OBJEC 

79000  219.19 Objections to new plans, plan amendments, or plan revisions 

79100  (a) Exceptions 
79200  (b) Public notice of the objection period 
79300  (c) Content of public notice of the objection 
79400  (d) Submitting objections (limitations on public comment, use of forms, etc)

79500  (e) Responding to objections 
79600  (f) Use of other administrative review process 
79700  (g) Compliance with the Paperwork Reduction Act 

APPEA 

80000  219.20 Appeals of plan amendments in site-specific project decisions 

NOTIC 

81000  219.21 Notice of plan decisions and effective dates 

81100  (a) Notice of decision 
81200  (b) Effective date 

TRANS 

82000  219.22 Transition (implementation of new/revised management plans) 

82100  Applicability 
82110  Timeframes for transition period 
82120  Procedures for transition period 

DEFIN 

83000  219.23 Definitions 

TABLE 

84000  Tables 

84100  Table 1: Comparison of 2000 Rule with Proposed Rule 
84200  Table 2: Ecological sustainability options side-by-side  

ATTAC 

85000  Attachments 
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1.1.1 ~ Affected Resource Codes 
000 – No affected resource 

001 – Multiple affected resources 

100 – Planning decisions/decision authority 

101 – Other rules/policies 

102 – Administrative effectiveness/efficiency  

103 – Trust and integrity - general 

104 – T&I USDA/Forest Service 

105 – Influence of interest groups 

106 – Influence of industry groups 

107 – Influence of environmental groups 

108 – Public relations/public involvement/public 
opinion

109 – Adequacy/availability of information 

111 – Public education/understanding 

112 – Relations with other agencies/orgs 

113 – Agency funding/staffing/structure 

200 – Alternatives 

230 – Laws, policies, and legal issues 

260 – American Indian cultural resources 

       – American Indian traditional lands and uses 

300 – General environment 

301 – Environmental Quality and Ecosystem 
Integrity 

302 – Short-Term vs. Long Term 
Productivity/Risks 

303 – Specific ecosystem/ecoregions 

304 – Watershed health  

       – Water quality/clarity 

       – Water quantity/runoff 

       – Wetlands/Riparian areas 

308 – Vegetation and botanical resources 

       – Plant species diversity 

       – Exotic/nuisance plant species 

311 – Soil quality 

312 – Biodiversity general  

313 – Wildlife and habitat 
       – Insect populations 
       – Game species 
       – Non-game wildlife 
314 – Aquatic wildlife and habitat 

315 – Threatened, endangered, or sensitive 
species (animal or plant) 

316 – Livestock/domestic animals (see 605)

320 – Air quality 

321 – Climate, Weather and Atmospheric 
Processes 

450 – Recreation General 

451 – Motorized recreation 

452 – Non-motorized recreation 

453 – Access 

500 – Public property 

501 – Private property 

530 – Roadless Areas 

531 – Wilderness Areas 

600 – Resource commodities 

601 – Agricultural products 

602 – Forest health 

603 – Timber resources 

604 – Mining 

605 – Grazing  

606 – Role of fire                   
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700 – Society and social values 

701 – Population/demographics 

702 – Quality of life 

703 – Public Health and Safety 

704 – Spiritual values 

705 – Future generations 

706 – Scenic and aesthetic values/resources 

707 – Intrinsic/non-market values 

708 – Noise levels 

709 – Cultural and historic resources 

730 – Economy and economic values 

731 – National economy 

732 – State/local economy 

733 – County/State agricultural base 

734 – Jobs/employment 

735 – Private property values 

736 – Cost-benefit analysis 

739 – Best available science/scientific advances 

740 – Use of taxpayer money/subsidies 

1.1.2 ~ Theme Codes 
 IR  Implement  
 DR  Don’t Implement   
 ED  Editorial 
 XX  Default 


